JAWS 10

Welcome

Congratulations on your purchase of JAWS for Windows, the international standard for screen reading software. As Windows software has evolved, JAWS has risen to meet the challenge to allow blind and low vision users access to the same information that others have on the World Wide Web, in popular applications, and when reading specialized document formats such as PDF or HTML.

Furthermore, JAWS is part of a family of products for blind and low vision computer users, which includes screen magnification software, scanning and reading software, a PDA for the blind, Braille displays, and notetakers. The newest versions of Freedom Scientific's products not only work with each other, but also do not interfere with other accessibility products on the same PC.

Your decision to use JAWS as your computer screen reader is an excellent choice. With JAWS you'll find that your access to the Internet is unparalleled. Using JAWS with Microsoft's Internet Explorer is easy, so you'll be surfing in no time. Additionally, JAWS supports the most popular office software products so that you'll be able to work in the same software environment as other Windows computer users. There are numerous other applications that are supported in JAWS, including word processors, encyclopedias, financial and spreadsheet packages, e-mail and messaging applications, and more. 

For Braille users, JAWS provides functionality that improves the efficiency and quality of your work when using a Braille display. It also provides an accurate representation, in Braille, of what's displayed on your computer's screen.

There are numerous settings that allow you to customize JAWS to meet your individual needs, including how much information is provided globally and in individual applications. Dozens of other options allow you to set your own voices, keystrokes, HTML preferences, verbosity levels, and more. With JAWS scripting, you can customize JAWS to work with any application, such as proprietary software developed by large employers. This feature provides ultimate flexibility and expandability, making JAWS an excellent investment for the present and future.

The links below will help you get started with JAWS:

What's New in JAWS?
New Users Start Here
Reading Screens and Documents
Using JAWS with Internet Explorer
Keyboard Commands
What's New in JAWS?
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License Agreement

Freedom Scientific End User License Agreement

Freedom Scientific Inc., provides you with the software program included in the package accompanying this agreement (the program) and licenses you to use this program. The license granted to you is nonexclusive and does not grant ownership rights. As a licensed user (Licensee), you should understand that you do not own the program and the instructional materials that accompany the program; you are only licensed to use the program and instructional materials in accordance with the terms stated in this agreement.

When you become a licensed user, you assume sole responsibility for determining the appropriateness of the program for achieving your intended results. You further assume sole responsibility for the installation, use, and results obtained from the program, and you assume complete responsibility for the selection, installation, use, and placement of hardware with which you use the program.

DEMONSTRATION AND EVALUATION LICENSE ONLY. NOT FOR COMMERCIAL USE.

Software licenses which require either System Reboot after a certain period of time or expire after a certain number of days, are to be used for evaluation prior to purchase only. Any commercial use is prohibited. Under no circumstances shall you, the end-user, be permitted, allowed or authorized to commercially exploit the SOFTWARE, or any portion thereof. Neither you, anyone at your direction nor any third party shall take the following actions with regard to the SOFTWARE, or any portion thereof to sell, rent, lend, lease, commercially exploit or use the SOFTWARE for any commercial purpose. For example, these demonstration or evaluation licenses are not permitted for purposes of development and testing of JAWS scripts, applications, HTML coding, or other Web Based code.

ACCEPTANCE OF THE LICENSE AGREEMENT

The terms and conditions of the Freedom Scientific Software License Agreement (License Agreement) explain the legal relationship between Freedom Scientific and the individual and institutional purchasers of Freedom Scientific software. By using the software, you acknowledge that you have read this agreement, that you understand it, and that you agree to be bound by all of its terms and conditions. You further agree that this agreement is the complete and exclusive statement of the agreement between you and Freedom Scientific, and that this agreement supersedes any prior communications, understandings, representations, proposals, or agreements, (whether oral or written) that may exist between you and Freedom Scientific.

If you choose to not accept the terms of this license agreement, then you must promptly return the following items to Freedom Scientific: the software, all materials that may have been included with the Freedom Scientific software, and the receipt you received when you purchased the software. The money you paid for the software, minus shipping/handling fees, will be refunded to you, if you meet the above conditions.

COPYING THE PROGRAM

The Licensee may not copy, transfer, decompile, disassemble, or reverse engineer the program or create a derivative work, or allow the program to be copied or transferred, in part or in whole, except as specifically indicated within this agreement. In the event the Licensee copies, transfers, decompiles, disassembles, or reverse engineers the program or creates a derivative work for another person in any form, except as is specifically authorized, then the Licensee's license to use the program shall be automatically terminated. The Licensee may install and use the program on more than one machine, but only one machine may be used at a time.

In the case of a Licensee who has purchased a Site, District, or Enterprise License, the Licensee may install the program on the specified number of machines as defined in the Site, District, or Enterprise License Agreement. The Licensee may install a Site, District, or Enterprise License on a Local Area Network (LAN) server, however, the concurrent number of users of the software cannot exceed the number of machines as defined in the Site, District or Enterprise License Agreement. This product is not intended, nor warranted to be installed or supported on a Wide Area Network (WAN) except to allow the use of a WAN for Enterprise-wide license authorization. The Licensee may copy the program for backup purposes to preserve the program. These copies and the original program may be stored in the possession of another person, so long as the storage does not result in the program being used in violation of the terms set forth above in this section.

Whenever the program or instructional materials are reproduced, then the copyright notice must also be reproduced and displayed in its original form.

TERMS

The license being granted shall be effective until terminated.

The Licensee may terminate the license at any time by destroying all copies of the program and all copies of related instructions, regardless of the form.

Additionally, this license is immediately terminated in the event the Licensee fails to comply with any term or condition of this agreement, whether or not Freedom Scientific has knowledge of the failure to comply. The Licensee agrees, as a term of this agreement, to destroy all copies of the program together with all related instructions, regardless of form, at such time this agreement is terminated, whether or not the Licensee is instructed to do so by Freedom Scientific.

LIMITED WARRANTY

The program provided to the Licensee is being provided "as is" without warranty of any kind, either expressed or implied, including, but not limited to the implied warranties of merchantability and fitness for a particular purpose. The entire risk as to the quality and performance of the program is with the Licensee.

Freedom Scientific does not warrant that the functions contained in the program will meet the Licensee's requirements or that the operation of the program will be uninterrupted or error free. However, Freedom Scientific warrants the media on which the program is furnished, to be free from defects in materials and workmanship, when in normal use, for a period of ninety (90) days from the date of delivery as evidenced by a copy of your receipt. The limited warranty will be honored by Freedom Scientific provided that the media is properly stored in an area free of magnets and/or magnetic fields and provided that defects in the materials and workmanship of the media do not result from an act of God or other cause beyond the control of Freedom Scientific or the media manufacturer.

LIMITATION OF REMEDIES

Freedom Scientific's entire liability and the Licensee's exclusive remedy shall be the replacement of any media not meeting Freedom Scientific's limited warranty. In no event will Freedom Scientific be liable to the Licensee for any damages, including any lost profits, loss of savings or any other incidental or consequential damages as may arise out of the use or inability to use the program, even if Freedom Scientific personnel or agents have been advised of the possibility of such damages.

OTHER PROVISIONS

The Licensee may not sublicense, assign, or transfer this license to another party. Any attempt to sublicense, assign or transfer any of the rights, duties or obligations under this agreement shall be null and void and without any legal effect.

This product uses the ETI-Eloquence text-to-speech system that contains material copyrighted by Nuance, Inc.

This agreement shall be governed by the laws of the state of Florida. In the event of any litigation of this agreement, the prevailing party shall be entitled to reimbursement of related costs incurred by such party, including but not limited to such party's reasonable attorney fees.

If you have questions concerning this agreement, contact Freedom Scientific for clarification at 11800 31st Court North, St. Petersburg, FL 33716, or phone (727) 803-8000.

System Requirements

To use JAWS for Windows, you need a personal computer running a 32-bit version of Microsoft Windows operating system with the following:

· A processor capable of handling the requirements of the operating system in addition to any other programs you want to use with JAWS. 

· Enough memory to run the operating system and any programs you want to use with JAWS. Additional memory will improve system performance while JAWS is running. 

· JAWS requires less than 200 MB of hard disk space for program and settings files. Additional space is required for the operating system, other programs, and the Windows swap file. 

· A display adapter capable of at least 800 x 600 screen resolution with 16 bit color (1024 x 768 screen resolution with 32 bit color is recommended). 

· If you intend to use the Eloquence for JAWS software synthesizer, you need a sound card compatible with the version of Windows you are running. If you choose not to use Eloquence for JAWS, then you must have a JAWS compatible software or hardware speech synthesizer, or a refreshable braille display. 

Note: If you do not have a sound card, JAWS does not provide speech during installation.

Proper licensing is required to run JAWS with Microsoft Windows operating systems. The JAWS licenses are either Professional or Standard.

· JAWS Professional licensing can be used with the following 32-bit operating systems: all versions of Windows Vista™, Windows XP Professional, Windows XP Home, Windows XP Media Center Edition, Windows 2008 Server, and Windows 2003 Server. 

· JAWS Standard can be used with 32-bit versions of Windows Vista™ Home Premium, Windows Vista Home Basic, and Windows XP Home. 

Note: JAWS will work with 64-bit processors, but not with 64-bit operating systems.

While JAWS supports the Windows XP Media Center Edition operating system, support for Media Center applications is limited to areas where Microsoft Active Accessibility® has properly exposed adequate information.

Installing JAWS for Windows

This topic contains information on the available installation options for JAWS. For information on JAWS Network Setup, please see Network JAWS.

Note: Close all applications before beginning JAWS Setup, including screen readers, screen magnification programs, and anti-virus software. If your firewall software interferes with the installation process, refer to Troubleshooting Firewall Software.

For minimum system requirements, please visit JAWS System Requirements. You must be logged on to an account with administrator privileges to install JAWS. 

The following topics contain detailed information on installing and setting up JAWS for use on your computer:

JAWS for Windows Setup 

Maintenance Setup 

Activating JAWS
JAWS Startup Wizard 

Operating System Considerations
JAWS for USB Thumb Drives

Freedom Scientific offers a version of JAWS that can be installed on and run from a portable USB thumb drive. However, you cannot use the version of JAWS on your program CD. You must download a special version of JAWS from www.FreedomScientific.com. For more information on running JAWS from a thumb drive, visit our Web site or see JAWS for USB Thumb Drives - Questions and Answers.

Maintenance Setup

Maintenance Setup allows you to make changes or corrections to the currently installed version of JAWS. To start Maintenance Setup, insert your JAWS program CD into your CD drive and choose the JAWS Setup button. If you downloaded JAWS from FreedomScientific.com, navigate to the folder where you saved the file, select it, and press ENTER.

Note: You must be logged on to an account with administrator privileges to use the Maintenance Setup options.

There are three Maintenance Setup options:

Modify

This option allows you to change your current installation settings.

Repair

This option allows you to reinstall JAWS with current settings, replacing existing files, which might be damaged or corrupted. When you choose this option, Setup asks if you want to delete your user settings files. Shared settings files are replaced by the default files.

Remove

This option allows you to remove all JAWS components, including the JAWS folder. You can also uninstall JAWS by opening the Start menu and choosing Programs or All Programs, JAWS, Tools, UnInstall JAWS.

 See also:

JAWS for Windows Setup 

Product Activation Overview

After you install JAWS, you must activate your software. JAWS runs in 40 minute mode until it is activated on your computer. Internet License Manager (ILM) allows you to quickly activate JAWS using the Internet. If you do not have an Internet connection, you can activate JAWS by telephone or fax. Alternatively, you can activate JAWS with the assistance of a trusted friend, relative, or organization that has access to the Internet. 

If you purchased a network (multi-user) license of JAWS, refer to ILM Multi-User Network Authorization for instructions on installing the license server and activating your software. For information on installing and setting up JAWS on a network, refer to Network JAWS.

If you purchased a single-user license of JAWS, you are asked to activate when you first start the program. You can activate JAWS at a later time by opening the Help menu and choosing Update Authorization. Select one of the following activation methods for detailed instructions on completing the activation process:

Activate using the Internet (recommended)
Activate by Telephone
Activate by Fax
Activate with the Help of a Trusted Third Party
Note: Your user account must have power user or administrator privileges to activate JAWS. Contact your network administrator if your account does not have the required level of access.

You can also use a dongle (a hardware device that connects to your computer's USB or parallel port) to make your JAWS license more portable. A dongle allows you to use an authorized version of JAWS on any computer as long as the dongle remains connected. For more information, see Dongle Authorization.

Note: Adding or removing certain hardware components may cause your computer's Locking Code to change. If this occurs, you must reactivate JAWS. If you need to request more activations, go to www.FSActivate.com.

Related Topics:
Frequently Asked Questions about Activation
Activating with Internet License Manager

You can use Internet License Manager (ILM) to activate JAWS using an Internet connection. This is the easiest and quickest way to activate your product. 

When you first start JAWS, you are asked to activate the program. You can also begin the activation process by opening the Help menu and choosing Update Authorization. To activate JAWS using the Internet, do the following:

1. In the Activation dialog box, choose Start Activation. 

2. Read the message that displays and then choose Continue. Insert the Authorization CD into your CD-ROM drive and choose Activate Using Authorization CD. You can find your Authorization CD in the same sleeve as your JAWS program CD. If you do not have your Authorization CD, choose Enter Your Authorization Number Manually. 

Note: If you have previously inserted your Authorization CD, you will not be asked to insert it again. Continue to step 3 of the activation.

3. Choose Activate. 

4. Use the arrow keys to select Now, Using the Internet (RECOMMENDED), and then press ENTER. 

5. If you used your Authorization CD, your 20-digit Authorization number is automatically inserted into the Authorization Number edit box. If your Authorization number is not shown, type it into the edit box. You can find your Authorization number in print and Braille on your JAWS CD sleeve. 

6. Press ENTER to continue. You will be asked to connect to the Internet if you have not already done so. You must establish an Internet connection before continuing with the activation. 

7. If you have not registered JAWS, you are asked to do so now. Registering JAWS lets you receive technical support. Choose Register Now and complete the online registration form by following the instructions provided. You can choose to register later, but you must register the next time you activate JAWS. 

8. After you submit your registration, Internet License Manager attempts to activate JAWS. This process may take several minutes. When the activation is successful, choose Finish. 

Note: If Internet License Manager cannot activate JAWS because of your firewall software, see Troubleshooting Firewall Software.

Related Topics:
Activating by Telephone
Activating by Fax
Activating through a Trusted Third Party
Activating by Telephone

If you do not have an Internet connection, you can call Freedom Scientific Customer Service. Customer Service will send you a CD in the mail that will automatically activate JAWS. 

When you first start JAWS, you are asked to activate the program. You can also begin the activation process by opening the Help menu and choosing Update Authorization. To activate JAWS by telephone, do the following:

1. In the Activation dialog box, choose Start Activation. 

2. Read the message that displays and then choose Continue. Insert the Authorization CD into your CD-ROM drive and choose Activate Using Authorization CD. You can find your Authorization CD in the same sleeve as your JAWS program CD. If you do not have your Authorization CD, choose Enter Your Authorization Number Manually. 

Note: If you have previously inserted your Authorization CD, you will not be asked to insert it again. Continue to step 3 of the activation.

3. Choose Activate. 

4. Use the arrow keys to select Telephone to Receive Activation by Mail, and then press ENTER. 

5. Call (727) 803-8015. Provide the customer service representative with the Authorization number and Locking code shown in this dialog box. If your Authorization number is not shown, you can find it in print and Braille on your JAWS CD sleeve. 

6. Choose Quit. You can continue using JAWS in 40 minute mode until you receive your CD. 

When you receive the CD with your Activation License code from Freedom Scientific, insert it into your CD-ROM drive to automatically activate JAWS. 

Note: If the CD does not automatically activate your software, press WINDOWS Key+R, type "D:\ActivationCode.exe" and press ENTER. If your CD-ROM drive is not D:, then substitute the correct letter. 

Related Topics:
Activating with Internet License Manager
Activating by Fax
Activating through a Trusted Third Party
Activating by Fax

If you do not have an Internet connection, you can send a fax to Freedom Scientific with your Authorization number and Locking code. You will then receive an Activation License code either in an e-mail message or on a CD. 

When you first start JAWS, you are asked to activate the program. You can also begin the activation process by opening the Help menu and choosing Update Authorization. To activate JAWS by fax, do the following:

1. In the Activation dialog box, choose Start Activation. 

2. Read the message that displays and then choose Continue. Insert the Authorization CD into your CD-ROM drive and choose Activate Using Authorization CD. You can find your Authorization CD in the same sleeve as your JAWS program CD. If you do not have your Authorization CD, choose Enter Your Authorization Number Manually. 

Note: If you have previously inserted your Authorization CD, you will not be asked to insert it again. Continue to step 3 of the activation.

3. Choose Activate. 

4. Use the arrow keys to select Fax, and then press ENTER. 

5. Complete the form by typing the required information into the edit boxes. If you want to receive your Activation License code in an e-mail message, enter your e-mail address. If you do not enter an e-mail address, Freedom Scientific will send you a CD in the mail that will automatically activate JAWS. 

6. If you used your Authorization CD, your 20-digit Authorization number is automatically inserted into the Authorization Number edit box. If your Authorization number is not shown, type it into the edit box. You can find your Authorization number in print and Braille on your JAWS CD sleeve. 

7. Choose Print to send the form to your printer. After you have printed the form, choose Quit. 

8. Fax the printed form to (727) 803-8001. 

If you entered your e-mail address, you should receive an e-mail message from Freedom Scientific within one or two business days. Follow the instructions provided in the message to activate JAWS. If you do not enter an e-mail address, you will receive a CD from Freedom Scientific in the mail. Insert the CD into your CD-ROM drive to automatically activate JAWS.

Note: If the CD does not automatically activate your software, press WINDOWS Key+R, type "D:\ActivationCode.exe" and press ENTER. If your CD-ROM drive is not D:, then substitute the correct letter. 

Related Topics:
Activating with Internet License Manager
Activating by Telephone
Activating through a Trusted Third Party
Activating through a Trusted Third Party

If you know a friend, relative, or other trusted person with an Internet connection, they can help you activate JAWS. Alternatively, you can use an Internet connection in a library, at work, or anywhere else. You or a trusted third party can visit www.FSActivate.com to obtain your Activation License code. 

Tip: A free program from Freedom Scientific called Activation Media Image Creator lets you create a CD, 3.5-inch disk, or e-mail attachment containing JAWS license information. 

To obtain an Activation License code from FSActivate.com, do the following:

1. Point your Web browser to http://www.FSActivate.com. 

2. Enter your 20-digit Authorization number and Locking code. Your Authorization number appears on your JAWS CD sleeve in both print and Braille. To find your computer's Locking code, open the JAWS Help menu and choose About JAWS for Windows. 

Note: The Locking code is unique for each individual computer. Be sure you enter the Locking code of the computer you intend to use with JAWS when it is activated.

3. Choose Submit License Request to receive an Activation License code. 

4. The remaining steps must be completed on the computer where the copy of JAWS you want to activate is installed. Begin by starting JAWS on this computer. From the JAWS Help menu, choose Update Authorization. 

5. In the Activation dialog box, choose Start Activation. 

6. Read the message that displays and then choose Continue. Insert the Authorization CD into your CD-ROM drive and choose Activate Using Authorization CD. You can find your Authorization CD in the same sleeve as your JAWS program CD. If you do not have your Authorization CD, choose Enter Your Authorization Number Manually. 

Note: If you have previously inserted your Authorization CD, you will not be asked to insert it again. Continue to step 7 of the activation.

7. Choose Activate. 

8. Use the arrow keys to select the Activation Generated from www.FSActivate.com radio button and press ENTER. 

9. Type the Activation License code you received from www.FSActivate.com into the edit box and then press ENTER. 

10. After you have successfully activated JAWS, choose Finish to complete the process. 

Using Activation Media Image Creator

Activation Media Image Creator is a free program from Freedom Scientific that allows a user with an Internet connection to retrieve Activation License codes from Internet License Manager. The user can then distribute these Activation License codes on CD, 3.5-inch disk, or e-mail. Users without Internet connections can use the files created by this program to activate JAWS without having to type the lengthy Activation License code. 

To download the installation package for Activation Media Image Creator, visit www.FSActivate.com. After you install the program, follow the instructions in the Activation Media Image Creator online Help to retrieve and distribute Activation License codes from Internet License Manager.

Related Topics:
Activating with Internet License Manager
Activating by Telephone
Activating by Fax
Dongle Authorization

A dongle is a hardware device that you can connect to a computer's parallel or USB port (depending on the type of dongle). JAWS is authorized to run on that computer as long as the dongle remains connected. This is useful if you frequently need to use JAWS on many different computers and do not want to activate the program on each of them. 

When JAWS starts, it first determines whether a dongle is connected to the computer. If one is connected, JAWS uses the features and information for the license associated with the dongle to authorize JAWS. If no dongle is connected, JAWS searches for the license information stored on the computer. You can use the Dongle Viewer utility to view information on the license associated with the dongle currently connected to your computer. To start this utility, go to the JAWS program group, open the Tools submenu, and choose Dongle Viewer.

Note: It is recommended that you do not connect the dongle to your computer until after you install JAWS. If the dongle was connected before or during installation, you must restart your computer to receive proper authorization.

Dongles are sold separately or as an additional JAWS feature. Contact Freedom Scientific Sales if you want to purchase one. 

Note: Certain international versions of JAWS require a dongle for authorization. Using one of these versions without a dongle displays an error message. 

Related Topics:
Product Activation Overview
Frequently Asked Questions about Activation

Below are frequently asked questions about the Internet License Manager (ILM) activation process. 

What is the Authorization number?

It is a 20 digit code that can be found on the sleeve that holds your JAWS program CD in print and Braille. This number is also contained on your Authorization CD. 

What is the Locking code?

The Locking code is a digital fingerprint of your computer system that “locks” your copy of JAWS to your computer. You must install JAWS to generate your computer's Locking code. After you install JAWS, start the program, open the Help menu, and choose About JAWS for Windows to find your Locking code. 

What is the Activation License code?

The Activation License code is the final piece of encoded data needed for activation. It is an alphanumeric code that has over 100 characters. 

Can I remove the Activation License Code from my computer? 

Yes. This code can be deleted from a computer, but cannot be moved to a different system. To do this, open the Start menu and go to the JAWS program group. Then, open the Tools submenu and choose Remove Product Activation. 

If I don’t have an Internet connection, how can I activate JAWS?

You can contact Freedom Scientific or anyone who has an Internet connection and have them complete the process for you. Refer to Activating through a Trusted Third Party for more information. 

What will happen to the ability to use older versions of JAWS, such as 4.51, once the new authorization scheme is in place?

Older versions will still use the older scheme. The new scheme will only be used for JAWS 5.10 and later. 

Will there be any potential conflicts between the old system and the new authorization when someone uses a new version of JAWS on the same system as an older version?

No. The different solutions will not conflict with each other. You can continue to use 4.51, 3.7U, and 5.10 all on the same computer provided you have both authorizations in place. 

Will users of JAWS 5.0 or earlier be able to continue with the 3.5-inch disk-based authorization system, and will authorization disks and keys continue to be replaced as needed?

Yes. 

How long will Freedom Scientific support the old authorization scheme? 

For as long as our customers require it. We expect this will continue for many years to come. 

Do you still have my serial number? 

Yes. You can find your serial number in the About JAWS dialog and on the status line of the JAWS user interface. 

Will I ever need more than three activations?

This depends on the number of computer systems you own and install your license on. To see how many keys are currently available for use, visit the Number of Keys Currently Available page on the Web. 

How do I get more activations? 

Visit www.FSActivate.com and complete the Request for Product Activation Reset form. Alternatively, you can call (727) 803-8015 and register with Customer Service to obtain additional activations. 

What does the Authorization CD do?

The Authorization CD included with your software is provided in order to offer you a quick way to enter your 20 digit Authorization number without typing it. This is the same number that appears in print and Braille on your program CD sleeve. You do not need the Authorization CD to activate your software because you can always manually enter your Authorization number when requested. 

Will I need to have the Authorization CD if I lose it? 

No, provided you record and safely store your Authorization number, you can always enter it manually if needed. This code is Brailled and printed on the JAWS CD sleeve. 

Can I order a replacement Authorization CD?

Yes, Freedom Scientific will be able to assist you in processing an order for a nominal fee. To avoid any delays in this process, you should be sure to register your product license as soon as possible.

What if I do consulting on other people’s machines and might need to work on a different machine every couple of months?

A solution for you might be to get a dongle to use for these cases. You can then just carry the dongle and that JAWS version if you intend on using lots of machines for short periods of time. Dongles are sold separately. Contact Freedom Scientific Sales for further information. 

What about Network installations? Is there an Internet solution for that too? 

Yes, there is a good network solution. The documentation for this network solution is available on the CD, or you can refer to the Network Authorization Quick Start Guide. 

How can I use JAWS on multiple computers connected to the same network?

If you have a network license for JAWS, you can install a license server that provides "tokens" to authorize JAWS on client computers. The number of tokens available is determined by the type of license you purchase. If you set up a license server, you can use JAWS on any computer connected to the network as long as a token is free. For more information, refer to the Network Authorization Quick Start Guide.

How do I implement a multi-user license if my computers that use JAWS are not on the same local area network (LAN)?

You can purchase a non-network multi-user license. When you have this type of license, there is no need to set up a license server. Each computer will receive its own Authorization number. You then follow the steps for activating a single-user license on each computer.

What type of license do I need to use JAWS in remote sessions with Citrix, Microsoft Terminal Services, or Microsoft Remote Desktop?

The Remote Access feature is only available for licenses of JAWS Professional that use Internet License Manager (ILM) for authorization. 

Do I need to purchase the Remote Access option to use PAC Mate Desktop?

No. PAC Mate Desktop works with any license of JAWS Professional or JAWS Standard. You do not need to purchase the Remote Access option for your license to use this feature. You only need to purchase the extra license option if you want to connect remotely from one PC to another using Citrix, Microsoft Terminal Services, or Microsoft Remote Desktop.

Registering JAWS

Taking the time to register your JAWS software helps Freedom Scientific help you. After you submit your registration information, you will become a registered JAWS user. This means that you can receive technical support, and that your software can be more easily replaced if it is damaged, lost, or stolen. There are different ways to register, depending on how you authorize your license of JAWS.

Internet License Manager (ILM) Registration

If you are using Internet License Manager, and you activate JAWS using the Internet, you register your product during the activation process. For more information, see Activating with Internet License Manager. If you register by phone or fax, a customer service representative will enter your registration information.

Registration is optional the first time you activate your software. However, if you try to activate JAWS on another computer, you must register before completing the activation process. After you successfully register, you will not be asked to register again the next time you activate JAWS. If you need to change your registration information, contact Freedom Scientific Customer Service at (800) 444-4443. 

JAWS Startup Wizard

The JAWS Startup Wizard is a helpful tool that contains a series of dialog boxes. It lets you quickly configure some of the more commonly used JAWS parameters. This can save time since you do not have to search multiple menus and managers to customize your copy of JAWS. 

The Startup Wizard automatically runs the first time you install a new version of JAWS. 

Note: You must choose the Finish button in the wizard's last dialog box to save and activate any changes. If you cancel or escape at any point in the wizard, your changes will not be saved. 

Training Materials

This dialog box only appears when you install JAWS from the program CD. To install the JAWS Basic Training, the What’s New, and the FSReaderGettingStarted DAISY books, select the Install Training Material check box.

Speech Settings 

The following options appear for the Speech Settings.

Rate

This scroll bar allows you to adjust the rate of speech for JAWS. Press LEFT ARROW, DOWN ARROW, or PAGE DOWN to decrease the speech rate. Press RIGHT ARROW, UP ARROW, or PAGE UP to increase the speech rate. The default rate is 57. 

Punctuation

This combo box allows you to specify how much punctuation JAWS speaks. Available options are None, Some, Most, and All. 

Most is selected by default.

Typing Echo

This group box allows you to select to have the information you type echoed in one of several ways. The default is to echo your typing by character. Set your preferences by selecting one of four radio buttons:

· Off: Select this option if you do not wish to hear typing echoed. 

· Characters: Each character you type is echoed. This is the default setting. 

· Words: Each word you type is echoed after pressing SPACEBAR or ENTER. 

· Characters and Words: Characters are echoed as you type them and words are echoed after you press SPACEBAR or ENTER. 

Run JAWS Settings 

The following options appear for the Run JAWS Settings.

Automatically Start JAWS

Having JAWS start automatically, which is also known as running JAWS as a service, is a great help to those who require speech immediately. There are two ways to automatically start JAWS depending on the Windows operating system on your computer.

Windows Vista Systems 

For Windows Vista users, several check boxes appear for the Run JAWS Settings. Use these settings to determine if JAWS starts before or after you log on and start Windows Vista. 

Note: The default values of the Start JAWS Option dialog box assure that JAWS is always loaded and running before and after you start Windows Vista. If you have an Administrator account, three options appear. If you have a Standard User account, only the Start JAWS after log on for this user combo box appears. There is no need to change the default values. 

· Automatically start JAWS at the Log On screen: When this check box is selected, JAWS will load and start when the Windows Vista log on screen appears. The check box is checked by default. 

Administrator rights are required to change this setting. If you have Standard user rights, you cannot change the value of this check box, and you will not hear it using JAWS. Uncheck this check box if you want JAWS to be off when the log on screen appears. The check box value applies to all users who log on to this version of JAWS on this computer. 

· Automatically start JAWS after log on for all users: When this check box is selected, JAWS will load and start after you log on to Windows Vista. It is unchecked by default.

Note: The only time that it is necessary to change the value of this check box is if you have an Administrator account on this computer, and you want to control how JAWS starts for all subsequent users who log on to Windows Vista using this computer. If you do not have Administrator rights, you cannot change the value of this check box, and you will not hear it using JAWS. 

If you have Standard user rights on this computer, refer to the combo box labeled Start JAWS after log on for this user for information that describes how to start JAWS after logging on to Windows Vista.

· Start JAWS after log on for this user: This combo box allows an individual user to control if JAWS starts after he or she logs on to Windows Vista. This combo box has three values: Always, Never, and Using the All Users Setting. The default value is Always. 

Note: This combo box is available to users with Administrator and Standard user rights. The value selected for the combo box overrides the value of the Automatically start JAWS after log on for all users check box. 

If Always is selected, JAWS will start every time the current user logs on to Windows Vista.

If Never is selected, JAWS will never start after the current user logs-on to Windows Vista. 

If the current user selects the value labeled Using the All Users Setting, then the following can happen:

JAWS will start after the current user logs on if the Administrator selected the Automatically start JAWS after log on for all users check box.

JAWS will not start after the current user logs on if the Administrator unchecked the Automatically start JAWS after log on for all users check box.

Windows XP Systems 

For Windows XP users, this option appears as a check box labeled Automatically Start JAWS. Select it to start JAWS each time you start Microsoft Windows. By doing this, JAWS is one of the first items that becomes available so that you have access to the Windows Log On dialog box through speech and braille. 

This check box is selected by default. 

Note: This check box is only available if JAWS is running from a local hard drive. If JAWS is running from a removable disk or network drive, the check box is not available.

Run JAWS from System Tray

This option removes JAWS from the TAB order and places it in the system tray. This change takes effect the next time you start JAWS. To access JAWS from the system tray, press INSERT+J. This brings up a shortcut menu with the Options, Utilities, Languages, and Help items listed. Press RIGHT ARROW to access sub-menus for each of these items. Press ALT to close this shortcut menu. 

This check box is not selected by default. 

Keyboard Settings 

The following options appear for the Keyboard Settings.

Use Keyboard Layout

Use this combo box to select the desired keyboard layout. Select from desktop, laptop, or kinesis. JAWS keystrokes frequently use keys located on the numeric keypad, which usually is on the right side of the keyboard. Most laptop computers do not have the numeric keypad, so JAWS provides alternate keystrokes, called laptop keystrokes. If your keyboard has the numeric keypad, choose the desktop keyboard option. For those of you who are using any of the Kinesis keyboards, select kinesis as this implements the features of these keyboards. If your keyboard does not have a numeric keypad, choose the laptop keyboard option. 

Initial State of NUM LOCK Key

JAWS uses the numeric keypad to perform numerous speech functions.  By default, the NUM LOCK key is turned off so that you can easily use these functions.  However, you may have a job that requires extensive use of the numeric keypad, in which case, you must always turn on the NUM LOCK key after JAWS starts. 

The Initial State of NUM LOCK Key option allows you to control whether or not the NUM LOCK key is enabled when JAWS starts. This option is only available in Default.jcf.

· Turn off at startup: This is the default value.  When selected, the NUM LOCK key is off when JAWS starts. 

· Turn on at startup: Enables the NUM LOCK key so that it is on when JAWS starts. 

· Do not modify: JAWS uses the current NUM LOCK key setting. 

Verbosity Settings

The following options appear for the Verbosity Settings.

Tutor Messages

Use this series of radio buttons to determine which Tutor messages are spoken. Tutor messages provide navigation tips in applications and Windows.

· Turn Off Menu and Control Help: No Tutor messages are spoken. 

· Announce Menu and Control Help: All Tutor messages are spoken. This is the default setting. 

· Announce Custom Messages Only: Only custom Tutor messages added through Prompt Manager are spoken. 

Access Keys

Access keys are the keys you press to move directly to a control or an item in a menu. Use this group of radio buttons to specify which access keys are announced: 

· Off: No access keys are spoken. 

· Speak all: JAWS speaks access keys for both menus and dialog boxes. This is the default setting. 

· Speak Menus Only: JAWS only speaks access keys for menu items. 

· Speak Dialogs Only: JAWS only speaks access keys for controls in dialog boxes. 

Verbosity Level

There are three levels of verbosity: Beginner, Intermediate, and Advanced. The beginner level provides the maximum amount of information spoken, while intermediate and advanced levels provide fewer details. Beginner is the default setting. 

Graphic Verbosity 

This series of radio buttons allows you to determine if JAWS announces when graphics are encountered, and which graphics are announced. 

· No Graphics: If this option is selected, JAWS does not announce graphics as they are encountered. 

· Labeled Graphics: If this option is selected, JAWS only announces graphics that have been labeled with the graphics labeler. 

· All Graphics: If this option is selected, JAWS announces all graphics as they are encountered. JAWS reads the labels for the graphics, if they are assigned. If no labels are assigned for a graphic, JAWS assigns a unique number. This is the default option. 

Braille Settings

The following options appear for the Braille Settings.

Grade Two

This group box contains several check boxes relating to Grade Two braille.

Enable Translator

If this check box is checked, Grade Two braille is displayed on your braille display. This check box is cleared by default. If you select this check box, it is recommended that you do not choose Fixed Increment user panning because JAWS may split the braille contractions on either edge of the display. Choose either Automatic or Best Fit user panning to keep JAWS from splitting braille contractions.

Expand Current Word

If this check box is checked, the word at the position of the braille cursor is displayed in computer braille. This check box is checked by default.

Updating JAWS

Freedom Scientific is continually seeking to improve and expand JAWS for Windows. Periodically, updates to JAWS will be released. It is recommended that you keep your software up-to-date so that you experience the greatest possible performance. It addition, Freedom Scientific will provide new and updated DAISY training materials for you to download if you choose. 

Updating your software is quick and easy. To search for updates to JAWS or new training materials, do the following:

Note: Your computer must be running Windows XP or later in order to use the Automatic Update procedure described below. In addition, you must be using ILM authorization.

1. Establish a connection to the Internet. 

2. Start JAWS. 

3. From the Help menu, choose Check for Updates. 

4. JAWS searches the Internet for updates and displays a list of any that are available to download. Use the arrow keys to move through the list, and press the SPACEBAR to select the check box next to any updates that you want to download and install. You can choose the Details button to view more information about the currently selected update. 

Note: If your computer has active firewall software (such as Windows Firewall), you may receive a warning indicating that either the FSAutoUpdate Application or FSAutoUpdate.exe is attempting to access the Internet. You must allow this process to access the Internet through the firewall in order to retrieve updates. If you are using Windows Firewall, you can do this by choosing the Unblock button when the warning message displays. For other firewall software, refer to the product's documentation. The firewall must allow JAWS to access the Internet using ports 20 and 21 or port 80.

5. When you are finished selecting updates, choose the Install button. You may be required to restart your computer. If the updates are not installed successfully, repair your installation of JAWS and then try the procedure again. 

Downloading Special Updates

Some users will be provided with a Freedom Scientific access code so that they can download special or private beta versions of JAWS. To search for these special updates, do the following:

1. Establish a connection to the Internet. 

2. Start JAWS. 

3. From the Help menu, choose About JAWS for Windows. 

4. Choose the Special Update Code button. 

5. Type your Freedom Scientific special update code in the edit box and then press ENTER. 

6. From the Help menu, choose Check for Updates. Then, follow the procedure described in the previous section to download and install updates. 

Updating Network JAWS

When you check for updates on the Network JAWS Server, only the version of JAWS installed on the server computer is updated. Each Network JAWS Client must then be updated separately. It is recommended that administrators update the Network JAWS Server before updating any Network JAWS clients. When you update the Network JAWS Server, ensure that no Network JAWS clients are running JAWS. 

Note: When you update a Network JAWS client, JFWX.version.rpt and JFWX.version.dmp (where X is the JAWS version number) are modified on the client, as well as JAWSUpdate.log in the network shared folder on the server. Therefore, administrators should grant Network JAWS clients read/write/append rights to these files.

Disabling Automatic Updates

If you do not want users to be able to update JAWS by opening the Help menu and choosing Check for Updates, you can disable this feature. This can prevent users from overwriting custom scripts that you have installed by performing an update. Organizations that use special JAWS versions or otherwise want more centralized control over updates may also want to disable this feature.

To disable Automatic Updates, do the following:

1. From the Options menu, choose Basics. 

2. Choose the Advanced button. 

3. Clear the Automatic Updates Available check box. 

4. Choose OK. 

Uninstalling JAWS

To uninstall JAWS, do the following:

1. Open the Start menu, and choose Control Panel. 

2. Use the arrow keys to select "Add or Remove Programs" and press ENTER. 

3. In the list of currently installed programs, use the arrow keys to select "Freedom Scientific JAWS X," where X is the JAWS version number. 

4. Press the TAB key until you move to the Remove button, and then press the SPACEBAR. 

5. Choose whether you want to uninstall JAWS only, or uninstall JAWS and all shared components. For more information, see Removing Shared Components. 

6. Choose the Next button and follow the instructions on your screen to uninstall JAWS. Setup provides you with speech during this process and, if you have a Focus or PAC Mate Braille display, allows you to read the screen using braille. 

Removing Shared Components

When you uninstall JAWS, you can choose to remove shared components. This refers to DAISY training materials, video drivers, and other components that are shared between different versions of JAWS, as well as among several other Freedom Scientific products, such as MAGic.

If you have another version of JAWS, or other Freedom Scientific products, installed on your computer, it is recommended that you choose not to remove shared components. If you remove them, your other Freedom Scientific products will no longer have all the necessary files. If you have no other Freedom Scientific products or versions of JAWS on your system, it is recommended that you choose to remove the shared components.

User Settings

When you uninstall JAWS, you are asked if you also want to delete your user settings files. These are configuration files, scripts, and other settings that you have customized or created. If you choose Yes, the files are deleted. If you choose No, the files are retained in C:\Documents and Settings\User Name\Application Data\Freedom Scientific\JAWS\X (where X is the JAWS version number)\Settings\ENU. Shared settings files are always removed.

Uninstalling Training Materials

To uninstall the DAISY training materials, such as the JAWS Basic Training and What's New in JAWS, do the following:

1. Open the Start menu, and choose Control Panel. 

2. Use the arrow keys to select "Add or Remove Programs" and press ENTER. 

3. In the list of currently installed programs, use the arrow keys to select the DAISY book you want to uninstall. 

4. Press the TAB key until you move to the Remove button, and then press the SPACEBAR. 

5. Repeat steps 3 and 4 until you have uninstalled all the DAISY books that you no longer want to keep on your computer. 

Script Files

If you added any new scripts to the C:\Documents and Settings\User Name\Application Data\Freedom Scientific\JAWS\X (where X is the JAWS version number)\Settings\ENU folder, those scripts are not deleted when you uninstall JAWS. JAWS only deletes files that it created during installation. The JAWS installation folder, and any folders that contain new scripts that were not installed with JAWS, also remain on your computer. JAWS does this so that you can retrieve any scripts you created or purchased separately and use them again.

If you replaced or modified any original JAWS scripts, such as the scripts for Internet Explorer or Microsoft Word, JAWS deletes those files during the uninstallation. If you want to save your modifications to the original JAWS scripts, it is recommended that you copy those scripts to a folder outside of the JAWS installation folder before uninstalling the program.

Personal Settings (.jsi) Files

Any .jsi files that you created while making changes to certain settings within JAWS are not deleted when you uninstall the program. These .jsi files remain in the JAWS installation folder.

Silent Uninstall

If you are a network administrator and need to uninstall JAWS silently, do the following:

1. Press WINDOWS Key+R. 

2. Choose the Browse button. 

3. Navigate to the folder C:\Program Files\Freedom Scientific Installation Information\356DE2A8-01EB-464e-9C33-0EEA3F923001-000. 

4. Select the file UnInstallJAWS.exe and press ENTER. 

5. Press END and then press the SPACEBAR. 

6. Type one of the following: 

· /Type Silent - Uninstalls JAWS. 

· /Type SilentRemoveShared - Uninstalls JAWS and removes all shared components. 

7. Press ENTER. 

Help!

JAWS provides a variety of ways to get help. JAWS tries to help you by providing information as you use your computer. To learn more about JAWS Help, follow the links below.

Using JAWS Help

JAWS help is accessed from the JAWS application window by pressing F1. The help window is a split window that contains the contents of the various topics on the right side. The left side of the window contains the Table of Contents (ALT+C), Index (ALT+N), Search (ALT+S), and Glossary (ALT+G) tabs. Press CTRL+TAB or the access keys to switch between these four tabs. Which ever of these tab pages is in use when you close the help window will be active the next time you access help.

Information is provided in the following sections to assist you in using this help system.

Using The Table of Contents (ALT+C)

When you first open the JAWS help system, the Table of Contents is displayed on the left side of a split window. The Table of Contents lists a number of books and pages. Books are categories containing a number of pages. The pages are topics containing information. UP ARROW and DOWN ARROW are used to move through the Table of Contents. RIGHT ARROW is used to open a book. LEFT ARROW is used to close a book. Press ENTER on a selected page to access the text of that topic, and then press F6 to move to the topic window. Press F6 to return to the Table of Contents,or press ALT+C to return to the Table of Contents from any section of the help system.

Using the Index (ALT+N)

Press ALT+N to move to the Index. Type in keywords to locate related topics. Keywords are help related terms or concepts. After typing in a keyword, press UP ARROW or DOWN ARROW to move through a list of matching index entries. Press ENTER to select a keyword. If there is only one matching topic, it is displayed in the topic window. Press F6 to move to the topic window. If there are multiple matching topics, they are displayed in a list. Select a topic from the list, press ENTER, then press F6 to move to the topic window.

Using Search (ALT+S)

Press ALT+S to move to the Search page. Type in the word or phrase you are looking for, and then press TAB to move to the List Topics Button. Press ENTER, and then press TAB to move to the list of topics.

Use the arrow keys to locate topics and press ENTER to open them. Press F6 to move to the topic window.

Using The Topic Window (F6)

Once you select a page in the Table of Contents, Index, or Search window and press ENTER to open it, press F6 to switch to the Topic window. 

Navigate through the text and links in the topic in the same manner as you would navigate on a web page. Read by line, sentence, or paragraph. Press ENTER on links to follow them. For more information on available navigation features, see Internet Explorer.

Using the Glossary (ALT+G)

Press ALT+G to move to the Glossary. Focus is initially in a list of Terms. Type the first few characters of the term for which you are looking and/or Arrow through the list of terms. Once you have located the desired term, press TAB to move to the definition for that term. Press INSERT+DOWN ARROW to read the definition. Other JAWS reading commands can also be used. Press TAB again to return to the list of terms.

Conventions

A shortcut key can be a single key on the keyboard or several keys that are pressed in combination. In this help system, the plus sign (+) indicates when keys are to be pressed in combination. For example, INSERT+RIGHT ARROW can be used to read the next word in a document. 

Shortcut keys can also consist of sequences of pressed keys, where some keys are pressed and released, and then other keys are pressed. A comma (,) indicates when keys are to be pressed one after the other. For example: ALT+F, X can be used to close many applications. In this example, press ALT and F together, release the keys, and then press X.

When referring to shortcut keys that require the use of the number pad, the word NUM PAD always precedes that shortcut key. For example: INSERT+NUM PAD 5. If the shortcut key does not say NUM PAD, use the number from the number row.

Help at Your Fingertips

The following commands provide quick access to Help as you use JAWS. 

Keyboard Help - INSERT+1 

Turn on this feature to explore JAWS commands. As you press key combinations, JAWS tells you which keyboard commands do what, safely - without actually performing the command. Press INSERT+1 again to exit keyboard help.

Screen Sensitive Help - INSERT+F1

Press INSERT+F1 and JAWS provides messages that describe the current control or window. Screen Sensitive Messages will appear in the Virtual Viewer, from which you can follow links to other related topics. 

Read Control and Help - INSERT+TAB 

INSERT+TAB speaks the tutor message for the current control or window, and the access key to move directly to that control, if one exists. Using this keystroke is a great way to review tutor and access key information without moving away from a control and back, and without needing to turn on automatic announcement of these messages.

Windows Key Help - INSERT+W

Windows Key Help presents a message that lists Windows hot keys that you may find helpful within the context in which you are presently working. Windows Key Messages will appear in the Virtual Viewer. 

Hot Key Help - INSERT+H 

Hot Key Help presents a message in the Virtual Viewer that lists JAWS hot keys that you may find helpful within the context in which you are working.

Screen Sensitive Help Technical - CTRL+INSERT+F1 

When writing JAWS scripts, use this keystroke to display a message in the Virtual Viewer that lists the Control ID, Class, and Handle information for the current control.

Virtual Viewer

The Virtual Viewer is a message window allowing you much greater functionality with many JAWS messages. Press INSERT+F1 to experience a message in the Virtual Viewer. While INSERT+F1 messages are the messages most frequently displayed in the Virtual Viewer, other messages appear there as well:

· Hot Key Help Messages (INSERT+H) 

· Windows Key Help messages (INSERT+W) 

· Screen Sensitive Help Technical messages (CTRL+INSERT+F1) 

· Several types of informational messages within Microsoft Office applications 

Easily review information with standard reading commands. Read by line, word, or character. Select text as you would in any word processing program and copy it to the clipboard. Press CTRL+HOME or CTRL+END to move to the top or bottom of the message.

Links take you to other messages or activate commands within your applications or within Windows. Press ENTER to select a link, or press INSERT+F7 to list all links in a message and select the one you want from the list.

Press ESC to close a message, or just TAB to the next control in a dialog and the message closes automatically. The following commands also perform their normal actions and automatically close the Virtual Viewer: SHIFT+TAB, CTRL+TAB, F1, INSERT+J, INSERT+F1+F1, CTRL+ESC.

By default, messages are visible on the screen in the Virtual Viewer, and this is very helpful for sighted trainers. However, the Virtual Viewer can be set so it is not visible on the screen. Change this in the Basic Settings Dialog under the Options menu in the JAWS application window, or in the User options dialog in Configuration Manager.

Note: If you want the Virtual Viewer visible in some applications, but not others, use Configuration Manager to change this setting.

Tutor Mode

Tutor messages provide navigation tips in Windows and applications. Tutor messages are spoken in a different voice than other JAWS messages. An example of a common tutor message is after pressing the ALT key to access the JAWS menu bar, you will hear, "To move through items press LEFT or RIGHT ARROW." You can activate or deactivate JAWS' Tutor messages, by first selecting the Options menu, and then choosing Basics. 

You can also set up your own custom Tutor messages through the new Prompt Creator utility. This lets you specify messages that will be spoken each time you use a control - just a quick reminder, or a short tip reminding you of what other controls might need to be used with the current one. To learn more about creating custom Tutor messages and control prompts, refer to Creating a Prompt.

Access Key Announcement

JAWS can announce access keys as you navigate through menus or dialogs or both. Use access keys to move directly to a control in a dialog box or an item in a menu. For example, with Speak All Access keys turned on, press ALT to move to the JAWS menu bar. Press DOWN ARROW to open the Options menu and select Basics. JAWS announces the name of the selected command and then says "B." B is the access key for the menu item called Basics. The next time that you go to the Options menu, you know that you can press B to quickly activate that menu item. As you navigate through the menus, make note of the access keys, so next time you use the menu, you will not have to use the arrow keys to move through each menu item. Instead, you can press the access key to automatically activate that menu item. 

You can specify which access keys you want to hear in the Basics dialog, activated from the Options menu. You can turn off access key announcement, you can have JAWS Speak All access keys, Speak menu access keys only, or Speak dialog access keys only.

JAWS Training Materials

The Basic Training for JAWS and other training materials are included in DAISY format on your JAWS program CD. You can also download training materials by using the Automatic Updates feature. You can listen to and read the training modules by using the FSReader Demo DAISY reader included with JAWS. To start FSReader Demo, open the Help menu and choose Training. For more information on using FSReader, select the "FSReaderGettingStarted" DAISY book and press ENTER. 

For information on installing the Training Materials, see JAWS for Windows Setup. You can also download training materials from the Freedom Scientific Web site. To install downloaded training materials, extract them into the C:\Program Files\Freedom Scientific\Training\JAWS\Enu folder. 

The JAWS Basic Training modules give you the best possible start on your road to mastering Windows with JAWS. The set takes you logically from starting JAWS to working in the Windows environment. The modules include actual samples of what you will hear as you perform various Windows and JAWS operations. All users are encouraged to take advantage of this training. Once JAWS is running, you should listen to all modules and perform the operations along with them.

Tip: There are more demonstration audios that discuss specific features of JAWS on the Freedom Scientific Training Headquarters. 

Updating Your Training Materials

Periodically, Freedom Scientific will release new DAISY training materials that you can download by using the Automatic Updates feature. To search for new training materials, open the JAWS Help menu and choose Check for Updates.

The JAWS Program Group

When you install JAWS, the JAWS program group is added to your Windows Start menu. To access this program group, do the following: 

1. Press WINDOWS Key to open the Start menu. 

2. Use the UP and DOWN ARROW keys to select Programs and then press RIGHT ARROW. If you are using Windows XP, select All Programs instead. 

3. Use the UP and DOWN ARROW keys to select JAWS and then press RIGHT ARROW. This is the JAWS program group. 

4. Each command in the JAWS program group is described in the next section. To carry out one of these commands, use the arrow keys to select the command and then press ENTER. 

Explore JAWS

The items in the Explore JAWS submenu are shortcuts to folders that contain important JAWS files. These shortcuts display the contents of the various folders in Windows Explorer. 

· Explore My Settings - View your user-specific settings files. These are the settings associated with your user profile. 

· Explore Program Files - View the JAWS program files. 

· Explore Shared Settings - View shared settings files for this computer. 

· Explore the Manuals - View electronic copies of printed JAWS documentation and other useful materials, including the JAWS Quick Start Guide. 

Tools

To open the Tools submenu, use the UP and DOWN ARROW keys to select it and then press RIGHT ARROW. The Tools submenu contains the following shortcuts.

Synthesizer and Braille Manager

Use this command to change which synthesizer and braille display drivers are installed on your computer. You can also change output port options for your currently installed braille displays. For more information, see Synthesizer and Braille Manager.

Display Chaining Manager

Use this command to remove or change the order of drivers in your system's display chain. Display Chaining Manager (DCM) allows multiple assistive technology aids (such as screen readers and screen magnifiers) to be installed on a single computer. For more information, see Display Chaining Manager.

Dongle Viewer

Use this command to view license information for the dongle currently connected to your computer. For more information on using a dongle to authorize JAWS, refer to Dongle Authorization.

PAC Mate Desktop

PAC Mate Desktop is a program that allows you to establish a connection between your PAC Mate and a computer with JAWS installed. You can connect your PAC Mate and computer using a USB cable, network connection, modem, or wireless local area network. Once you establish a connection, you can run programs, read documents and Web pages, and work with files and folders on your computer using only your PAC Mate. For more information, see Using PAC Mate Desktop.

Settings Packager

Use this command to start Settings Packager. Settings Packager is a program that allows you to import and export speech and sound schemes, PlaceMarkers, and personalized Web settings (including custom labels). For information about using this program, start Settings Packager, open the Help menu, and choose Help Topics.

Start JAWS with Eloquence

Use this command to start JAWS with the default Eloquence speech synthesizer.

Video Intercept Manager

Use this command to start Video Intercept Manager. Video Intercept Manager detects problems related to video that may prevent JAWS from functioning properly. For more information, see Video Intercept Manager.

Network JAWS Admin

Use this command to start HJ Administrator. You can use HJ Administrator to set up and manage user accounts for Network JAWS. For more information, see Introduction to HJ Administrator. This command only appears if you installed Network JAWS. 

Braille Viewer

Braille Viewer is a program that provides textual representation on the computer screen of the output received on a refreshable Braille device. Braille Viewer can assist sighted instructors or testers that do not read Braille or may not have access to a Braille display. For more information, see Braille Viewer.

FSReader Demo

Use this command to start FSReader Demo. This program allows you to listen to DAISY books created by Freedom Scientific. The JAWS Basic Training and What's New are both available in DAISY format. You can install these books when you install JAWS. After you start FSReader, open the File menu and choose Open. You can listen to the included "FSReaderGettingStarted" DAISY book to learn how to use the program.

Help

Use this command to view the JAWS Help system. For more information, see Using JAWS Help. 

JAWS

Use this command to start JAWS. For more information, see Starting JAWS for Windows. 

Run HJPad

Use this command to start HJPad. HJPad is a word processing program intended for use as a training tool for JAWS users. For more information, see HJPad.

Starting JAWS for Windows

After installing JAWS, you can configure it to start manually, or to launch automatically when your computer starts. The latter is known as running JAWS as a service. Starting automatically is useful for those who require speech immediately. This topic describes how to starts JAWS manually, configure JAWS to start automatically in Windows Vista, and configure JAWS to start automatically in Windows XP. 

Manually Starting JAWS

To manually start JAWS, do the following:

1. Press WINDOWS Key+R to open the Run dialog box. 

2. Type "JAWSX" (where X is the version number such as 9 or 10) and press ENTER. 

Tip: To override your user settings and start JAWS with only the default factory settings, type "JAWSX /default" (where X is the version number such as 9 or 10).

You can also assign a shortcut hot key to the JAWS shortcut. For more information, please see Define a Hot Key.
Automatically Starting JAWS with Windows Vista

When you first install JAWS, the JAWS Startup Wizard launches. The Run JAWS Settings page in the wizard provides several options for starting JAWS. Use the default settings on this page since these will ensure that JAWS always loads, starts, and runs before and after Windows Vista launches. If these settings change and later you want to restore the default values, do the following so that JAWS starts automatically in Windows Vista:

1. Start JAWS manually as previously described, and press INSERT+J to access the JAWS application window. 

2. Press ALT+H to select the Help menu, and then Z to launch the JAWS Startup Wizard. 

3. Choose Next until the Run JAWS Settings page opens. 

Note:  If you have an Administrator account, four options appear in the wizard. If you have a Standard User account, only the Start JAWS after log on for this user combo box appears.

4. Do one of the following: 
For an Administrator account: 

· Press S to jump to the Start JAWS at the Log On Screen check box and make sure it is selected. To select the check box, press SPACEBAR. 

· Press TAB and make sure that the Start JAWS after Log On for all Users check box is cleared 

· Press TAB and make sure that the Start JAWS after Log On for the User combo box is set to Always. 

· Press TAB and make sure that the Run JAWS from System Tray check box is cleared. 

For a Standard User account:

· Make sure that the Start JAWS after Log On for this User combo box is set to Always. 

5. Choose ENTER to continue to the next page. 

6. On the last page of the JAWS Startup Wizard, choose Finish to accept the changes and close the wizard.

The next time you start Windows Vista, JAWS starts automatically, and is one of the first programs available. 

Automatically Starting JAWS with Windows XP

When you first install JAWS, the JAWS Startup Wizard launches, and on the Run JAWS Settings page, the Automatically Start JAWS check box is selected. Use the default setting ensure that JAWS always loads, starts, and runs before and after Windows XP launches. If you clear this check box and later want to restore the default value, do the following so that JAWS starts automatically in Windows XP:

1. Start JAWS manually as previously described, and press INSERT+J to access the JAWS application window. 

2. Press ALT+H to select the Help menu, and then Z to launch the JAWS Startup Wizard. 

3. Choose Next until the Run JAWS Settings page opens. The focus is on the Automatically Start JAWS check box. 

4. Press SPACEBAR if the check box is not selected. 

5. Choose ENTER to continue to the next page. 

6. On the last page of the JAWS Startup Wizard, choose Finish to accept the changes and close the wizard. 

The next time you start Windows XP, JAWS starts automatically, and is one of the first programs available. 

Reading Screens and Documents

Many speech functions in JAWS are accessed by using the numeric keypad (NUM PAD) located on the far right side of your keyboard. Usually this NUM PAD is used to type numbers so you must turn off the number lock function. Do this by pressing the NUM LOCK key in the upper left corner of the NUM PAD. 

JAWS uses the INSERT key at the bottom left of the NUM PAD in combination with the other keys on this keypad to control what JAWS will speak.

To start JAWS reading the screen, press the key combination INSERT+DOWN ARROW. This is the Say All command. While using the Say All command, you can press the LEFT or RIGHT ARROW keys to rewind or fast forward through the text. You can also press PAGE UP or PAGE DOWN to increase or decrease the speech rate. To halt speech, press the CTRL key.

Tip: JAWS can automatically switch to a more natural-sounding voice when reading with the Say All command. To choose which speech synthesizer you want to use, open the Utilities menu and choose Configuration Manager. Next, open the Set Options menu and choose Say All Options. For more information, see Say All Options Dialog.

Here are the rest of the keystroke combinations using this keypad and the name of the command.

· NUM PAD 5 Say Character 

· INSERT+NUM PAD 5 Say Word 

· INSERT+NUM PAD 5 twice  Spell Word 

· INSERT+LEFT ARROW Say Prior Word 

· INSERT+RIGHT ARROW Say Next Word 

· INSERT+UP ARROW Say Line 

· INSERT+HOME (7) Say To Cursor 

· INSERT+PAGE UP (9) Say From Cursor 

· INSERT+PAGE DOWN (3) Say Bottom Line Of Window 

· INSERT+END (1) Say Top Line Of Window 

· CTRL+INSERT+DOWN ARROW Start Skim Reading 

Skim Reading

The Skim Reading feature lets you quickly browse through long documents by reading the first part of each paragraph. To begin skim reading in a document, press CTRL+INSERT+DOWN ARROW. By default, JAWS reads the first line of each paragraph, but you can choose to read the first sentence of each paragraph instead or set up your own skim reading rules. To change your skim reading preferences, press CTRL+SHIFT+INSERT+DOWN ARROW. For more information on these options, see Skim Reading Dialog.

Tip: While skim reading, you can begin reading the entire document by pressing INSERT+DOWN ARROW to carry out the Say All command. To begin skim reading again, press CTRL+INSERT+DOWN ARROW. 

Adjust JAWS Options 

The Adjust JAWS Options tree view contains various options that you can apply temporarily to the program you are currently using. While using any program in Windows, press INSERT+V to open the Adjust JAWS Options tree view. Select an option with the arrow keys and then press SPACEBAR or use the Execute button to cycle through the available settings. Press ENTER to accept your changes and close the dialog box. 

Most changes you make using the Adjust JAWS Options tree view remain in effect until you quit the program. However, some options (such as typing echo) will return to the original setting if you press ALT+TAB to switch to another program and then switch back. Other settings (such as user verbosity) remain in effect until you quit JAWS. If you want to change a setting permanently, use the JAWS Configuration Manager.

Note: Some business programs, such as Microsoft Word and Excel, save certain settings with your files. Each time you open those files, JAWS will use the settings you specified last time you worked with them.

Some options are specific to certain programs. For example, if you press INSERT+V in Microsoft Word, you will see special settings that only apply to Word. The following tables describe options that are available for all Windows programs. For more information on specific options for Windows programs, refer to the appropriate help topic in the Popular Applications section.

General Options Group

	General Options Item 
	Description 

	User Verbosity
	There are three levels of verbosity: Beginner, Intermediate, and Advanced. The beginner level provides the maximum amount of information spoken, while intermediate and advanced levels provide fewer details.

To customize your own settings for any one of these levels, open the Configuration Manager and go to the Verbosity Preferences under Verbosity Options in the Set Options menu. 

	Progress Bar Announcement
	Use this option to specify whether JAWS should announce the status of progress bars. You can choose how often JAWS announces the state of progress bars during a process in the User Options dialog box of Configuration Manager.

	Top and Bottom Edge 
	This option controls whether or not JAWS beeps when it encounters a top or bottom boundary while you navigate.

· Off: No beep is heard when a top or bottom boundary is encountered. 

· Alert with Sound: A beep is heard when a top or bottom boundary is encountered. 

	Graphics Verbosity
	This option allows you to determine if JAWS announces when graphics are encountered, and which graphics are announced. 

· No Graphics: JAWS does not announce graphics as they are encountered. 

· Labeled Graphics: JAWS only announces graphics that have been labeled with the graphics labeler. 

· All Graphics: JAWS announces all graphics as they are encountered. JAWS reads the labels for the graphics, if they are assigned. If no labels are assigned for a graphic, JAWS assigns a unique number. 

	Screen Echo 
	This option allows you to select what information is echoed when text on the screen changes.

· Echo No Text: Changes to displayed text are not echoed. 

· Echo Highlighted Text: Changes to highlighted text are echoed. 

· Echo All Text: Changes to any displayed text are echoed. 


Reading Options Group

	Reading Options Item 
	Description 

	Smart Word 
	This option controls how JAWS reads words with punctuation in them, such as phone numbers. When off, JAWS reads the punctuation symbol under the cursor. When on, JAWS reads the entire word.

	Language Detection
	This setting allows you to enable or disable automatic language detection. If enabled, JAWS reads text that is marked or indicated as a specific language using the appropriate synthesizer voice for that language. If disabled, JAWS does not change the voice of the synthesizer when reading text in another language.

	Custom Labels 
 
	This option allows you to enable or temporarily disable custom labels that you have defined for Web pages or forms. This feature allows individuals, such as support staff, developers, and testers, to suppress their custom labels while working with a document or Web page, without permanently deleting them. For more information, see Custom Labels.


Say All Options Group

	Say All Options Item 
	Description 

	Say All By
	This option allows you to determine how JAWS reads text when you use the Say All command (INSERT+DOWN ARROW).

· Line with Pauses: JAWS reads by line, pausing slightly at the end of each line. 

· Line without Pauses: This option allows for smoother reading. 

· Sentence: Select this option for programs where Say All sounds choppy. This moves the pauses between elements to the ends of sentences, making the reading sound smoother. 

· Paragraph: This option is very useful in large documents, since you can press the right SHIFT key to quickly move through the paragraphs without needing to interrupt Say All. 

	Capitalization
	Use this option to specify if JAWS should announce capitalization when reading with Say All (INSERT+DOWN ARROW). If you choose On, JAWS says, "Cap" for single capital letters, and, "All cap," for capitalized words. 


Editing Options Group

	Editing Options Item 
	Description 

	Typing Echo
	This option allows you to specify how JAWS repeats information you type. 

· Off: Select this option if you do not wish to hear typing echoed. 

· Characters: Each character you type is echoed. 

· Words: Each word you type is echoed after you press SPACEBAR or ENTER. 

· Characters and Words: Characters are echoed as you type them and words are echoed after you press SPACEBAR or ENTER. 

	Caps Indicated
	Use this option to tell JAWS when to indicate capitalization.

	Punctuation
	This option allows you to determine how much punctuation JAWS should read.

	Indentation Indication
	If you choose Yes for this option, JAWS indicates changes in indentation, according to rules defined in the Speech and Sounds Manager. 


Synthesizer Group

	Synthesizer Item 
	Description 

	Synthesizer
	Use this option to turn speech on and off.


	Back 
	
	Next 
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The JAWS application can be configured to run in a normal window, or to run from the system tray. This topic provides a detailed description of the options available in the JAWS application window. If you run JAWS from the system tray, these same options are still available through a shortcut menu. 

When open, the JAWS application window displays the following menus: 

Options Menu Overview

This topic describes the menu items found in the Options menu of the JAWS application window. 

Basics...

Select this menu item to open a dialog containing basic JAWS settings. for more information, please refer to The Basic Settings Dialog.

Voices

Open this submenu to access two dialogs to adjust speech settings.

Global Adjustment...

Select this item to open a dialog to globally adjust voice settings. For more information, please refer to The Global Voice Settings Dialog. 

Individual Voice Adjustment...

Select this item to open a dialog to individually adjust voice settings. For more information, please refer to The Individual Voices Dialog.

Note: Before making adjustments to individual voices, use the Global Voice Settings dialog to make all adjustments you wish to apply to all voices. Then make any desired individual voice adjustments. Global voice adjustments override individual voice adjustments, so it is important to make changes in this order. 

Braille...

Select this item to open a dialog to adjust Basic Braille settings. For more information, please refer to The Braille Basic Settings Dialog.

Manage Application Settings...

Select this item to enable or disable applications in which the settings have been modified. Changes may have been made through the Configuration Manager or with custom scripts. This dialog allows you to temporarily disable those application-specific settings quickly, so that you can troubleshoot by ruling out any changes made in JAWS. This dialog is ideal for technical support personnel who are assisting users with their installed version of JAWS. For more information, please refer to The Manage Application Settings Dialog.

Exit

If you select this item, a dialog is brought up to confirm whether or not you wish to exit the JAWS application. Press ENTER to exit JAWS, or press ESC to return to the JAWS application window.

Utilities Menu Overview

This topic describes the Utilities menu items found in the JAWS application window. For more information on the options accessible from this menu, please see Overview of the JAWS Utilities.

Merge Utility

This menu item provides access to the Merge Manager.

Synthesizer and Braille Manager

This menu item provides access to the Synthesizer and Braille Manager.

Configuration Manager

This menu item provides access to the Configuration Manager. 

Keyboard Manager

This menu item provides access to the Keyboard Manager.

Dictionary Manager

This menu item provides access to the Dictionary Manager.

Frame Viewer

This menu item provides access to the Frame Viewer.

Script Manager

This menu item provides access to the Script Manager.

Navigation Quick Key Manager

Use this menu item to open the Navigation Quick Key Manager. 

Re-Initialize Authorization

This menu item allows you to force JAWS to search for valid ILM authorization. If the search is successful, JAWS displays your serial number.

Video Intercept Manager

This menu item provides access to the Video Intercept Manager.

Language Menu Overview

This topic describes the Language menu items found in the JAWS application window. 

JAWS Language

This menu item provides access to a submenu of language version choices for JAWS. This menu is unavailable in English only versions of JAWS.

Voice Profiles

This menu item lets you instantly switch to any existing voice profile and its installed synthesizer such as Eloquence, SAPI 5, or RealSpeak Solo Direct. You can also select Create New which opens the Global Voices dialog box allowing you to make and add a new voice profile. Finally, you can use No Speech to temporaily turn off speech. Refer to Global Voices for additional information about voice profiles. 

Help Menu Overview

This topic describes the Help menu items found in the JAWS application window. 

Training

Choose this menu item to start FSReader. A dialog box that allows you to open a DAISY book appears. If you installed the JAWS Basic Training or What's New, you can select and open either of these books. These DAISY books guide you through the new features of your JAWS version and help you learn the basics of using JAWS. 

JAWS Help Topics

This menu item provides access to the JAWS help system. 

Keyboard Commands

This menu item opens the JAWS help system, and moves you to topics providing information on available commands in JAWS.

What's New

This menu item allows you to view descriptions of the new features added in this version of JAWS. You can also view new features added in previous versions. 

End User License Agreement

This menu item opens the help system to the JAWS License Agreement. 

Technical Support

This menu item provides access to information on how to contact Freedom Scientific Technical Support.

Web Resources

Web Resources provides the following helpful links to Freedom Scientific products and resources:

· JAWS Headquarters – a one-stop resource for JAWS. Use these pages to download software updates, locate resources, and learn new ways to use JAWS. 

· Technical Support – Use this link to access support bulletins and FAQs. 

· FS Activate – Use this link to verify the number of available JAWS activation keys, request a reset of the number of activations allowed for a registered user, or retrieve an activation license code based on your Authorization number and Locking code. 

· Surfing the Internet – Use this link to access Surf's Up! A useful tool that teaches you how to work with and read HTML pages with JAWS. 

· MAGic Screen Magnification – Learn more about MAGic, Freedom Scientific's screen magnification software. 

· Training Headquarters – Learn more about training options and tutorials available from Freedom Scientific. 

· PAC Mate Headquarters – Use this link to access information, documentation, and tools available for the PAC Mate accessible PDA. 

· www.FreedomScientific.com – Use this link to open the Freedom Scientific home page. 

About JAWS for Windows

This menu item provides access to the version number, serial number, copyright notices, your computer's unique locking code, and other important information about JAWS. It also contains information about your SMA, or software maintenance agreement. Purchasing an SMA for JAWS provides you with automatic upgrades at a reduced price for a specific amount of time. Note that although the About box gives SMA information, if the information in the Freedom Scientific database differs, the database information is assumed to be accurate and up to date.

Startup Wizard

The JAWS Startup Wizard is a helpful tool that allows you to configure specific JAWS parameters, such as automatically starting JAWS when you turn on your computer, or install training material, like FSReader, which is Freedom Scientific’s DAISY book reader, or load various other JAWS items and functions. During a new JAWS installation, the Startup Wizard appears after you complete product activation. However, it can always be accessed later from the JAWS Help menu by pressing ALT+H and choosing Startup Wizard. 

Update Authorization

Use this command to activate JAWS. JAWS runs in 40 minute mode until you activate the software. You will need your authorization number, locking code, and a connection to the Internet. You can also use this command if you want to enter an activation license code that you received from FSActivate.com, Freedom Scientific Customer Service, or your distributor. 

Note: If you change certain components of your computer's hardware, you may need to reactivate JAWS. You can use this command at any time to activate your software. 

For more information on activating JAWS, see Activating with Internet License Manager. For information on activating JAWS if your computer cannot connect to the Internet, see Activating by Telephone, Activating by Fax, or Activating through a Trusted Third Party.

Check for Updates

Choose Check for Updates from the JAWS Help menu to search for new versions of the software on the Web. JAWS then checks to see if any updates are available and displays a list for you to choose from. The list of updates includes the file size and details about what the update contains. You can then choose to download and install any of the new software versions in order to keep JAWS up-to-date. Related material, such as DAISY training materials, can also be downloaded and updated. This service will help Freedom Scientific make minor changes and improvements to JAWS much more frequently.

Internet access and administrative rights are required to check for updates. Automatic updates are available for the English version of JAWS only. Automatic updates are only supported under Windows XP.

Tip: If you want to disable Automatic Updates for any reason, open the Options menu and choose Basics. Then, choose the Advanced button and clear the Automatic Updates Available check box. 

Manage Application Settings

This dialog allows you to enable or disable customized settings created for an application using either Configuration Manager or a script. 

Application Settings

This list box is a directory of applications in which the default configuration values were changed using either Configuration Manager or a script. A check box appears before each modified application. If the check box is checked, JAWS uses the customized settings. If the check box is unchecked, JAWS will not use the customized settings. 

Enable All

Select this button to check the check boxes for all applications in the list box. The modified settings will be used for each application. 

Disable All 

Select this button to uncheck the check boxes for all applications in the list box. The modified settings will not be used for each application. 

Remove Selected

Select this button to remove any checked application from the list box. 

OK

When you select this button, any changes you have made are saved, and you are returned to the JAWS application window. 

Cancel

When you select this button, any changes you have made are discarded, and you are returned to the JAWS application window. 

JAWS Basic Settings

To change your JAWS basic settings, open the Options menu and choose Basics. This topic documents the settings available in the Basic Settings Dialog. 

Tutor Messages

Use this series of radio buttons to determine which Tutor messages are spoken. Tutor messages provide navigation tips in applications and Windows.

· Turn Off Menu and Control Help: No Tutor messages are spoken. 

· Announce Menu and Control Help: All Tutor messages are spoken. 

· Announce Custom Messages Only: Only custom Tutor messages added through Prompt Manager are spoken. 

Access Keys

Access keys are the keys you press to move directly to a control or an item in a menu. Use this group of radio buttons to specify which access keys are announced: all access keys, only access keys for menu items, only access keys for controls in dialogs, or no access keys.

Automatically Start JAWS

Having JAWS start automatically, which is also known as running JAWS as a service, is a great help to those who require speech immediately. There are two ways to automatically start JAWS depending on the Windows operating system on your computer.

Windows XP

For Windows XP™ users, this option appears as a check box labeled Automatically Start JAWS. Select it to start JAWS each time you start Microsoft Windows. By doing this, JAWS is one of the first items that becomes available so that you have access to the Windows Log On dialog box through speech and braille.

Note: This check box is only available if JAWS is running from a local hard drive. If JAWS is running from a removable disk or network drive, the check box is not available.

Windows Vista

For Windows Vista™ users, this option appears as a button that opens the Start JAWS Options dialog box. Use it to determine if JAWS starts before or after you log on and start Windows Vista. 

Note: The default values of the Start JAWS Option dialog box assure that JAWS is always loaded and running before and after you start Windows Vista. If you have an Administrator account, three options appear. If you have a Standard User account, only the Start JAWS after log on for this user combo box appears. There is no need to change the default values. 

· Automatically start JAWS at the Log On screen: When this check box is selected, JAWS will load and start when the Windows Vista log on screen appears. The check box is checked by default. 

Administrator rights are required to change this setting. If you have Standard user rights, you cannot change the value of this check box, and you will not hear it using JAWS. Uncheck this check box if you want JAWS to be off when the log on screen appears. The check box value applies to all users who log on to this version of JAWS on this computer. 

· Automatically start JAWS after log on for all users: When this check box is selected, JAWS will load and start after you log on to Windows Vista. It is unchecked by default.

Note: The only time that it is necessary to change the value of this check box is if you have an Administrator account on this computer, and you want to control how JAWS starts for all subsequent users who log on to Windows Vista using this computer. If you do not have Administrator rights, you cannot change the value of this check box, and you will not hear it using JAWS. 

If you have Standard user rights on this computer, refer to the combo box labeled Start JAWS after log on for this user for information that describes how to start JAWS after logging on to Windows Vista.

· Start JAWS after log on for this user: This combo box allows an individual user to control if JAWS starts after he or she logs on to Windows Vista. This combo box has three values: Always, Never, and Using the All Users Setting. The default value is Always. 

Note: This combo box is available to users with Administrator and Standard user rights. The value selected for the combo box overrides the value of the Automatically start JAWS after log on for all users check box. 
If Always is selected, JAWS will start every time the current user logs on to Windows Vista.
If Never is selected, JAWS will never start after the current user logs-on to Windows Vista. 
If the current user selects the value labeled Using the All Users Setting, then the following can happen:
JAWS will start after the current user logs on if the Administrator selected the Automatically start JAWS after log on for all users check box.
JAWS will not start after the current user logs on if the Administrator unchecked the Automatically start JAWS after log on for all users check box.

Automatically Start PAC Mate Desktop

If you select this check box, PAC Mate Desktop automatically starts when you start JAWS. PAC Mate Desktop allows you to issue commands to your computer from your PAC Mate via an ActiveSync connection. For more information, see Using PAC Mate Desktop.

Warning: Do not select this check box if Microsoft ActiveSync is not installed on your computer. To download ActiveSync, visit www.microsoft.com.

Run JAWS from System Tray

This option removes JAWS from the TAB order and places it in the system tray. This change takes effect the next time you start JAWS. To access JAWS from the system tray, press INSERT+J. This brings up a shortcut menu with the Options, Utilities, Languages, and Help items listed. Press RIGHT ARROW to access sub-menus for each of these items. Press ALT to close this shortcut menu. 

Show Virtual Viewer on Screen

Use this check box to specify whether the Virtual Viewer is visually displayed on the screen when you access context-sensitive (INSERT+F1) help and other helpful messages. It may be useful in training environments to show the Virtual Viewer. However, in a presentation application like PowerPoint, it might disrupt your presentation to display the Virtual Viewer. JAWS functions the same in these messages regardless of whether the Virtual Viewer is visible. For more information on using the Virtual Viewer, see Virtual Viewer.

Note: You must quit and restart JAWS for changes to this option to take effect.

Use Keyboard Layout

Use this combo box to select the desired keyboard layout. Select from desktop, laptop, or kinesis. JAWS keystrokes frequently use keys located on the numeric keypad, which usually is on the right side of the keyboard. Most laptop computers do not have the numeric keypad, so JAWS provides alternate keystrokes, called laptop keystrokes. If your keyboard has the numeric keypad, choose the desktop keyboard option. For those of you who are using any of the Kinesis keyboards, select kinesis as this implements the features of these keyboards. If your keyboard does not have a numeric keypad, choose the laptop keyboard option. 

Windows System Parameters

Select this button to open the Windows System Parameters dialog. The Windows features checked in the Windows System Parameters dialog are disabled when JAWS starts, and are enabled again when JAWS closes. Features that were disabled before JAWS started are not enabled when JAWS is closed. Disabling these items improves JAWS functionality, so we recommend you leave all items checked. For more information on these features, refer to Windows Help.

Enable Enforced Write Protect

The Enable Enforced Write Protect check box is available in the Windows System Parameters dialog box. It is recommended that you leave this check box cleared if you use your computer for multi-session work, such as Citrix/Terminal Services remote access or fast user switching. You should also leave this check box cleared if your network administrator uses service management software to install updates or make changes to your computer remotely. If you select this check box, your network administrator cannot update or modify JAWS files remotely.

Note: You cannot select this check box if Fast User Switching is enabled in Windows.

Advanced 

Choose the Advanced button to open a dialog box containing the following additional JAWS options:

· Automatic Updates Available - The Automatic Updates Available check box is selected by default. Clear this check box if you do not want users to be able to download JAWS updates by opening the Help menu and choosing Check for Updates. This can prevent users from overwriting custom scripts that you have installed by performing an update. Organizations that use special JAWS versions or otherwise want more centralized control over updates may also want to clear this check box. For more information on automatic updates, see Updating JAWS. 

· Try Remote Access Speech on Startup - If you clear this check box, JAWS uses the host's speech synthesizer and sound card to provide speech feedback during remote JAWS sessions and when using PAC Mate Desktop. For example, if you clear this check box and use PAC Mate Desktop, JAWS speaks through your computer's speakers rather than your PAC Mate's speakers. 

· Try Remote Access Braille on Startup - If you clear this check box, JAWS uses the host's default Braille display during remote JAWS sessions and when using PAC Mate Desktop. For example, if you clear this check box and use PAC Mate Desktop, JAWS displays information on the Braille display connected to your computer rather than your PAC Mate's Braille display. 

· Use Authorization from PAC Mate - Clear this check box if you want to make use of third-party scripts that are locked to your JAWS serial number while using PAC Mate Desktop. Remote JAWS will use the computer's authorization information (including the serial number) instead of the PAC Mate's information. This check box is selected by default. 

· Enable Remote Access Client - Select this check box if you want to use JAWS during terminal sessions. You can clear this check box if you will not be using JAWS when you connect remotely to another computer. You must purchase the remote access option for your software license to use JAWS during terminal sessions. 

· Enable Remote Access Server - Select this check box if users that connect remotely to your computer will be using JAWS during their terminal sessions. If you clear this check box, remote JAWS users will not have speech and braille access to terminal sessions. 

· Run JAWS Without Speech - Select this check box if you want JAWS to run without speech. The setting takes effect the next time JAWS starts. If you want to temporarily run JAWS without speech and without restarting, choose the No Speech profile from the JAWS Language menu. 

OK

When you select this button, any changes you have made are saved, and you are returned to the JAWS application window.

Cancel

When you select this button, any changes you have made are discarded, and you are returned to the JAWS application window.

Braille Basic Settings

To change your Braille basic settings, open the Options menu and choose Braille. This topic documents the settings available in the Braille Basic Settings Dialog.

Default Braille Display

Use this combo box to select the default Braille display. The default Braille display is active each time you start JAWS.

Modify Settings

Select this button to open a dialog to modify connection settings for the default Braille display.

Show Braille Load Error

If this check box is checked, when JAWS starts, a message is displayed when the default Braille display driver cannot be loaded. 

Translation Table

Use this combo box to select the Braille translation table you wish to use. The translation table determines how Braille characters are displayed on your Braille display. 

Add Braille Display

Select this button to add a Braille display for use with JAWS. 

Advanced

Select this button to open a dialog containing more advanced Braille settings. This same dialog is available from Configuration Manager, under the Set Options menu. The dialog opened with this button is not available when running a Network Client version of JAWS. 

OK

When you select this button, any changes you have made are saved, and you are returned to the JAWS application window.

Cancel

When you select this button, any changes you have made are discarded, and you are returned to the JAWS application window.

Global Voices

Use this dialog box to change the synthesizer, voice, language, speech rate, pitch, punctuation level, and other speech options for JAWS. These speech preferences are used any time JAWS speaks. If you only want to change certain speech aspects (such as the speech used to read documents or the speech used for a certain application) use the Individual Voices settings or the Application radio button in the Modify group of this dialog box. By saving your speech settings as a voice profile, you can quickly and easily switch between different settings.

Tip: It is recommended that you first use this dialog to adjust those settings you want to use with each voice, then use the Individual Voices dialog to make adjustments for settings you want applied only to specific voices. The settings in this dialog override settings in the Individual Voices dialog, so it is important to make adjustments in the proper order.

Modify Group Box

The Modify group box contains two radio buttons:

· Default: Select this radio button if you want your voice profile changes to apply to all applications. Any changes made and saved to this voice profile are written to the Default.jcf file. This means that these speech settings are used any time JAWS speaks. 

· Application: Select this radio button to create a voice profile that only applies to a specific application. The settings are saved to the application's jcf file. In addition, the Application radio button takes on the name of the last application used. For example, the name of the radio button will be Application Microsoft Word 2007 if Word 2007 was the last program you were running before opening the Global Voices dialog box. 

Profile Group Box 

You can save your global voice settings as part of a voice profile. Use the Profile area to select and manage voice profiles that you have created. To save your current voice settings as a voice profile, choose the Save As button. Profiles can have both global and individual voice settings.

Name

In the Name list, select the voice profile that you want to use. This provides a starting point for you to select a synthesizer and modify various options in this dialog box. After customizing your voice settings, you can name it and save it as a new profile using the Save As button. 

Delete
Use this button to delete any voice profiles that you created. This button is not available for the standard Eloquence, SAPI 5, and RealSpeak Solo Direct voice profiles.

Synthesizer Group Box

The Synthesizer area allows you to select a different speech synthesizer and synthesizer language.

Name

Use this combo box to select the speech synthesizer that you want to use for your voice profile. Once you have selected a synthesizer, you can then choose a language and eventually a specific voice. 

Language

Select the synthesizer language that you want the selected profile to use. The available languages are determined by the speech synthesizer you are using.

Detect SAPI 4 Synthesizers

This button installs older SAPI 4 synthesizers. These synthesizers do not work with all operating systems, such as Windows Vista. 

Choose the Detect SAPI 4 Synthesizers button to find the other compatible synthesizers installed on your system. After compatible synthesizers are located, the Update Synthesizer List dialog box appears. On the left side of the dialog box, there is a list of the available SAPI synthesizers. The buttons in this dialog box let you add or remove synthesizers. 

To add a new synthesizer: 

1. Select one or more synthesizers from the Available SAPI Synthesizer list. 

2. Choose the Add button to add just the selected synthesizers to the Synthesizer List for JAWS, or choose Add All to move all synthesizers to the Synthesizer List for JAWS. 

To remove a synthesizer from the Synthesizer List for JAWS:

1. Select one or more synthesizers from the Synthesizer List for JAWS . 

2. Choose the Remove button to remove only the selected synthesizers, or choose Remove All to remove all the synthesizers from the Synthesizer List for JAWS . 

Note: Although Eloquence does not appear in the Update Synthesizer List dialog box, it always appears in the list of available synthesizers.

Voice Group Box 

The Voice area allows you to change various synthesized speech characteristics of JAWS.

Rate

This scroll bar allows you to adjust the rate of speech for the currently selected synthesizer. Press RIGHT ARROW, UP ARROW, or PAGE UP to increase the speech rate. Press LEFT ARROW, DOWN ARROW, or PAGE DOWN to decrease the speech rate. 

Punctuation

This combo box allows you to specify how much punctuation JAWS speaks. Available options are None, Some, Most, and All. Most is selected by default.

Person

Use the Person list to select which synthesizer voice, and dialect based on the Language combo box setting, you want to use. The voices and dialects available are determined by which synthesizer language you selected in the Language combo box.

Pitch

The Pitch slider allows you to adjust the pitch for the currently selected voice.

Volume

This scroll bar allows you to adjust the volume of some hardware speech synthesizers. Press LEFT ARROW, DOWN ARROW, or PAGE DOWN to decrease the synthesizer volume. Press RIGHT ARROW, UP ARROW, or PAGE UP to increase the synthesizer volume. If you are using a software speech synthesizer such as Eloquence, a message is displayed, stating, "Set this using system volume control."

Say All Group Box

JAWS can immediately switch from one synthesizer, for example, Eloquence Software, to another, such as SAPI 5 or RealSpeak Solo Direct, when using the Say All command (INSERT+DOWN ARROW). While the default Eloquence voice may be useful for reading and navigating short text such as prior or next line, sentence, or paragraph, it may not be the preferred voice for longer passages of text. The SAPI 5 or RealSpeak Solo Direct voice chosen remains active during the Say All even as you fast forward, rewind, speed up, or slow down. However, when you stop the Say All, the Eloquence voice returns. 

Use the following controls in the Say All group to set preferences for how the Say All command works.

Speech Synthesizer

Use this combo box to select the synthesizer used for Say All. Select either Default, SAPI 5, or RealSpeak Solo Direct. When using Default, all other controls in the Say All group are unavailable. Also, note that RealSpeak Solo Direct is only available if you have downloaded and installed a RealSpeak Solo Direct voice. 

If the Say All synthesizer is Default, then either SAPI 5 or RealSpeak Solo Direct will be used for an Alternate Say All (ALT+INSERT+DOWN ARROW). If either SAPI 5 or RealSpeak Solo Direct is selected, the Default synthesizer is used for Alternate Say All. 

Rate

Use this slider to select a comfortable speech rate for the Say All voice. PAGE DOWN and PAGE UP change the rate of speech by larger increments, while the UP ARROW and DOWN ARROW keys make more gradual changes.

Punctuation

Use this list to set the punctuation level used by JAWS when the Say All voice speaks. Use the UP or DOWN ARROW keys to select a punctuation level. The options available are None, Some, Most, which is the default, and All.

Person

The Person combo box lets you to select which SAPI 5 or RealSpeak Solo Direct synthesizer voice to use for Say All. 

Pitch

The Pitch slider allows you to adjust the pitch for the currently selected voice. 

Volume 

Use the slider to increase or decrease the Say All speech volume. The DOWN ARROW , LEFT ARROW, and PAGE DOWN keys decrease volume, and the UP ARROW, RIGHT ARROW, and PAGE UP keys increase volume. 

OK

When you select this button, any changes you have made are saved, and you are returned to the JAWS application window.

Cancel

When you select this button, any changes you have made are discarded, and you are returned to the JAWS application window.

Save As

Choose this button to save your current global voice settings as part of a voice profile. Type a name for your voice profile or select an existing profile from the list. If you select an existing profile, that profile's individual voice settings will be overwritten by the new settings when you choose OK. 

Restore to Factory 

Use this button to restore the default settings for the speech synthesizer, language, and voice that are in use for the current voice profile. 

Individual Voices

Use the Individual Voices dialog box to assign different voices for JAWS to use when reading documents, messages, menus, dialog boxes, keystrokes, and items that you point to with the mouse. Similar to Global Voice settings, you can save your individual voice parameters as part of a voice profile, allowing you to quickly and easily switch between different settings.

Note: Before adjusting settings for individual voices, use the Global Voices dialog to make any changes you wish to apply to all voices. Changes made in the Global Voices dialog override any changes you make to individual voices, so it is important to make adjustments in this order to avoid losing settings you have changed.

Modify Group Box

The Modify group box contains two radio buttons:

· Default: Select this radio button if you want your Individual Voice profile changes to apply to all applications. Any changes made and saved to this voice profile are written to the Default.jcf file. 

· Application: Select this radio button to create a voice profile that only applies to a specific application. The settings are saved to the application's jcf file. In addition, the Application radio button takes on the name of the last application used. For example, the name of the radio button will be Application Microsoft Word 2007 if Word 2007 was the last program you were running before opening the Individual Voices dialog box. 

Profile Group Box

You can save your individual voice settings as part of a voice profile. Use the Profile area to select and manage voice profiles that you have created.

Tip: To save your current voice settings as a voice profile, choose the Save As button.

Name

In the Name list, select the voice profile that you want to use. This provides a starting point for you to select a synthesizer and modify various options in this dialog box. After customizing your voice settings, you can name it and save it as a new profile using the Save As button. 

Delete

Use this button to delete any voice profiles that you created. This button is not available for the standard Eloquence, SAPI 5, and RealSpeak Solo Direct voice profiles.

Synthesizer Group Box

The Synthesizer area allows you to select a different speech synthesizer and synthesizer language.

Name

Use this combo box to select the speech synthesizer that you want to use for your voice profile. Once you have selected a synthesizer, you can then choose a language and eventually a specific voice. 

Language

Select the synthesizer language that you want the selected profile to use. The available languages are determined by the speech synthesizer you are using.

Detect SAPI 4 Synthesizers

This button installs older SAPI 4 synthesizers. These synthesizers do not work with all operating systems, such as Windows Vista. 

Choose the Detect SAPI 4 Synthesizers button to find the other compatible synthesizers installed on your system. After compatible synthesizers are located, the Update Synthesizer List dialog box appears. On the left side of the dialog box, there is a list of the available SAPI synthesizers. The buttons in this dialog box let you add or remove synthesizers. 

To add a new synthesizer: 

1. Select one or more synthesizers from the Available SAPI Synthesizer list. 

2. Choose the Add button to add just the selected synthesizers to the Synthesizer List for JAWS, or choose Add All to move all synthesizers to the Synthesizer List for JAWS. 

To remove a synthesizer from the Synthesizer List for JAWS:

1. Select one or more synthesizers from the Synthesizer List for JAWS . 

2. Choose the Remove button to remove only the selected synthesizers, or choose Remove All to remove all the synthesizers from the Synthesizer List for JAWS . 

Note: Although Eloquence does not appear in the Update Synthesizer List dialog box, it always appears in the list of available synthesizers.

Voice Group Box

The Voice group lets you change various characteristics of synthesized speech in JAWS.

Context

Use the Context combo box and the Person combo box to choose a voice that you want to associate with the PC Cursor, JAWS Cursor, typing echo, tutor messages, and basic screen navigation. The voices that are available are determined by the speech synthesizer selected in the Synthesizer group. The following describes the items in the Context combo box. 

· PC Cursor Voice - The PC Cursor is the primary cursor used in JAWS. It corresponds to the system focus. To use a specific voice to distinguish when JAWS is reading a document, moving through or selecting options or icons, and performing most standard Windows functions, select PC Cursor and then select a voice from the Person combo box. 

· JAWS Cursor Voice - The JAWS Cursor is linked to mouse pointer functions in Windows and other applications. Select this item and then select a voice from the Person combo box to differentiate when the JAWS Cursor is active. 

· Keyboard Voice - Select this item and a voice from the Person combo box when you want JAWS to announce characters and words in a different voice when typing echo is on. 

· Tutor and Message Voice - Use this item and a voice from the Person combo box when you want tutor messages announced in a specific voice. A tutor message can provide navigation tips in Windows and other applications. For example, if you press ALT to access an application's menu bar, JAWS announces the message, "To navigate, press LEFT or RIGHT ARROW." 

· Menu and Dialog Voice - To assign a voice when navigating menus and dialog boxes, select this item and then select a voice from the Person combo box. 

Rate

This scroll bar allows you to adjust the rate of speech for the currently selected synthesizer. Press RIGHT ARROW, UP ARROW, or PAGE UP to increase the speech rate. Press LEFT ARROW, DOWN ARROW, or PAGE DOWN to decrease the speech rate. 

Punctuation

This combo box allows you to specify how much punctuation JAWS speaks. Available options are None, Some, Most, and All. Most is selected by default.

Person

Use the Person list to select which synthesizer voice you want to use with a specific Context combo box item. The voices that are available are determined by which speech synthesizer you selected in the Synthesizer group.

Pitch

The Pitch slider allows you to adjust the pitch for the currently selected voice.

Volume

Use this scroll bar to adjust the volume of some hardware speech synthesizers. Press LEFT ARROW, DOWN ARROW, or PAGE DOWN to decrease the synthesizer volume. Press RIGHT ARROW, UP ARROW, or PAGE UP to increase the synthesizer volume. If you are using Eloquence as the speech synthesizer, use the system volume to adjust volume control.

Say All Group Box

JAWS can immediately switch from one synthesizer, for example, Eloquence Software, to another, such as SAPI 5 or RealSpeak Solo Direct, when using the Say All command (INSERT+DOWN ARROW). While the default Eloquence voice may be useful for reading and navigating short text such as prior or next line, sentence, or paragraph, it may not be the preferred voice for longer passages of text. The SAPI 5 or RealSpeak Solo Direct voice chosen remains active during the Say All even as you fast forward, rewind, speed up, or slow down. However, when you stop the Say All, the Eloquence voice returns. 

Use the following controls in the Say All group to set preferences for how the Say All command works.

Speech Synthesizer

Use this combo box to select the synthesizer used for Say All. Select either Default, SAPI 5, or RealSpeak Solo Direct. When using Default, all other controls in the Say All group are unavailable. Also, note that RealSpeak Solo Direct is only available if you have downloaded and installed a RealSpeak Solo Direct voice. 

If the Say All synthesizer is Default, then either SAPI 5 or RealSpeak Solo Direct will be used for an Alternate Say All (ALT+INSERT+DOWN ARROW). If either SAPI 5 or RealSpeak Solo Direct is selected, the Default synthesizer is used for Alternate Say All. 

Rate

Use this slider to select a comfortable speech rate for the Say All voice. PAGE DOWN and PAGE UP change the rate of speech by larger increments, while the UP ARROW and DOWN ARROW keys make more gradual changes.

Punctuation

Use this list to set the punctuation level used by JAWS when the Say All voice speaks. Use the UP or DOWN ARROW keys to select a punctuation level. The options available are None, Some, Most, which is the default, and All.

Person

The Person combo box lets you to select which SAPI 5 or RealSpeak Solo Direct synthesizer voice to use for Say All. 

Pitch

The Pitch slider allows you to adjust the pitch for the currently selected voice. 

Volume 

Use the slider to increase or decrease the Say All speech volume. The DOWN ARROW , LEFT ARROW, and PAGE DOWN keys decrease volume, and the UP ARROW, RIGHT ARROW, and PAGE UP keys increase volume.

OK

When you select this button, any changes you have made are saved, and you are returned to the JAWS application window.

Cancel

When you select this button, any changes you have made are discarded, and you are returned to the JAWS application window.

Save As

Choose this button to save your current voice settings as part of a voice profile. Type a name for your voice profile or select an existing profile from the list. If you select an existing profile, that profile's individual voice settings will be overwritten by the new settings when you choose OK. 

Restore to Factory 

Use this button to restore the default Individual Voice settings for the speech synthesizer, language, and voice that are in use for the current voice profile. 

Application Specific Voice Settings

JAWS now allows you to set voice settings on an application specific level. As an example, you could have the voice rate set high in Microsoft Outlook so you can quickly review your email, and have the voice rate set lower in Word so you can carefully read reports and other documents. For more information, select one of the following links.

Setting Voice Options for an Application

Application specific voice settings are modified in the Voice Settings Dialogs available under the Options menu of the JAWS application Window.

To set voice options for an application, make that application the active window. Navigate from this window directly to the JAWS application window. Press INSERT+J, or press and hold ALT while pressing and releasing TAB until JAWS is located in the switch to order, and then release both keys. You cannot use the Window List Dialog box (INSERT+F10) for this process.

If JAWS is set to run from the system tray, access the menus by pressing INSERT+J, or by using the Select a System Tray Icon Dialog box (INSERT+F11) and then selecting JAWS from the list.

Navigate to the Options menu, select Voices, and select either Global Adjustments or Individual Voice Adjustments. 

After opening one of these dialog boxes, focus is on the Modify group box. There are two radio buttons in this group box: Default and Application. The Application radio button has the name of an application listed behind it. This is the application for which you can set or modify voice options, and is the application that last had focus. Select the Application radio button, press the TAB key to move to other controls in the dialog to set desired options, and then press ENTER to save those changes, and close the dialog box.

Removing Application Specific Voice Settings

To remove application specific voice settings, move the focus to the application whose voice settings you wish to remove. Navigate from this window directly to the JAWS application window as detailed above. Open the Options menu, and select the menu item for the voice adjustment dialog containing those settings you wish to remove. In the Modify group box, the Application radio button is selected, and the name of the application that last had focus will be listed. This is the application whose settings can be modified or removed. Navigate to the Restore to Factory button and press ENTER. This returns the voice settings to the default state, which are the settings in use when you first installed JAWS.

Adding Speech for Special Symbols

While JAWS correctly represents the most frequently used symbols with speech, you may need to add new ones. If you are reading a document and find that JAWS misrepresents or does not announce a symbol, do the following:

1. From the Utilities menu, choose Configuration Manager. 

2. From the Set Options menu, choose Graphics and Symbols. 

3. Select the Speak Character Value in Hex check box. 

4. Choose OK. Then, press CTRL+S to save your changes and press ALT+F4 to close Configuration Manager. 

5. Return to your document. Move the cursor to a lowercase letter "a" (type one if none are present) and press NUM PAD 5 three times quickly. JAWS should say, “Character U+61HEX”. If you hear anything else, do not proceed with these steps. 

6. Move the cursor to the character whose speech representation you want to change and press NUM PAD 5 three times quickly to obtain the hexadecimal unicode value of the character. Be sure to make a note of this value, as you will need it in the next steps. 

7. Using a text editor like Notepad, open the .sbl file for the active synthesizer. This file is located in your user settings folder (C:\Documents and Settings\[User Name]\Application Data\Freedom Scientific\JAWS\X (where X is the JAWS version number)\Settings\Enu). If your user settings folder does not contain Eloq.sbl, then look for it in the shared settings folder. 

Note: Character definitions are specific to your synthesizer and selected language. For example, if you are using Eloquence and American English, you should open the file named Eloq.sbl and modify the section named [American English]. 

8. At the bottom of the appropriate section for your language, add a new entry for the specific symbol you want JAWS to speak. The entry should be in the following format:

U+XXXX=SpokenRepresentation

(Where XXXX is the unicode hexadecimal value of the symbol, and "SpokenRepresentation" is the desired pronunciation). 

9. Save your changes to the .sbl file, and then quit and restart JAWS. Your speech changes should now take effect. 

Related Topics:
Adding and Modifying Braille Symbols
About Cursors

JAWS provides many ways to access information and navigate within Windows. The cursor you use to access Windows determines what information JAWS reads. This section provides an overview of the means for accessing Windows, and detailed information on the cursors used within JAWS. You will find information on the following topics:

Using the PC Cursor

The PC Cursor is the primary cursor used in JAWS. It corresponds to the system focus. The PC Cursor is used to navigate menus, edit text in documents, and to navigate in dialog boxes. The PC Cursor is used for most standard Windows functions, and provides a high degree of functionality. The PC Cursor is active when JAWS is first started, but if you switch to another cursor, you can press NUM PAD PLUS to make the PC Cursor active once again.

The PC Cursor can only go where the system focus can go, and this does limit the access it provides to the Windows environment.

See also:
JAWS Keystrokes for Reading Text 

Navigation - Information Keystrokes 

JAWS Keystrokes for Working in Dialog Boxes 

Using the JAWS Cursor

The JAWS Cursor is very useful when working in Windows. It corresponds to the system mouse. The JAWS Cursor is used to manipulate the system mouse, read static text to which the PC Cursor does not have access, and to access other parts of Windows to which the PC Cursor cannot be moved. The JAWS Cursor is also used to provide a quick overview of the information currently available on the screen. Press NUM PAD DASH to make the JAWS Cursor active.

Find information in the following areas:

Restricting the JAWS Cursor

The JAWS Cursor has 4 separate levels related to where it can move on the computer screen. Each time you press INSERT+R with the JAWS Cursor active, the next level of restriction is set and announced. 

Application Window Restriction

When the JAWS Cursor is within the Parent Window with focus, the cursor does not move outside the Parent window when using standard navigation keys such as PAGE UP PAGE DOWN, HOME, END, or arrow keys. This is the default selection.

Current Window Restriction

When put in this mode, the JAWS Cursor is restricted to the current window that it is in at that moment. This is useful to restrict movement and reading to a control such as a list box without having to hear other information outside of that specific control. The cursor does not move outside the Window with standard navigation keys such as PAGE UP PAGE DOWN, HOME, END, or arrow keys.

Frame Restriction

When put in this mode, the JAWS Cursor is restricted to the current frame that it is in at that moment. This is useful to restrict movement and reading to an area of an application you define. The cursor does not move outside the frame with standard navigation keys such as PAGE UP PAGE DOWN, HOME, END, or arrow keys. For more information about frames, refer to Introduction to Frames.

Unrestricted

In Unrestricted Mode, with the JAWS Cursor active, you can freely roam the entire screen regardless of the number of Windows open or how they appear on the screen. Using this mode, you can easily browse the screen line by line and get an understanding of everything available on the screen.

Using the Mouse Buttons

The JAWS Cursor corresponds to the system mouse, allowing you to move the mouse pointer. JAWS provides the additional functionality of keystrokes to simulate clicking the mouse buttons. For more information, please see Keystrokes for Cursors and Mouse Simulation.

Using the Invisible Cursor

The Invisble Cursor allows you to move around the screen without changing the position of the PC Cursor or mouse pointer. You can use this cursor to read text and access options that you cannot move to with the PC Cursor. You can also use the Invisible Cursor to provide a quick overview of the information currently available on the screen. To activate the Invisible Cursor, press NUM PAD MINUS twice quickly. Use the standard JAWS reading commands to move the Invisible Cursor around the screen.

Like the JAWS Cursor, the movement of the Invisible Cursor is restricted by the boundaries of the window unless you change the cursor restriction by pressing INSERT+R. However, the Invisible Cursor is not visible on the screen because it does not bring the mouse pointer to its location. 

Tip: For more information on restricting the Invisible Cursor, see Using the JAWS Cursor.

If you do not want to move the JAWS Cursor from its current position, it is recommended that you use the Invisible Cursor. For example, sometimes informative text appears on the screen, usually in the status bar, when the mouse pointer is at a particular location. If you try to use the JAWS Cursor to read this text, the mouse pointer moves with it and the text disappears.

Using the Virtual Cursor

Text in a web page is very much like the static text in a Windows status message. The PC Cursor cannot move to this text as there is no insertion point. The JAWS Cursor can access this text, but this is not the most effective way to access larger documents such as those often found on the World Wide Web.

When using Internet Explorer 5 or later (or programs that tie into the core components of Internet Explorer), JAWS provides the Virtual Cursor to simulate an insertion point. This provides you similar functionality to that found in any word processing document. Read text by word, line, sentence, or paragraph, or select and copy text to the Windows clipboard. The Virtual Cursor is active by default in applications that support it. If you switch to another cursor, press NUM PAD PLUS to make the Virtual Cursor active again. 

You can turn the Virtual Cursor off entirely, but this seriously limits functionality. Toggle the Virtual Cursor on and off by pressing INSERT+Z. 

Routing the Virtual Cursor to the PC Cursor

Press INSERT+DELETE to route the Virtual Cursor to the PC Cursor. Using this command moves the Virtual Cursor to the current location of the PC Cursor. This makes using Web forms easier, and is also useful on pages where a form control is automatically made active when the page loads.

Routing the PC Cursor to the Virtual Cursor

You can press CTRL+INSERT+DELETE to route the PC Cursor to the Virtual Cursor. Using this command moves the PC Cursor (and the application focus) to the current location of the Virtual Cursor. Visually, the page will scroll so that the area containing Virtual Cursor is visible on the screen. This command is the opposite of the Route Virtual to PC Cursor command (INSERT+DELETE).

Routing the Virtual Cursor to the JAWS Cursor
You can press INSERT+NUM PAD PLUS to route the Virtual Cursor to the JAWS Cursor. Using this command moves the Virtual Cursor to the current location of the mouse pointer and can help sighted users navigate Web pages.

An Overview of Internet Explorer

Microsoft Internet Explorer is a web browser. It allows you to view HTML based documents, and navigate through the World Wide Web. JAWS, when used with Internet Explorer 5 or later, provides unparalleled access to the Internet. Navigate and read framed information in the order in which it is presented. Navigate and read tables in a logical order. Access dialogs listing the links on a page, or the frames on a page. Access and fill out web-based forms. For more information on using Internet Explorer with JAWS, please see Internet Explorer.

Forms Mode

Forms and form controls are often found within web pages. These form controls are very similar to the controls found in standard dialog boxes. In Internet Explorer, JAWS provides Forms Mode for easy access to these form controls. To use Forms Mode, use the Virtual Cursor to locate a form control you would like to access. Press ENTER to enter Forms Mode. Enter information or change settings in the form control in the same manner you would in any dialog box. Press TAB or SHIFT+TAB to move between form controls without leaving Forms Mode. Press NUM PAD PLUS to exit Forms Mode.

Note: If you use the Virtual Cursor to navigate to a form control, and attempt to make changes without entering Forms Mode, no changes are made. JAWS echoes keyboard activity, so it may sound like information is being entered, but the form controls can only be accessed after entering Forms Mode. For more information, please see Internet Explorer.

Using the Braille Cursor

The Braille Cursor allows you to review text in a document, separate from any of the other cursors in JAWS. Unlike the other JAWS cursors, the Braille Cursor is not limited to one particular character. Instead, the term Braille Cursor refers to the line of text currently shown on the Braille display. As you use a Braille display, you may notice raised or blinking dots under one character. The dots represent the active cursor, which is usually the PC cursor.

Movement of the Braille Cursor is done solely through the use of the display that you are using. Some displays may have commands that are not available to others, and the commands to perform each action vary. Some of the commands available using most or all displays include:

· Move the Braille Cursor up or down by line 

· Move the active cursor up or down by line 

· Route the Braille Cursor to either the JAWS or PC cursor 

· Link or unlink the Braille Cursor to the active cursor 

· Pan left or right on the current line 

· Route the PC Cursor to a particular character on the Braille display 

Linking Cursors

JAWS provides three ways to link your Braille Cursor with the active cursor. Each of these modes can be helpful at different times, and can be changed through the configuration manager.

The Braille Cursor can be completely unlinked from the active cursor. This allows you to navigate using either the Braille or the active cursor, without changing the position of the other. However, if you change the active cursor from JAWS to PC or vice versa, the Braille cursor moves to the location of the activated cursor.

The Braille Cursor can be set to follow the active cursor. In this mode, moving the active cursor causes the Braille Cursor to move. You can still move the Braille Cursor without moving the active cursor. Most Braille displays have a command which can be used to toggle between this mode and the previous one.

You can choose to tether the Braille Cursor to the active cursor. In this mode, moving either the Braille or the active cursor causes the other to move. When moving the Braille Cursor, the active cursor follows but does not cause JAWS to speak.

Note: The above options only affect line mode. If you use structured mode, and are viewing a structured line, movement of either the Braille or the active cursor automatically moves both cursors.

Overview of the JAWS Utilities

JAWS provides several utilities used to customize how JAWS works with the applications you use. Customizing JAWS allows you to make any changes that might be necessary to provide you more complete access to your programs. This topic provides an overview of the JAWS utilities.

The Run JAWS Manager Dialog

Press INSERT+F2 at any time for quick access to a dialog listing the JAWS Managers and utilities. The managers and utilities available in this dialog are listed below with a brief description of each.

Adjust Braille Options

Use this option to temporarily adjust your Braille settings. These settings only apply to the application that is currently active. If you switch to another application, the settings are restored to their original values. For more information, please refer to Adjust Braille Options.

Configuration Manager

Configuration Manager allows you to modify many settings that determine what information JAWS reads, and how much of it is read. You can also modify configuration settings for Braille options and synthesizer options. For more information, please refer to Configuration Manager.

Custom Highlight Assign

Use Custom Highlight Assign to specify colors that are then recognized by JAWS as highlighted. This is very useful in applications that do not use Windows colors, or do not allow you to modify preset color settings. For more information, please refer to Custom Highlight Colors.

Custom Label, Custom Label Delete, and Custom Label Delete All

These options are only available in Internet Explorer, Adobe Acrobat/Reader, Microsoft Word, and HTML documents that use the virtual cursor. Use the Custom Label option to assign a custom label to the current HTML link, HTML image, or form field/control. Use the Custom Label Delete option to delete the label assigned to the current item. Use the Custom Label Delete All option to delete all custom labels on the current page or document. For more information on using this feature, see Custom Labels.

Customize List View

A list view is an area in a window or dialog box that contains one or more items, such as files, folders, records, and so on. The list view usually contains multiple columns that display information about each item in the list. You can use the Customize List View feature to change how JAWS provides you with information about the columns and items in certain list views. For more information, please refer to Customizing List Views.

Dictionary Manager

Use Dictionary Manager to specify how JAWS pronounces words, allowing you to more easily recognize spoken information and to work more effectively. For more information, please refer to Dictionary Manager.

Frame Viewer

Use Frame Viewer to specify areas within an application window that can then be set to be read with a keystroke, in response to some change in the program, or to silence a change in the application that you do not want to hear. For more information, please refer to Frame Viewer
Graphics Labeler

Graphics Labeler allows you to assign text labels to graphics. The text labels are then automatically read when labeled graphics are encountered by the active cursor. For more information, please refer to Graphics Labeler.

Keyboard Manager

Use Keyboard Manager to review, add, or change keystrokes assigned to listed actions. For more information, please refer to Keyboard Manager.

Mark Colors in Braille

Use Mark Colors in Braille to specify text colors to be identified when the Color attribute is selected in Configuration Manager, Braille Options. For more information, please refer to Braille Options Dialog.

Prompt Creator/Modifier

Prompts are the labels spoken when you navigate to a control. However, these labels are not always automatically spoken. Use Prompt Creator to specify the label JAWS speaks for specific controls, and even include a custom tutor message to provide helpful navigation tips. For more information, refer to Creating a Prompt.

Script Manager

Use Script Manager to write and compile scripts - small programs - that can greatly alter how JAWS functions within applications. For more information on Script Manager and writing scripts, please refer to Characteristics of the Script Manager.

Settings Packager

Settings Packager is a program that allows you to import and export speech and sound schemes, PlaceMarkers, and personalized Web settings (including custom labels). For information about using this program, start Settings Packager by selecting this option, open the Help menu, and choose Help Topics.

Skim Reading Tool

Use the Skim Reading Tool to change your skim reading preferences. This also allows you to create, select, edit, and delete skim reading text rules. You can start skim reading with your current preferences at any time by pressing CTRL+INSERT+DOWN ARROW. For more information, please refer to Skim Reading Dialog.

Window Class Reassign

A Windows class is a programming level label for a window or control. Some programs use non-standard Window classes, making it difficult for JAWS to recognize and read them properly. Windows Class Reassign allows you to specify a standard Windows class assignment that JAWS can recognize and access. For more information, please refer to Window Classes Dialog. 

Merge Utility

Use the Merge Utility to import your settings from a previous version of JAWS. For more information, please refer to Using the Merge Utility.

Default or Application Settings

Settings changed in the JAWS managers and utilities can be made at a default or application level. Default level changes affect all applications, while application level changes affect only the current application. For example, if you press INSERT+F2 and select a manager while Word is active, changes you make only apply to Word.

In several of the managers, if you press CTRL+SHIFT+D before making changes, your changes take place on a default level.

An Overview of Windows Versions

Over the years, JAWS has kept pace with the numerous versions of Windows that have been released. All of the versions of Windows have marked similarities. Applications will appear similar, all have a Start Menu, all have a Control Panel. You will find Windows Explorer in each of these versions of Windows. You will also find very similar dialog boxes with familiar settings. If our directions indicate you should modify a setting in a specific section of Windows, you might not find the exact setting we mention, but you should find a variation of it within the same area. Generally, the basic concept of what needs to be done is as important as the specific directions of how to do it. Despite the similarities in appearance, there are major differences between the differing versions of Windows. While many of these differences are "behind the scenes" it can be important to remember that they exist.

Operating System Considerations

JAWS 10 and later supports Windows Vista and Windows XP. If you are new to JAWS and must use an older Windows operating system, please refer to the Previous JAWS for Windows Downloads page for an appropriate JAWS version.

The following topics discuss important information that can make JAWS work more effectively:

Windows Vista and JAWS
Windows XP and JAWS
Using the Clipboard

The Clipboard is a Windows feature that allows you to copy items from one location and then paste them in another location. You can copy text from form fields, Web pages, documents, edit boxes, the JAWS Virtual Viewer, and any other place where you can select text. You can also copy files in Windows Explorer. Items that you copy are placed on the Clipboard, an invisible region that operates in the background throughout Windows. When you copy an item to the Clipboard, it replaces any item that was already there. The keystroke for copying the currently selected item to the Clipboard in any program is always CTRL+C.

The Cut command is similar to the Copy command. However, items that you cut are deleted, in addition to being copied to the Clipboard. The Cut command is useful for moving items to other locations. The keystroke for the Cut command is always CTRL+X.

To tell Windows which item you want to copy or cut, you must select it first. The process for selecting items varies by program. For information on selecting files in Windows Explorer, see Using Windows Explorer. To select text, use the following Windows commands:

· Select the next character to the left of the cursor – SHIFT+LEFT ARROW 

· Select the next character to the right of the cursor – SHIFT+RIGHT ARROW 

· Select the next word to the left of the cursor - CTRL+SHIFT+LEFT ARROW 

· Select the next word to the right of the cursor – CTRL+SHIFT+RIGHT ARROW 

· Select all text between the cursor and the beginning of the line – SHIFT+HOME 

· Select all text between the cursor and the end of the line – SHIFT+END 

· Select all text between the cursor and the beginning of the current document – CTRL+SHIFT+HOME 

· Select all text between the cursor and the end of the current document – CTRL+SHIFT+END 
· Select all text in the current document – CTRL+A 

After you select the text you want to copy, press CTRL+C or CTRL+X to place that text on the Clipboard. 

Note: To read the Clipboard contents, press WINDOWS Key+INSERT+X.

Pasting Items

Any items that you have placed on the Clipboard can be inserted, or "pasted," into a document, edit box, folder, and other locations. To paste an item from the Clipboard, press CTRL+V. If there is text on the Clipboard, it is inserted at the current location of the PC Cursor. The item that you pasted remains on the Clipboard, so you can copy it elsewhere if necessary. 

Using FSClipboard

FSClipboard extends the functionality of the Windows Clipboard. When you use the Windows Copy (CTRL+C) or Cut (CTRL+X) commands to place text on the Clipboard, it replaces any text already there. When using the FSClipboard feature, text that you copy is added to any text that you have previously copied to the Clipboard. This allows you to continue adding text to the Clipboard until you are ready to paste it into a document. You can only copy text with the FSClipboard feature. 

To add text to the Clipboard, select it using the text selection commands, and then press WINDOWS Key+C. The text is appended to the end of any text already on the Clipboard. To paste all the text that you have placed on the Clipboard so far, use the Windows Paste command (CTRL+V). The text is inserted into your document at the current location of the cursor. Each block of text that you copied is separated by a blank line.

Note: If you attempt to add the same selection of text to the Clipboard more than once, the text is not added. This feature is intended to reduce unintentional duplication. 

All formatting is removed from text that you copy using the FSClipboard feature. This can be useful in programs like Microsoft Word if you do not want to include styles, numbering, and other formatting information when you paste text into a document.

If you want to replace all of the text on the Clipboard with a new text selection, use CTRL+C or CTRL+X instead of WINDOWS Key+C. JAWS asks if you want to overwrite your previously saved items. Choose Yes to replace all the text on the Clipboard with the new selection.

Window List Dialog Box

This topic documents the settings available in the Window List dialog box. This dialog allows you to switch between running applications. To access this dialog, press INSERT+F10.

Running Applications

This list box lists the running applications that are displayed on the task bar. The window state of each application is also listed. The window state will be minimized, restored, or maximized. You can select a listed application and press ENTER to switch to that application. 

Switch To

This button allows you to switch to the application selected in the Running Applications list box.

Cancel

This button allows you to exit the Windows List dialog box without switching to a different application.

About

This button allows you to view a dialog containing copyright information for the Windows List dialog box.

Select a System Tray Icon Dialog Box

This topic documents the settings available in the Select a System Tray Icon dialog box. This dialog box allows you to access items in the system tray. To access this dialog box, press INSERT+F11.

System Tray Icon

This list box lists the icons that are displayed in the system tray. Select an item from the list and press ENTER to simulate a right single click of the mouse on the item. This will normally bring up a context menu providing access to the item’s options.

Right Single Click

This button can be used to simulate a right single click on the item currently selected in the System Tray Icon list box.

Left Single Click

This button can be used to simulate a left single click on the item currently selected in the System Tray Icon list box.

Left Double Click

This button can be used to simulate a left double click on the item currently selected in the System Tray Icon list box.

Cancel

This button allows you to exit the Select a System Tray Icon dialog box without taking any action on any system tray icons.

Select a Symbol to Print Dialog Box

This topic documents the Select a Symbol to Print dialog box. This dialog allows you to insert certain symbols into a document. To access this feature, press INSERT+4.

Symbols List

This list box contains textual descriptions of the symbols that you can insert into your document. To insert the selected symbol, press ENTER or activate the OK Button.

Cancel

Activating the Cancel Button closes the dialog box without inserting any symbols. 

Browsing the Internet

Microsoft Internet Explorer and Mozilla Firefox are programs called "browsers" that allow you to access the World Wide Web, read HTML documents on your computer, or view your local intranet site. These browsers don't just display information. They also help you find information and interact with other people using message boards, Web-based e-mail, shopping carts, and much more. Support for Macromedia Flash MX makes audio and video a part of the experience. JAWS provides the same powerful features for both browsers, allowing you to choose the one that best suits your needs.

Note: JAWS works best with Internet Explorer 5.0 or later or Mozilla Firefox 1.1 or later. To download the latest version of Internet Explorer, visit Microsoft's Internet Explorer Home Page. To download the latest version of Firefox, visit the Firefox Home Page.

When browsing the Web, JAWS gives you quick access to the information you need, and provides detailed information about the structure and organization of Web pages. Tables, lists, headings, and alternate text for images are all announced. The information comes right from the HTML used to create the page. HTML 4.0 is designed with accessibility in mind, and JAWS supports more of the built-in HTML accessibility features than any other screen reader.

Any time you read an HTML document, JAWS uses the Virtual Cursor. With the Virtual Cursor, you can read Web pages using the standard JAWS reading commands, use the TAB key to move through links and easily follow them, display lists of links or headings to quickly find and move to what you need, and easily move to and fill out Web-based forms.

To learn more about using the Internet, see the JAWS Help topic for your browser:

Microsoft Internet Explorer
Mozilla Firefox
Alternatively, you can learn about the commands, keystrokes, and verbosity options for working with HTML documents, all of which are available in both browsers:

JAWS Commands for HTML
Navigating Web Pages
Customizing Your Web Settings
Keyboard Commands

JAWS has an extensive list of keyboard commands. Keyboard key combinations (called keystrokes or commands) provide quick and effective access to the entire scope of Windows features. Programs are opened, used, and closed. Letters are written and edited. Spreadsheets are compiled and calculated. Files are created, modified, and deleted. The Internet is browsed, and files and programs are downloaded. Through extensive use of keystrokes, the limitations of a graphical user environment are overcome. 

JAWS uses cursors to track system activity and speak the necessary information. JAWS keystrokes allow you to control what information - and how much of it - JAWS speaks at any given time by controlling the movement of these cursors. Most of the time when you use a keystroke, you are also manipulating a cursor. For this reason, many keystrokes behave differently for different cursors. In fact, some keystrokes do not work at all unless the correct cursor is selected. For example, if you try to restrict the JAWS cursor (INSERT+R) while the PC Cursor is active, you receive the message, "Before you can set restriction, you must turn on either the JAWS or Invisible Cursor." 

Some cursors only work in certain applications, or sections of them. The PC cursor cannot directly access every portion of the screen as it only goes where the system focus goes. The Virtual PC Cursor works in version 5 or later of Internet Explorer or programs that are tied into the core components of Internet Explorer such as Outlook, Outlook Express, and some help files.

This section of the JAWS help system contains listings of commonly used Windows keystrokes and listings of all JAWS keystrokes. We have attempted to organize these keystrokes according to what they do so you can easily find the keystrokes you need at any given time.

Find the keystrokes you need in each of the following areas:

JAWS Keystrokes 

Standard Windows Keystrokes 

JAWS Keystrokes for Popular Applications 

JAWS Keystrokes

JAWS provides many keyboard key combinations (keystrokes) to enable you to better navigate Windows and use Windows based programs. This section contains keystrokes that are specific to JAWS. 

If you have used JAWS for some time, you are familiar with using the INSERT key as part of the commands you type. We refer to this key as the "modifier" key, or the "JAWS" key. The INSERT key is the default JAWS Key in the desktop keyboard layout. The CAPS LOCK key is now the default JAWS key in the laptop keyboard layout. And you can now assign your own JAWS key. For more information, please refer to the JAWS Key.

This section documents commands by listing them with the default JAWS keys for the desktop and laptop keyboard layouts. Those commands listed in the desktop keystrokes sections that are not also listed in the laptop keystrokes section should work with the INSERT or the CAPS LOCK key if you are using the laptop keyboard layout.

You will find listings of keystrokes for the following areas:

JAWS Keystrokes for Reading Text 

Change Voice Rate on the Fly 

Navigation - Information Keystrokes 

JAWS Keystrokes for Working in Dialog Boxes
Keystrokes for Working in Tables 

JAWS Keystrokes for Cursors and Mouse Simulation 

Miscellaneous JAWS Keystrokes 

Keystrokes for Accessing the JAWS Utilities 

JAWS Keystrokes for Accessing Help 

JAWS Keystrokes for Using Help 

Laptop Keystrokes 

See also:
Standard Windows Keystrokes 

JAWS Keystrokes

JAWS provides many keyboard key combinations (keystrokes) to enable you to better navigate Windows and use Windows based programs. This section contains keystrokes that are specific to JAWS. 

If you have used JAWS for some time, you are familiar with using the INSERT key as part of the commands you type. We refer to this key as the "modifier" key, or the "JAWS" key. The INSERT key is the default JAWS Key in the desktop keyboard layout. The CAPS LOCK key is now the default JAWS key in the laptop keyboard layout. And you can now assign your own JAWS key. For more information, please refer to the JAWS Key.

This section documents commands by listing them with the default JAWS keys for the desktop and laptop keyboard layouts. Those commands listed in the desktop keystrokes sections that are not also listed in the laptop keystrokes section should work with the INSERT or the CAPS LOCK key if you are using the laptop keyboard layout.

You will find listings of keystrokes for the following areas:

JAWS Keystrokes for Reading Text 

Change Voice Rate on the Fly 

Navigation - Information Keystrokes 

JAWS Keystrokes for Working in Dialog Boxes
Keystrokes for Working in Tables 

JAWS Keystrokes for Cursors and Mouse Simulation 

Miscellaneous JAWS Keystrokes 

Keystrokes for Accessing the JAWS Utilities 

JAWS Keystrokes for Accessing Help 

JAWS Keystrokes for Using Help 

Laptop Keystrokes 

See also:
Standard Windows Keystrokes 

JAWS Keystrokes for Reading Text

	Description
	Command

	Say Prior Character 
	LEFT ARROW

	Say Next Character 
	RIGHT ARROW

	Say Character
	NUM PAD 5

	Say Character Phonetically
	NUM PAD 5 twice quickly

	Say Prior Word
	INSERT+LEFT ARROW

	Say Next Word
	INSERT+RIGHT ARROW

	Say Word
	INSERT+NUM PAD 5

	Spell Word
	INSERT+NUM PAD 5 twice quickly 

	Say Prior Line
	UP ARROW

	Say Next Line
	DOWN ARROW

	Say Current Line
	INSERT+UP ARROW

	Spell Current Line
	INSERT+UP ARROW twice quickly

	Say Prior Sentence 
	ALT+UP ARROW

	Say Next Sentence 
	ALT+DOWN ARROW

	Say Current Sentence
	ALT+NUM PAD 5

	Say to Cursor
	INSERT+HOME

	Say from Cursor
	INSERT+PAGE UP 

	Spell to Cursor
	INSERT+HOME twice quickly

	Spell from Cursor
	INSERT+PAGE UP twice quickly

	Say All
	INSERT+DOWN ARROW

	Fast Forward during a Say All
	RIGHT ARROW

	Rewind during a Say All
	LEFT ARROW

	Say Color
	INSERT+5

	Say ASCII or Hexadecimal Value
	NUM PAD 5 three times quickly

	Say Font
	INSERT+F, twice quickly to display in virtual viewer

	Start Skim Reading
	CTRL+INSERT+DOWN ARROW

	Skim Reading dialog box
	CTRL+INSERT+SHIFT+DOWN ARROW

	Display Skim Reading Summary
	INSERT+WINDOWS Key+DOWN ARROW

	Copy Selected Text to FSClipboard
	WINDOWS Key+C


Additional Notes 

See also:
Keystrokes for Using the Clipboard 
Windows Keystrokes for Working with Text 

Change Voice Rate on the Fly

JAWS now allows you to temporarily change the speech rate for the current voice. This can be done at any time - even while using Say All!

When not using SayAll:
	Description
	Command

	Decrease Voice Rate
	ALT+CTRL+PAGE DOWN

	Increase Voice Rate
	ALT+CTRL+PAGE UP


Note: JAWS states "slower" or "faster" with each press of the above keystrokes.

During a SayAll:
	Description
	Command

	Decrease Voice Rate
	PAGE DOWN

	Increase Voice Rate
	PAGE UP


To restore voice settings to their normal rate, press INSERT+ESC. Switching to another application also restores the default voice rate.

Navigational & Informational Keystrokes

	Description
	Command

	Say System Time
	INSERT+F12

	Say System Date
	INSERT+F12 twice quickly

	Say Window Title
	INSERT+T

	Say Window Prompt and Text
	INSERT+TAB

	Say Top Line of Window
	INSERT+END

	Say Bottom Line of Window
	INSERT+PAGE DOWN 

	Say Selected Text
	INSERT+SHIFT+DOWN ARROW 

	Spell Selected Text
	INSERT+SHIFT+DOWN ARROW twice quickly

	Say Application Version
	CTRL+INSERT+V

	Window List
	INSERT+F10

	List System Tray Icons
	INSERT+F11

	View System Tray Contents
	CTRL+SHIFT+F11

	List Labeled Graphics
	CTRL+INSERT+SHIFT+G


Additional Notes 

 See Also: 

General Windows Keystrokes 

JAWS Keystrokes for Working in Dialog Boxes

	Description
	Command

	Say Default Button of Dialog 
	INSERT+E

	Say Current Control Hot Key 
	SHIFT+NUM PAD 5

	Read Current Window
	INSERT+B

	Say Window Prompt in Text
	INSERT+TAB

	Read Word in Context
	INSERT+C

	Open Combo Box
	ALT+DOWN ARROW

	Close Combo Box
	ALT+UP ARROW

	Select Multiple List Items
	CTRL+SHIFT or CTRL+SPACEBAR

	Unselect All But Current
	CTRL+\

	Read List View Columns 1 through 10
	CTRL+INSERT+1 through 0


Tip: Press INSERT+F1 in any control in a dialog box for context sensitive help on the type of control and keystrokes that work in that control.

Additional Notes 

See Also:
Windows Keystrokes for Working in Dialog Boxes 

JAWS Keystrokes for Cursors and Mouse Simulation

	Description
	Command

	PC Cursor
	NUM PAD PLUS

	JAWS Cursor
	NUM PAD MINUS

	Invisible Cursor
	NUM PAD MINUS twice quickly

	Route PC Cursor to JAWS Cursor
	INSERT+NUM PAD PLUS

	Route JAWS Cursor to PC Cursor 
	INSERT+NUM PAD MINUS

	Tether JAWS to PC
	CTRL+INSERT+NUM PAD MINUS

	Restrict JAWS Cursor
	INSERT+R

	Left Mouse Button
	NUM PAD SLASH

	Right Mouse Button
	NUM PAD STAR 

	Left Mouse Button Lock
	INSERT+NUM PAD SLASH

	Right Mouse Button Lock
	INSERT+NUM PAD STAR

	Drag and Drop
	CTRL+INSERT+NUM PAD SLASH

	Say Active Cursor
	ALT+DELETE

	Say Cursor Type
	CTRL+INSERT+SHIFT+C

	Mouse Down
	ALT+SHIFT+DOWN ARROW

	Mouse Left
	ALT+SHIFT+LEFT ARROW

	Mouse Right
	ALT+SHIFT+RIGHT ARROW

	Mouse Up
	ALT+SHIFT+UP ARROW


Additional Notes 

Miscellaneous JAWS Keystrokes

	Description
	Command

	Adjust JAWS Verbosity
	INSERT+V

	Adjust Braille Settings
	INSERT+CTRL+B

	Switch Voice Profile 
	INSERT+CTRL+S

	Interrupt Speech
	CTRL

	Custom Highlight Assign
	INSERT+CTRL+H

	Refresh Screen
	INSERT+ESC

	Screen Echo toggle
	INSERT+S

	Typing Echo Toggle
	INSERT+2

	Pass Key Through
	INSERT+3

	Select Symbol to Print
	INSERT+4

	JAWS Window
	INSERT+J

	JAWS Find
	INSERT+CTRL+F

	JAWS Find Next
	INSERT+F3

	JAWS Find Previous
	INSERT+SHIFT+F3

	Shut Down JAWS
	INSERT+F4

	Say Active Configuration Name
	INSERT+Q, twice quickly to display in virtual viewer.

	Say Program Comments
	CTRL+SHIFT+C

	Run JAWS Manager
	INSERT+F2

	Virtualize Window
	INSERT+CTRL+W

	Select Scheme
	ALT+INSERT+S

	Select Language
	CTRL+WINDOWS KEY+L

	Select Voice Profile 
	INSERT+CTRL+S

	Minimize All Applications
	WINDOWS KEY+M

	Copy Selected Text to FSClipboard
	WINDOWS Key+C


Additional Notes 

See also:
General Windows Application Keystrokes 

General Windows Keystrokes 

Navigation - Information Keystrokes 

Keystrokes for Accessing the JAWS Utilities

	Description
	Command

	Create a Prompt
	CTRL+INSERT+TAB

	Graphics Labeler
	INSERT+G

	Start Auto Graphics Labeler
	CTRL+INSERT+G

	Set Frame Top Left
	CTRL+SHIFT+LEFT BRACKET 

	Set Frame Bottom Right
	CTRL+SHIFT+RIGHT BRACKET 

	Set Frame to Window
	CTRL+SHIFT+LEFT BRACKET twice quickly 

	Clear Initial Values
	CTRL+INSERT+C

	Run JAWS Manager
	INSERT+F2

	Configuration Manager
	INSERT+6

	Dictionary Manager
	INSERT+D

	Frame Viewer
	INSERT+9

	Keyboard Manager
	INSERT+8

	Script Manager
	INSERT+0

	Script Manager Default
	Unassigned

	Window Class Reassign
	INSERT+7

	Screen Sensitive Help Technical
	CTRL+INSERT+F1

	Say special Window Classes
	CTRL+INSERT+F2

	Say Frame at Cursor
	INSERT+X


Additional Notes 

Keystrokes for Working in Tables

JAWS now supports standard commands for working in tables. These commands work in most popular applications, allowing you access right away - without having to learn the application specific commands. As you become more familiar with new applications, you may find it easier to use the commands specific to that program, or it might be easier for you to continue using these commands.

Commands for Moving within Tables

These commands move focus to the indicated cell and speak the contents. Cell and row coordinates as well as column and/or row heading information may also be provided.

	Description
	Command

	Say Current Cell
	ALT+CTRL+NUM PAD 5

	Cell to Right
	ALT+CTRL+RIGHT ARROW

	Cell to Left
	ALT+CTRL+LEFT ARROW

	Cell Below
	ALT+CTRL+DOWN ARROW

	Cell Above
	ALT+CTRL+UP ARROW

	First Cell
	ALT+CTRL+HOME

	Last Cell
	ALT+CTRL+END

	First Cell in Column
	ALT+CTRL+SHIFT+UP ARROW

	Last Cell in Column
	ALT+CTRL+SHIFT+DOWN ARROW

	First Cell in Row
	ALT+CTRL+SHIFT+LEFT ARROW

	Last Cell in Row
	ALT+CTRL+SHIFT+RIGHT ARROW


Table Reading Commands

	Description
	Command

	Say Current Cell
	ALT+CTRL+NUM PAD 5

	Read Current Row
	WINDOWS Key+COMMA or WINDOWS Key+NUM PAD 5

	Read from Start of Row
	INSERT+SHIFT+HOME

	Read to End of Row
	INSERT+SHIFT+PAGE UP

	Read Current Column
	WINDOWS Key+PERIOD

	Read from Top of Column
	INSERT+SHIFT+END

	Read to Bottom of Column
	INSERT+SHIFT+PAGE DOWN


JAWS Keystrokes for Accessing Help

	Description
	Command

	Screen Sensitive Help
	INSERT+F1

	Keyboard Help
	INSERT+1

	JAWS Help for Applications
	INSERT+F1 twice quickly 

	Hot Key Help
	INSERT+H

	Window Key Help
	INSERT+W


Additional Notes 

See also:
JAWS Keystrokes for Using Help 
JAWS Keystrokes for Using Help

This section contains information on navigating within various help files. There are two primary help formats in use for Windows based applications: WinHelp and Microsoft HTML Help. Different keystrokes are used to navigate through these different types of help files. WinHelp will generally have a Table of Contents window separate from the Contents Display window. Microsoft HTML Help will generally be similar to a framed Web page, with the Table of Contents pane on the left and the Contents (or Topic) pane on the right.

Moving Through a WinHelp Help System 

Moving through a Microsoft HTML Help system 

Moving Through a WinHelp Help System

	Description
	Command

	Read Current Help Screen
	CTRL+INSERT+DOWN ARROW

	Move Down One Screen and Read
	CTRL+PAGE DOWN

	Move Up One Screen and Read
	CTRL+PAGE UP

	Move to Prior Topic in Browse Sequence
	COMMA

	Move to Next topic in Browse Sequence
	PERIOD

	Move to Prior topic
	B

	Move Focus Between Links
	TAB or SHIFT+TAB

	Activate Selected Link
	ENTER

	View Table of Contents
	T

	View Options
	O or ALT+O


Note: Use the UP ARROW and DOWN ARROW to move up and down in the Table of Contents. Use the RIGHT ARROW to open a closed book, and press ENTER to open a topic.

Moving through a Microsoft HTML Help System

The Table of Contents Pane

	Description
	Command

	Move Up through List
	UP ARROW

	Move Down through List
	DOWN ARROW

	Open Book
	RIGHT ARROW or ENTER

	Up One Level or Close Book
	LEFT ARROW

	Display Selected Topic
	ENTER

	Move Between TOC and Topic Pane
	F6


The Topic Pane

	Description
	Command

	Previous topic
	BACKSPACE or ALT+LEFT ARROW

	Next Topic
	ALT+RIGHT ARROW


Note: ALT+RIGHT ARROW does not take you to the next topic unless you have previously gone back one topic or more.

You can access the Topic Pane with the Virtual PC Cursor providing the same functionality as in a web page. Standard JAWS keystrokes for reading text allow you to read the information in each topic. Press ENTER on any link to activate it. 

See also:
JAWS Keystrokes for Reading Text 

Windows Keystrokes for Working with Text 

Laptop Keystrokes

This section contains information on keystrokes specific to the Laptop keyboard layout. The keyboard layout can be changed in the JAWS Application Window under the Options menu, in the Basics dialog. Few Laptop systems have keyboards with a number pad, so many of these functions have been shifted to the main section of the keyboard. Many of the keystrokes are not much different from the Desktop keyboard layout. Only those that are totally different are listed here.

The other keystrokes are all listed in the Desktop keystrokes section. When using the Laptop keyboard layout, just substitute the CAPS LOCK key for the INSERT key. For most of those keystrokes, the INSERT key works as well, however, you may find the CAPS LOCK key is a very easy to use substitute.

Note:  MAGic allows you to select which key is used as the MAGic Key. Since JAWS now provides the same flexibility for the JAWS Key, when the two products are used together, it is important that the MAGic Key and the JAWS key are not assigned to the same key. If they are assigned to the same key, any JAWS commands assigned to a key combination using the JAWS Key are not activated when the key combination is pressed.

Even if you use a desktop system or keyboard, you may wish to try the Laptop keyboard layout. When using the Laptop keyboard layout, most of your commands are right at your fingertips - as you type - so you do not need to continually switch your right hand to the number pad and back to the main section of your keyboard.

Laptop Keystrokes for Reading Text and Information
Laptop Keystrokes for Cursors and Mouse Simulation 

Choose your own JAWS Key
Laptop Keystrokes for Reading Text and Information

	Description
	Command

	Say Prior Character
	CAPS LOCK+M

	Say Next Character
	CAPS LOCK+PERIOD

	Say Character
	CAPS LOCK+COMMA

	Say Character Phonetically
	CAPS LOCK+COMMA twice quickly

	Say Prior Word
	CAPS LOCK+J

	Say Next Word
	CAPS LOCK+L

	Say Word
	CAPS LOCK+K

	Spell Word
	CAPS LOCK+K twice quickly 

	Say Prior Line
	CAPS LOCK+U

	Say Next Line
	CAPS LOCK+O

	Say Line
	CAPS LOCK+I

	Spell Current Line
	CAPS LOCK+I twice quickly

	Say Prior Sentence
	CAPS LOCK+Y

	Say Next Sentence
	CAPS LOCK+N

	Say Sentence
	CAPS LOCK+H

	Say Prior Paragraph
	CAPS LOCK+CTRL+U

	Say Next Paragraph
	CAPS LOCK+CTRL+O

	Say Paragraph
	CAPS LOCK+CTRL+I

	Say to Cursor
	CAPS LOCK+HOME or CAPS LOCK+SHIFT+J

	Say from Cursor
	CAPS LOCK+PAGE UP or CAPS LOCK+SHIFT+L

	Spell to Cursor
	CAPS LOCK+HOME or 
CAPS LOCK+SHIFT+J twice quickly

	Spell from Cursor
	CAPS LOCK+PAGE UP or 
CAPS LOCK+SHIFT+L twice quickly

	Say All
	CAPS LOCK+A or CAPS LOCK+DOWN ARROW

	Say Selected Text
	CAPS LOCK+SHIFT+A or CAPS LOCK+SHIFT+DOWN ARROW

	Say Color
	CAPS LOCK+5

	Say Font
	CAPS LOCK+F

	Say Text and Attributes
	ALT+CAPS LOCK+DOWN ARROW

	Say Top Line of Window
	CAPS LOCK+SHIFT+Y

	Say Bottom Line of Window
	CAPS LOCK+SHIFT+N

	Report Battery Level
	CAPS LOCK+SHIFT+B

	Say ASCII or Hexadecimal Value
	CAPS LOCK+COMMA three times quickly

	Say Current Table Cell
	ALT+SHIFT+COMMA

	Move to Prior Table Cell 
	ALT+SHIFT+M

	Move to Next Table Cell 
	ALT+SHIFT+PERIOD

	Move Up One Table Cell 
	ALT+SHIFT+Y

	Move Down One Table Cell 
	ALT+SHIFT+N

	Start Skim Reading
	CTRL+CAPS LOCK+DOWN ARROW

	Skim Reading dialog box
	CTRL+CAPS LOCK+SHIFT+DOWN ARROW

	Display Skim Reading Summary
	CAPS LOCK+WINDOWS Key+DOWN ARROW


Additional Notes 

See also:
JAWS Keystrokes for Reading Text 

Navigation - Information Keystrokes 

Windows Keystrokes for Working with Text 

Laptop Keystrokes for Cursors and Mouse Simulation

	Description
	Command

	PC Cursor
	CAPS LOCK+SEMICOLON

	JAWS Cursor
	CAPS LOCK+P

	Invisible Cursor
	CAPS LOCK+P twice quickly

	Route PC Cursor to JAWS Cursor 
	CAPS LOCK+APOSTROPHE

	Route JAWS Cursor to PC Cursor 
	CAPS LOCK+LEFT BRACKET

	Restrict JAWS Cursor
	CAPS LOCK+R

	Left Mouse Button
	CAPS LOCK+8

	Right Mouse Button
	CAPS LOCK+9

	Left Mouse Button Lock 
	CTRL+WINDOWS Key+8

	Right Mouse Button Lock
	CTRL+WINDOWS Key+9

	Drag and Drop
	CAPS LOCK+CTRL+8

	Say Active Cursor
	ALT+DELETE

	Mouse Down
	ALT+SHIFT+DOWN ARROW

	Mouse Left
	ALT+SHIFT+LEFT ARROW

	Mouse Right
	ALT+SHIFT+RIGHT ARROW

	Mouse Up
	ALT+SHIFT+UP ARROW


Additional Notes 

Standard Windows Keystrokes

This section contains listings of keystrokes that are part of Windows. JAWS does enhance some of these keystrokes so that what is being done is spoken, but these keystrokes work even without JAWS running. We have attempted to include the most useful Windows keystrokes, but have not attempted to compile a complete listing.

General Windows Keystrokes 

General Windows Application Keystrokes 

Keystrokes for Working in Dialog Boxes 

Keystrokes for Working with Text in Documents 

Keystrokes for Working in Windows Explorer 

Keystrokes for Using the Clipboard
Keystrokes for Windows Vista Gadgets 
See also:
Keystrokes for Popular Applications
General Windows Keystrokes

	Description
	Command

	Get Help
	F1

	Open the Start Menu
	WINDOWS LOGO KEY or CTRL+ESC

	Switch between Open Applications
	ALT+TAB

	Open the Shortcut Menu
	APPLICATIONS KEY or SHIFT+F10

	Minimize all Applications
	WINDOWS LOGO KEY+M

	Find a File or Folder from Desktop
	F3

	Move to First Item on the Taskbar
	WINDOWS LOGO KEY+TAB

	Open Windows Explorer
	WINDOWS LOGO KEY+E

	Open Run Dialog
	WINDOWS LOGO KEY+R


Additional notes 

See also:
Navigation - Information Keystrokes 

General Windows Application Keystrokes

	Description
	Command

	Exit the Active Application
	ALT+F4

	Open the Application Control Menu
	ALT+SPACEBAR

	Move to the Menu Bar
	ALT

	Move between Menus
	ALT, ARROW KEYS

	Choose a Menu Item
	ENTER

	Open a child Window Control Menu
	ALT+DASH

	Cancel or close a Menu
	ESC or ALT


Additional Notes 

See also: 

Navigation - Information Keystrokes 

Windows Keystrokes for Working in Dialog Boxes

	Description
	Command

	Move through Dialog Controls
	TAB

	Move Backward through Dialog Controls
	SHIFT+TAB

	Move to Another Page
	CTRL+TAB

	Reverse Direction through Pages
	CTRL+SHIFT+TAB

	Select/Deselect in List View
	SPACEBAR or CTRL+SPACEBAR

	Toggle a Check Box ON/OFF
	SPACEBAR


Additional Notes 

See also:

JAWS Keystrokes for Working in Dialog Boxes 

Windows Keystrokes for Working with Text

	Description
	Command

	Move One Character Left
	LEFT ARROW

	Move One Character Right
	RIGHT ARROW

	Move One Word Left
	CTRL+LEFT ARROW

	Move One Word Right
	CTRL+RIGHT ARROW

	Move to Beginning of Line
	HOME

	Move to End of Line
	END

	Move One Paragraph Up
	CTRL+UP ARROW

	Move One Paragraph Down
	CTRL+DOWN ARROW

	Move to Top of Next Page
	CTRL+PAGE DOWN

	Move to Top of Previous Page
	CTRL+PAGE UP

	Move to Beginning of Document
	CTRL+HOME

	Move to End of Document
	CTRL+END

	Scroll Up or Down One Screen
	PAGE UP or PAGE DOWN

	Select One Character Left
	SHIFT+LEFT ARROW

	Select One Character Right
	SHIFT+RIGHT ARROW

	Select One Word Left
	CTRL+SHIFT+LEFT ARROW

	Select One Word Right
	CTRL+SHIFT+RIGHT ARROW 

	Select to Beginning of Line
	SHIFT+HOME

	Select to End of Line
	SHIFT+END

	Select to Beginning of Document
	CTRL+SHIFT+HOME

	Select to End of Document
	CTRL+SHIFT+END

	Select All
	CTRL+A

	Undo
	CTRL+Z

	Delete Current Character
	DELETE

	Delete Prior Character
	BACKSPACE


Additional Notes 

See also:
Keystrokes for Using the Clipboard
JAWS Keystrokes for Reading Text 

Keystrokes for Working in Windows Explorer

	Description
	Command

	Delete Selected File or Folder
	DELETE

	Rename Selected File or Folder
	F2

	Refresh Window
	F5

	Switch Between Tree View and List View
	F6 or TAB

	Go Up One Folder Level
	BACKSPACE

	Open File or Folder Properties
	ALT+ENTER

	Untruncate Columns in List View
	CTRL+NUM PAD PLUS  


Additional Notes.

See Also:
Keystrokes for Using the Clipboard 

Keystrokes for Using the Clipboard

	Description
	Command

	Copy Selected File or Text to Clipboard
	CTRL+C

	Cut Selected File or Text to Clipboard
	CTRL+X

	Paste Contents of Clipboard
	CTRL+V

	Read Clipboard Contents 
	WINDOWS Key+INSERT+X


Tip: You also can press WINDOWS Key+C to copy selected text to the FSClipboard. Text that you copied with this keystroke is added to any text that you have previously copied to the Clipboard, instead of replacing it. This allows you to continue adding text to the Clipboard until you are ready to paste it into a document. For more information, see Using the Clipboard.

See also: 
Using the Clipboard
JAWS Keystrokes for Reading Text
Keystrokes for Working in Windows Explorer 

Windows Keystrokes for Working with Text 

Keystrokes for Windows Vista Gadgets 

The Windows operating system uses visual references, such as icons, to quickly access applications and files. In Windows Vista, gadgets are desktop applications and tools that provide visual updates for such items as computer performance, weather, time, and news feeds. The following table contains a list of keyboard shortcuts that can help you navigate gadgets that appear in an area on the desktop known as the Sidebar.

	Description
	Command

	Bring Sidebar and all gadgets to the foreground 
	WINDOWS Key+SPACEBAR

	Cycle forward through the Sidebar gadgets 
	WINDOWS Key+G 

	Cycle backward through the Sidebar gadgets 
	WINDOWS Key+SHIFT+G 


To open the Sidebar, do the following:

1. Press WINDOWS Key. 

2. Type Sidebar in the Start Search edit field and press ENTER. 

Keystrokes for PAC Mate BX Remote Mode

Because the BX series of PAC Mates do not have the types of keys required to operate a computer that you access remotely with PAC Mate Desktop, a number of special keystrokes are provided. These keystrokes allow you to simulate modifier keys (such as CTRL, INSERT, and ALT), special keys not available on the PAC Mate (such as ENTER or ESC), and certain JAWS commands for navigation and selecting text. 

Modified Keys
Special Keys
Navigation Commands
Text Selection Commands
Modifier Keys

You can use these modifier keys to simulate key combinations that include CTRL, ALT, WINDOWS Key, SHIFT, or the JAWS Key (INSERT). To use these modifiers, hold down DOT 8 CHORD and then press the corresponding modifer keys in the keystroke. After you create the modifier portion of the keystroke, release the keys and press the remaining key. For example, to perform the keystroke CTRL+SHIFT+V you press DOTS 3-7-8 CHORD, release them, and then press V (DOTS 1-2-3-6).

	Key
	Command

	Function Keys (F1 - F12)
	DOT 1

	INSERT
	DOT 2

	CTRL
	DOT 3

	WINDOWS Key
	DOT 4

	JAWS Key
	DOT 5

	ALT
	DOT 6

	SHIFT
	DOT 7


Function Keys

To simulate the function keys (F1 through F12) on your PAC Mate BX, press DOTS 1-8 CHORD followed by A through L (which correspond to 1 through 12). For example, to simulate the F6 key, press DOTS 1-8 CHORD, then F (DOTS 1-2-4).

If the function key is part of a key combination, add the appropriate modifiers while holding down DOTS 1-8 CHORD. For example, to simulate the keystroke INSERT+F2, press DOTS 1-2-8 CHORD, then B (DOTS 1-2).

Special Keys

You can use these commands to simulate certain keys that are not available on the BX keyboard. These keys can be combined with the modifier keys described previously.

	  Key
	Command

	ESC
	F1

	ALT
	F2

	APPLICATION Key
	F2 CHORD

	NUM PAD ASTERISK
	F3

	WINDOWS Key
	F4

	NUM PAD MINUS
	F6

	NUM PAD SLASH
	F7

	CAPS LOCK
	F7 CHORD

	NUM PAD PLUS
	F8

	ENTER
	DOT 8

	BACKSPACE
	DOT 7

	CTRL+BACKSPACE
	DOTS 1-2-3-4-5-6-7 CHORD

	TAB
	DOTS 4-5 CHORD

	SHIFT+TAB
	DOTS 1-2 CHORD

	HOME
	DOTS 1-3 CHORD or DOT 3+LEFT ARROW

	END
	DOTS 4-6 CHORD or DOT 3+RIGHT ARROW

	PAGE UP
	DOT 2+UP ARROW or DOT 2+LEFT ARROW

	PAGE DOWN
	DOT 2+DOWN ARROW or DOT 2+RIGHT ARROW

	DELETE
	DOTS 1-2-3-4-5-6 CHORD

	EQUALS
	DOTS 1-2-3-4-5-6

	RIGHT BRACKET
	DOTS 1-2-4-5-6-7

	LEFT BRACKET
	DOTS 2-4-6-7

	BACKSLASH
	DOTS 1-2-5-6-7

	SLASH
	DOTS 3-4

	RIGHT PARENTHESIS
	DOTS 2-3-4-5-6

	APOSTROPHE
	DOT 3

	DASH
	DOTS 3-6

	GRAVE
	DOT 4

	PERIOD
	DOTS 4-6

	SEMICOLON
	DOTS 5-6

	COMMA
	DOT 6


Navigation Commands

You can use these keystrokes to perform various JAWS navigation commands. 

	 Description
	Command

	Say Prior Character
	DOT 3 CHORD or LEFT ARROW

	Say Next Character
	DOT 6 CHORD or RIGHT ARROW

	Say Character
	DOTS 3-6 CHORD or RIGHT ARROW+LEFT ARROW

	Say Prior Word
	DOT 2 CHORD or DOT 5+LEFT ARROW

	Say Next Word
	DOT 5 CHORD or DOT 5+RIGHT ARROW

	Say Word
	DOTS 2-5 CHORD or DOT 5+RIGHT ARROW+LEFT ARROW

	Say Prior Line
	DOT 1 CHORD or UP ARROW

	Say Next Line
	DOT 4 CHORD or DOWN ARROW

	Say Line 
	DOTS 1-4 CHORD or UP ARROW+DOWN ARROW

	Say Prior Sentence
	DOT 4+LEFT ARROW

	Say Next Sentence
	DOT 4+RIGHT ARROW

	Say Sentence
	DOT 4+UP ARROW or DOT 4+RIGHT ARROW+LEFT ARROW

	Say Prior Paragraph
	DOT 1+UP ARROW

	Say Next Paragraph
	DOT 1+DOWN ARROW

	Say Paragraph
	DOT 1+UP ARROW+DOWN ARROW

	Move to Top of File
	DOTS 1-2-3 CHORD or DOT 3+UP ARROW

	Move to Bottom of File
	DOTS 4-5-6 CHORD or DOT 3+DOWN ARROW

	Say to Cursor
	DOTS 3-7+LEFT ARROW

	Say from Cursor
	DOTS 3-7+RIGHT ARROW

	Say All
	DOTS 4-5-6-8 CHORD or DOTS 1-2-4-5-6 CHORD or DOTS 3-7+DOWN ARROW

	Say Selected Text
	DOTS 1-2-4-5-6-7 CHORD or DOTS 4-5-6-7-8 CHORD

	Previous Document Window
	DOTS 2-3 CHORD

	Next Document Window
	DOTS 5-6 CHORD

	Open List Box
	DOT 7+DOWN ARROW

	Close List Box
	DOT 7+UP ARROW

	Exit Forms Mode
	DOTS 1-3-4-6 CHORD

	Say Window Prompt and Text
	DOTS 1-2-4-5 CHORD


Microsoft Word Navigation Quick Keys

You can use these keystrokes to navigate Microsoft Word documents. Navigation Quick Keys must be enabled in order for these commands to function. For more information, see Navigation Quick Keys in Word.

Tip: You can add DOT 7 to most of the keystrokes in the table below to move to the previous element of that type in the document. 

	Description
	Command

	Next Bookmark
	DOTS 1-2

	Next Comment
	DOTS 1-4

	Next Endnote
	DOTS 1-5

	Next Form Field
	DOTS 1-2-4

	Next Graphic
	DOTS 1-2-4-5

	Next Heading
	DOTS 1-2-5

	Next Footnote
	DOTS 1-3-5

	Next Paragraph
	DOTS 1-2-3-4-8

	Previous Paragraph
	DOTS 1-2-3-4-7

	Next Section
	DOTS 2-3-4

	Next Table
	DOTS 2-3-4-5

	Next Page
	SPACEBAR

	Previous Page
	BACKSPACE


Text Selection Commands

You can use these keystrokes to perform various text selection commands. 

	 Select Prior Character
	DOTS 3-7 CHORD or LEFT ARROW CHORD

	Select Next Character
	DOTS 6-7 CHORD or RIGHT ARROW CHORD

	Select Prior Word
	DOTS 2-7 CHORD or DOT 5 CHORD+LEFT ARROW

	Select Next Word
	DOTS 5-7 CHORD or DOT 5 CHORD+RIGHT ARROW

	Select Prior Line
	DOTS 1-7 CHORD or UP ARROW CHORD

	Select Next Line
	DOTS 4-7 CHORD or DOWN ARROW CHORD

	Select Prior Screen
	DOT 2 CHORD+UP ARROW

	Select Next Screen
	DOT 2 CHORD+DOWN ARROW

	Select from Start of Line
	  

DOTS 1-3-7 CHORD or DOT 3 CHORD+LEFT ARROW

	Select to End of Line
	DOTS 4-6-7 CHORD or DOT 3 CHORD+RIGHT ARROW

	Select from Top
	DOTS 1-2-3-7 CHORD or DOT 3 CHORD+UP ARROW

	Select to Bottom
	DOTS 4-5-6-7 CHORD or DOT 3 CHORD+DOWN ARROW


Keystrokes for Popular Applications

Windows 

Internet 

E-Mail 

Word Processing
Spreadsheet, Financial, and Database 

Multimedia
Utilities 

Programming Tools 

Miscellaneous
Using the Merge Utility

If JAWS 5.0 or later is installed on your computer, you can use the Merge Utility to import your settings. This utility imports all of your configuration (.jcf) files, dictionary (.jdf) files, graphics (.jgf) files, schemes, sounds, PlaceMarkers, personalized Web settings, and voice settings from a previous version of JAWS. Any script files you created that are not already included with JAWS are also imported. This allows you to retain many of your customized settings when you upgrade to a later version.

Note: You cannot use the Merge Utility if you are running JAWS from a USB thumb drive.

This process does not import your JAWS startup preferences, braille settings, keyboard layout selection, or custom keyboard assignments. In addition, any changes to script files included with JAWS are not imported.

Note: You may need to open your scripts in Script Manager and recompile them before using them with JAWS.

To import your settings from a previous version of JAWS, do the folowing:

1. From the Utilities menu, choose Merge Manager. 

2. In the JAWS Version list, select the version of JAWS you want to import settings from. If the version of JAWS you want to use as the source is not in the list, choose Browse to locate it. You can only merge settings from JAWS 5.0 or later. 

3. Choose OK to import your settings. 

Using the Synthesizer and Braille Manager

The Synthesizer and Braille Manager allows you to add, modify, or remove synthesizer and braille display drivers. Adding synthesizers or braille displays makes them available from the JAWS user interface. Modifications can include changing the default synthesizer or braille display and changing the output port, if applicable. Removing the devices will only remove them from the JAWS user interface. The device files will remain on the computer until JAWS is uninstalled.

To start the Synthesizer and Braille Manager, do one of the following:

· Open the Utilities menu and choose Synthesizer and Braille Manager, or.
· Choose Synthesizer and Braille Manager from the Tools menu in the JAWS Start menu program group. 

When you start this utility, a tree view of all synthesizer and braille display drivers installed on your computer displays. 

To add, change, or delete devices, do the following:

1. Choose the Add, Remove, or Change Devices button. 

2. If you want to select synthesizers, select the Speech Synthesizers radio button. If you want to select braille displays, select the Braille Displays radio button. 

3. Choose the Next button. 

4. A list of available devices displays. To add or remove a device, use the arrow keys to select it in the list and then press the SPACEBAR to select or clear the check box. After you have selected all devices that you want to use, choose the Next button. 

5. If you are selecting synthesizers, you are asked to choose a default synthesizer that JAWS will use each time you start the program. If you are selecting braille displays, you are asked to choose a default braille display. After you have made a selection, choose the Next button. 

6. If you are modifying braille displays, you are asked to specify your device settings. 

7. Choose Finish to complete the process. The braille displays and synthesizers that you selected are now installed. 

Graphics Labeler Overview

Windows is a graphical user interface. A graphic can be an icon, toolbar button, or a picture in an application or on the Internet. Many graphics that you encounter in Windows are labeled. When you navigate over a graphic, JAWS reads these labels to you. Some graphics are not labeled. In this case you will hear, "Graphic XXX." The numbers you hear after the word graphic are assigned by JAWS. With JAWS, you can label graphics that don’t already have a label specified. You can label graphics automatically or manually. You may need sighted assistance, to help you determine what the graphic is so that you can label it appropriately. 

After you label your graphics, you can choose to save these labels to the specific application or to the default file. If you save the graphics labels in the default file, the label will always be recognized unless it is labeled differently by an application. 

Creating a Graphic Label Manually 

Using the Auto Graphics Labeler 

Creating a Graphic Label Manually

To practice creating a Graphic Label, use HJPad. To launch HJPad go to Start, Programs, JAWS X (where X is the JAWS version number), Run HJPad.

Using the Graphics Labeler is easy, but before you start ensure that you have speak graphics verbosity turned on. Follow these steps to be sure:

1. With HJPad open, press INSERT+V to bring up the Verbosity dialog box. 

2. Press G to move to the Graphics Verbosity item in the list box. 

3. Press the SPACEBAR until you hear JAWS say, "All graphics," and then press ENTER. 

Now that all graphics will be spoken, you are ready to find a graphic to label. 

4. Press the NUM PAD MINUS key to activate the JAWS cursor. 

Tip: To navigate to the toolbar, first press PAGE UP to move to the top of the window, and then press HOME to move to the top, left.

5. Use the arrow keys to move to the first toolbar button. You will hear, "Graphic XXX." XXX can indicate any number. 

6. Press INSERT+G to open the Graphics Labeler. 

7. When the Graphics Labeler is opened, the focus is in the edit field, where you should enter the label for the graphic. It will contain the graphic and the number that is assigned to it. Type the name for your graphic. 

8. Press the TAB key to move to the Braille label field. Here you can enter a label for a Braille display. 

9. Next press the TAB key to move to a group of radio buttons that will let you determine where you want to save the label, in the application file, default file, or both files. 

10. Press ENTER to activate your graphic label. 

Note: To edit a graphic label, use the same procedure that you would to create a new graphic label, and just change the name of the label in the Graphics Labeler when it opens. To delete a graphic label, do the same, but delete the name in the Graphics Labeler.

Using the Auto Graphics Labeler

The Auto Graphics Labeler assigns a text label to all graphics that are associated with ToolTips. A ToolTip is a brief description of a graphic that appears on the screen as you point to the graphic with your mouse. 

To activate the Auto Graphics Labeler, open the desired application, and press CTRL+INSERT+G.

JAWS will attempt to label all graphics. Do not move the mouse or press any keys on the keyboard until JAWS states that the Auto Graphics Labeler is finished. When JAWS finishes, it will announce the newly labeled graphics.

After using the Auto Graphics Labeler, you can use CTRL+INSERT+SHIFT+G to bring up the Select Graphic to Click Dialog box. With this dialog box, you can use your arrow keys to move through the available graphics, and then press the TAB key to move to the OK button and press ENTER to activate the graphic you selected.

Add and Change Prompts

Prompts are labels for controls in dialog boxes. Some of the time, JAWS does not read a prompt, or the prompt that is provided is not very meaningful. Now, when you find a prompt like this, just assign the prompt you want JAWS to speak and display in Braille. And if you want a brief reminder spoken whenever you move to a particular control, just add a custom tutor message to provide this information.

Creating a Prompt

To create a prompt:

1. Move to the control for which the prompt is not properly spoken. 

2. Press CTRL+INSERT+TAB. 

3. A dialog box appears to walk you through the creation of the prompt. On the first page, enter the prompt for the control as you want JAWS to speak it, and then select Next. 

4. On the second page, enter the prompt for the control as you want JAWS to display it in Braille, and then select Next. 

5. On the third page, specify a Tutor message to provide assistance with navigation or the use of this control. If you leave the Tutor message blank, the default message is used. Select Finish to create your prompt. 

Note: You can also press INSERT+F2 to open the Run JAWS Manager dialog and select Prompt Create from the list to create a prompt.

If you wish to change a prompt you have assigned, just press CTRL+INSERT+TAB again and change the labels you entered.

Custom Tutor Messages

The Prompt Creator dialogs can be used to create custom Tutor messages. Even if you don't want to change a control's prompt, you can still add a Tutor message that provides you tips to remind you of the purpose of a control.

When you create a Prompt, the field for specifying a spoken prompt initially contains what JAWS believes the prompt is. If you do not change this, and select the Next button, the prompt to be displayed in Braille contains this same information. If you select Next without changing this, you can add the Tutor message you wish to use without modifying the spoken or Brailled prompt for the control.

Tutor messages are a great tool for familiarizing yourself with windows and applications. If you no longer need these messages, you can turn them off, but still hear the custom Tutor messages you have added. In the JAWS application window, Options, Basic Settings, set the Tutor Messages group of radio buttons to Announce Custom Messages Only. And if you wish to hear Tutor messages for menus and controls, as well as the custom Tutor messages you have added, just leave this group of radio buttons set to Announce Menu and Control Help. However, you cannot choose to hear both a custom Tutor message and a default Tutor message for the same control.

Deleting Prompts

To delete a prompt you have created:

1. Navigate to the dialog or window containing the control for which you created the prompt. 

2. press INSERT+F2, select Frame Viewer, and press ENTER. 

3. TAB to the frame with the name of the prompt you wish to delete and press the DELETE key. 

Troubleshooting Prompts

Creating prompts is a straightforward process and you will seldom run into any difficulties. However, there are a few situations within which your prompts may need to be slightly reconfigured for best results. There are also situations within which it is necessary to create your prompts in a specific manner. Several of these situations are listed below with our recommendations for how to make your prompts work best. 

A Prompt is Recognized in Several Dialogs

It is possible FOR a prompt to be recognized within several dialogs within the same application. This can only occur when the dialogs in an application use similar names and the controls in them are laid out similarly.

When prompts are created, the text from the title of the dialog in which the control is located is recorded. The prompt is then available whenever a dialog in that application containing that text is opened. Because of this, if you create a prompt in a dialog titled "Options," and that same application also has a dialog named "Format Options" or something else containing the word "options," the prompt is recognized in that dialog as well. And if there is a control in that dialog in the same position as that for which you created the prompt, the prompt is spoken when you TAB to that control.

To correct this:

1. Open the dialog where you created the prompt. 

2. Press INSERT+F2 to open the Run JAWS Manager dialog, select Frame Viewer, and press ENTER. 

3. TAB to the frame with the name of your prompt. 

4. Press ALT+ENTER to open properties for the frame. 

5. Press CTRL+TAB to move to the Validation Rules page of this dialog. 

6. Select the Window Title rule and press ALT+M to modify it. 

7. Do not change the rule type. Move to Next and press ENTER. 

8. Change the comparison type from Contains to Is and select Next. 

9. Do not change the comparison value. Select Finish. 

10. You should be back in the Validation Rules page of properties. Press ENTER. 

11. Press CTRL+S to save changes. 

12. Press ESC to exit Frame Viewer. 

Your prompt should now work only in the dialog for which it was intended.

Prompts in Multipage Dialogs

Prompts created within multipage dialogs may be recognized within several pages of the dialog. This is because the title of the dialog is used to determine when the prompt is available, and the title of multipage dialogs do not change as you move from page to page.

To prevent this, the prompt must look for something unique in the page of the dialog where it was created. We recommend identifying text of some sort within the page, which is not present in any other pages of the dialog. Once you have identified such text, follow these steps to set your prompt to only be available when that text is present.

1. Open the dialog to the page where you created the prompt. 

2. Press INSERT+F2 to open the Run JAWS Manager dialog, select Frame Viewer, and press ENTER. 

3. TAB to the frame with the name of your prompt. 

4. Press ALT+ENTER to open properties for the frame. 

5. Press CTRL+TAB to move to the Validation Rules page of this dialog. 

6. Press ALT+A to modify a new rule. 

7. Set the rule type to Window Text. Move to Next and press ENTER. 

8. Leave the comparison type set to Contains, and select Next. 

9. For the comparison value, type in the text you identified as unique to the page of the dialog where you want your prompt to work. Press TAB to move to the Add button and press ENTER. Then select Finish. 

10. You should be back in the Validation Rules page of properties. Press ENTER. 

11. Press CTRL+S to save changes. 

12. Press ESC to exit Frame Viewer. 

A Prompt that does not Size to the Control

You may find situations where a prompt you create does not correctly size to the control or area of the screen in which you want to use it. One example of this is when creating prompts for use in terminal emulation software. In these cases, it may be necessary to create the prompt in another manner.

You can use the JAWS cursor to specify the exact position of the top left and bottom right corners of your prompt, limiting it to the exact area where you need it.

1. With the JAWS cursor, navigate to the top, left corner of the area you want included in the prompt. 

2. Press CTRL+SHIFT+LEFT BRACKET. 

3. Move to the bottom, right corner of the area you wish to include in the prompt, and press CTRL+SHIFT+RIGHT BRACKET. 

4. A dialog box appears asking you if you wish to create a frame or a prompt. Select to create a prompt. 

The standard Prompt Creator dialogs appear. Fill out the information on each page just like with any other prompt.

Introduction to Frames

Frames are a quick, easy way to make your applications more accessible. A frame is a rectangular area of a window or the screen you define so JAWS knows to monitor it for any activity that might take place.

What Frames Do

Frames can do many things. Some of the more common uses are:

· Speak or Braille information at the press of a keystroke. 

· Speak or Braille information when you TAB to a control within the borders of the frame. 

· Speak or Braille information when text is newly displayed within the borders of the frame. 

· Prevent JAWS from automatically speaking information. 

Quickly list all of your currently active frames by pressing INSERT+F9. Select a frame in the list and press ENTER and the JAWS cursor is moved to that frame.

Press CTRL+INSERT+A to quickly display the names and textual content of all currently active frames within the Virtual Viewer. Easily select text and copy it to the clipboard. Use standard reading commands to read the information. Each frame's name is a link, and selecting one of these links moves the JAWS cursor to that frame. This feature makes it very easy to interact with text without moving focus away from the control or window where you were working, and will save many people a lot of time in terminal emulation programs, call centers, and many other situations.

Working with Frames

Frames are now much easier to work with and modify. We provide a totally new interface that is easier to use for everyone. In Frame Viewer, frames are visible on the screen, and standard commands let you easily move between them, move and resize them, and access their properties. Refer to Frame Viewer.

Frames also provide the support to make it possible to quickly and easily create prompts for controls when the prompt does not speak or does not provide useful information. Refer to Add and Change Prompts.

Designing Effective Frames

With frames, there are three main things to consider:

Position: Your frame needs to be properly positioned. The frame's size and location determine what areas of the screen or window are monitored. Frames should be positioned based on what information you want them to speak, what you want them to do, or what activity occurring in your application you wish to have cause the frame to do something. Frames are positioned when they are first created, and easy to use methods are provided for you to move or resize a frame within Frame Viewer.

Validation Rules: Frames set rules to compare information in your application with information that is specified when each frame is created. This ensures frames are only available where you need to use them. Frames should be limited so they only work where you need them. If you design a series of three or four frames to make a specific dialog box in Microsoft Word more accessible, the frames should only be active in that dialog box. If they are active in other Word dialog boxes, you will receive unpredictable, and possibly very confusing results.

Events and Actions: Events are the activities that cause your frames to perform some action. Set your frames to do something when a key is pressed, when text is newly displayed within the borders of the frame, when you move to a control within the borders of a frame, or when one of these events occur within another frame. Assign the actions you wish to occur to each event, and a frame can do many things, naturally responding as you work in your application.

Creating a Frame

1. With the JAWS cursor, navigate to the top, left corner of the area you want included in the frame. 

2. Press CTRL+SHIFT+LEFT BRACKET. 

3. Move to the bottom, right corner of the area you wish to include in the frame, and press CTRL+SHIFT+RIGHT BRACKET. 

4. A dialog box appears asking you if you wish to create a frame or a prompt. Select to create a frame. 

5. A dialog appears to walk you through the creation of the frame. On the first page, enter the name of the frame and select Next. 

Note: Frame names cannot contain spaces or symbols. We recommend concatenating the names, capitalizing the start of each word.

6. The second page asks for a synopsis of the frame's purpose. Fill out the information and select Next. This information is very important if others are going to use your frames. 

7. The third page asks for a more detailed description of the frame's purpose. Fill out the information and select Next. This information is very important if others are going to use your frames. 

8. The fourth page prompts you to assign a keystroke to the frame. If you choose to assign a keystroke, text within the frame is spoken when the keystroke is pressed. This functionality is added as a frame event and can be modified later. 

9. The fifth page prompts you to specify how JAWS will echo text newly written within the frame. Select JAWS Screen Echo, Silent, Highlight, or All. These settings correspond to using the current JAWS screen echo setting, or specifying which screen echo setting to use. This functionality is added through use of Frame Events. For information on what Frame Event is added based on your selection, please refer to Default Frame Events. After selecting an option, select Finish to continue. 

Tip: Move the JAWS cursor to a control or window, and press CTRL+SHIFT+LEFT BRACKET twice quickly to set the frame to the current control or window. Then fill in the information as stated above.

At this point, the frame is created, but not saved. Focus is on the frame, and Frame Viewer is active. Press the Applications key to open the context menu for the frame.

· Select Save Changes from the menu to save the frame. 

· Select Properties to modify settings for the frame. 

· If you select Exit Frames Mode without first saving the frame, a dialog prompts you to save your changes. 

Tip: Sighted users of JAWS may find it easier and more straightforward to create a frame by opening Frame Viewer, selecting Options, Create New Frame, and after filling in the information in the Create a Frame dialogs, sizing and positioning the frame with the mouse. By default, frames created in this manner are sized to the current control or window.

Frame Viewer

Frame Viewer is where you work with frames. Move between them, move them, resize them, or open a frame's properties and adjust settings.

To open Frame Viewer, press INSERT+F2, move to Frame Viewer, and press ENTER.

The Frame Viewer displays all active frames for the current application and the Frames Mode buttons. Focus is initially on the first of these frames. (This is determined by which frame was first created.) Press TAB to move through the frames. If you continue to press TAB until you have moved through all the frames, focus moves to the Frame Viewer buttons.

There are four Frame Viewer buttons: Options, Frames List, Help, and Close. These buttons let you access very useful features, and most all these features, and more, are accessible right from any frame. If you open Frame Viewer and no frames are active, focus is on the Options button.

Commands Available from any Frame

	Description
	Command

	Read Text in Frame 
	INSERT+DOWN ARROW 

	Move Between Frames 
	Tab or SHIFT+TAB 

	Open Frame Properties 
	ALT+ENTER 

	Open Context Menu 
	APPLICATIONS KEY or SHIFT+F10 

	Save All Changes to Frames 
	CTRL+S 

	Delete Current Frame 
	DELETE 


Frames Context Menu

The context menu for a frame is opened by pressing the APPLICATIONS key. The following options are available from this context menu.

Frame Properties: Opens a multi page dialog containing General Properties, Validation Rules, Events, and Position information. Refer to Frame Properties for more information.

Status: Use this submenu to temporarily disable and enable frames.

Move: Use this option to move the frame, right from the keyboard, while receiving spoken feedback. Refer to Moving Frames for more information.

Resize: Use this option to resize the frame, right from the keyboard, while receiving spoken feedback. Refer to Resizing Frames for more information.

Events: Opens the Frame Properties dialog to the Events page. Refer to Events Properties for more information.

Save Changes: Saves changes to all frames.

Frames List: Opens a dialog listing frames currently active, or frames in the current application. Refer to Frames List for more information.

Delete: Deletes the current frame.

Hide Titles: Temporarily hides frame titles.

Exit Frame Viewer: Exits frame viewer. If changes have been made, but not saved, you are prompted to save changes.

Positioning Frames

One of the primary factors determining how well a frame will work is how effectively it is positioned. Frames are positioned in the following ways.

· When you create a frame,you can size and position the frame to the current control or window, or you can specify the exact location of the top left corner and bottom right corner. For more information, refer to Creating a Frame. 

· Open Frame Viewer, press TAB to move to an existing frame, press ALT+ENTER to open the current frame's properties, and press CTRL+TAB to move to the position page. Modify the settings in this dialog to adjust the location and size of the frame. For more information, refer to Position Properties. 

· Open Frame Viewer, press TAB to move to an existing frame, and select Move or Resize from the frame's context menu, and use the arrow keys to adjust the position or size of the frame. This method allows you to adjust a frame's size and/or position right within Frame Viewer, and provides spoken feedback as you move or resize a frame. 

· Use your mouse to drag a frame by its title bar to a new location, or to drag a border to resize the frame. 

Tip: When a person, working visually, uses the mouse to move the mouse pointer over the edge of a frame, the mouse changes shape and becomes a double arrow. If they click and hold the left mouse button they can now drag the edge to change the frame size. When they release the left mouse button, the changed size is retained. They can continue sizing by moving the mouse to another edge and repeating the process. If they simply want to move the frame they would click and hold the left mouse button with the mouse on the title bar of the frame. While the mouse button is held down the person can move the frame freely around the screen. When they release the mouse button, the new position is retained.

Enable Show Window Contents

If you select the context menu items and use the arrow keys to move or resize a frame, you first need to check the Show Window Contents While Dragging check box in the Effects page of Display Properties. This will ensure you receive the maximum feedback while you are moving or resizing a frame. To do this:

1. Press the WINDOWS KEY to open the Start Menu. 

2. Select Settings, Control Panel. 

3. Select Display Properties. 

4. Press CTRL+TAB until you are at the Effects page. 

5. TAB to the Show Window Contents While Dragging check box and press SPACEBAR to check it if it is not already checked. 

This ensures you receive spoken feedback as you move or resize a frame. If you do not check this check box, you still receive spoken feedback, but only after completing the operation.

Moving Frames

To move frames with the arrow keys:

1. Press INSERT+F2, move to Frame Viewer, and press ENTER. 

2. TAB to the frame you wish to reposition. 

3. Press the APPLICATIONS key. Then press M. 

4. Press the arrow key corresponding to the direction you wish to move the frame. As you press arrow keys and the frame moves, the distance in pixels is reported. 

5. Press INSERT+DOWN ARROW to hear what text is within the borders of the frame. This should assist you in verifying the frame is positioned where you need it. 

6. Press ENTER when the frame is positioned where you want it, or press ESC to cancel the operation. 

Resizing Frames

To resize a frame with the arrow keys:

1. Press INSERT+F2, move to Frame Viewer, and press ENTER. 

2. TAB to the frame you wish to resize. 

3. Press the APPLICATIONS key. Then press R. 

4. Press the arrow key corresponding to the border of the frame you wish to move. 

5. Press the arrow key corresponding to the direction you wish to move the selected border. 

For example, if you wish to bring the right border of the frame in (to make the frame smaller), first press RIGHT ARROW, then press LEFT ARROW to move the border of the frame. As you press arrow keys and the border moves, the distance in pixels is reported.

6. Press INSERT+DOWN ARROW to hear what text is within the borders of the frame. This should assist you in verifying the frame is sized as you need it. 

7. Press ENTER when the frame border is positioned where you want it, or press ESC to cancel the operation. 

Frame Viewer Toolbox

Frame Viewer includes a toolbox containing four buttons: Options, Frames List, Help and Close. The Help button opens the Introduction to Frames help topic, and closes Frame Viewer. The close button closes Frame Viewer. The Options and Frames List buttons are explained in the following sections.

Options

Select the Options button to open a context menu containing the following items:

Create New Frame: This item creates a new frame positioned on and sized to the control or window that was active when Frame Viewer was opened.

View Frames List: This item opens the Frames List dialog.

Save Changes: This item saves changes to all frames.

Exit Frame Viewer: This item closes Frame Viewer. If frame settings have been changed, but not saved, you are prompted to save your changes.

Status: This item opens a submenu from which you can disable all frames and enable them again.

Hide Titles: This item temporarily hides titles for all frames.

Frames List

The Frames list button opens a dialog that lists all frames for the application that was active when Frame Viewer was opened. This list provides an alternate means of working with your frames, and provides access to frames that are inactive. Frame Viewer does not display frames that are inactive, so the Frames List dialog is the only way to access and make modifications to inactive frames. 

An inactive frame has Validation Rules set to check for conditions that are not met at the time Frame Viewer was opened. For example, if a frame is set to be active in the Options dialog within an application, but Frame Viewer is opened from the application's Settings dialog, the frame would be inactive.

The following commands are available from the list of Frames:

	Description
	Command

	Enable/Disable Frame
	SPACEBAR

	Open Frame Properties
	ALT+P

	Delete Frame
	ALT+D

	Close Frames List
	ALT+C

	Move to Frame
	ALT+M


Note:  You can only move to active frames, but you can modify the properties for any frame in the list.

Frame Properties

The Frame Properties Dialog is a multi-page dialog box. Use this dialog to modify general settings, validation rules, events, or to fine tune a frame's position and size.

To access the properties for a frame, press INSERT+F2 to open the Run JAWS Manager dialog. Select Frame Viewer from the list and press ENTER. TAB to the frame and press ALT+ENTER.

General Properties

The General page of the Frame Properties dialog contains basic settings. Many of these settings contain the information entered when a frame is created. Use this page to modify those settings you feel you need to change after you have created your frame.

Frame Name: Lists the name you assigned when you created your frame.

Synopsis and Description: Lists information that is used in Keyboard Help, INSERT+1, when you press the keystroke assigned to your frame.

Prompts - Spoken, Brailled, Tutor: Lists information for frames used to provide prompt information for controls.

Keystroke: Lists the keystroke which activates the On Frame Key event for the frame, causing any assigned actions to take place. If you copy a frame from another version of JAWS, or from another computer running JAWS, you need to reassign this keystroke.

Priority: Sets the relative priority of frames. This is useful when you have multiple frames within the same area of an application as it allows you to determine which one takes precedence over the others. The lower the value, the higher the priority.

Validation Rules Properties

The Validation Rules page of the Frame Properties dialog contains a list of the rules used to determine when the frame is active. The rules compare information from your application with information specified when the frame was created. The order in which rules are listed is the order in which they are processed.

The list specifies if the rule is on or off, the type of rule, the comparison type, and the value being compared.

	Description
	Command

	Create Rule
	ALT+A

	Toggle Rule on/off
	SPACEBAR

	Modify Rule
	ALT+ENTER

	Move Rule up
	ALT+UP ARROW

	Move Rule Down
	ALT+DOWN ARROW

	Edit Comparison Value
	F2


When you select to create or modify a rule, a series of dialogs prompts you through each of the settings for the rule. Select Next after choosing each setting, and select Finish when you have completed all the dialogs. For more information, refer to Validation Rules.

Events Properties

The Events page of the Frame Properties dialog contains a list of the frame events set for the current frame. Events specify what your frame does, and what system activity causes it to do it. Events are things that happen in the application. Actions are assigned to them in this dialog so they take place whenever the event occurs. The order in which events are listed is the order in which they take place.

	Description
	Command

	Create Event
	F2

	Modify Event
	ALT+ENTER

	toggle Event on/off
	SPACEBAR

	Move Event Up
	ALT+UP ARROW

	Move Event Down
	ALT+DOWN ARROW


When you select to create or modify an event, a series of dialogs prompts you through each of the settings for the event. Select Next after choosing each setting, and select Finish when you have completed all the dialogs. If you are assigning multiple actions to the same type of event, after completing the dialogs, TAB past the Finish button and select the Add Another Event button. You are returned to the Actions dialog where you can assign another action to the event. The Events Properties dialog lists an event for each action you assign, and they are in the order you added the actions.

For more information, refer to Frame Events.

Position Properties

Use the Position page of the Frame Properties dialog box to specify exactly where you want the frame. The fields in this dialog are automatically filled out when you create the frame, so use these fields to tweak the exact position of your frame.

The first group of radio buttons has two choices:

· Distance from Left Side of Window 

· Distance from Right Side of Window 

Press TAB to move to the Distance edit field. Specify the distance in pixels (measured either from the left or right side of the window as specified by the radio buttons).

Press TAB to move to the Width edit field. This field specifies the exact width of the frame in pixels. This field automatically updates as you change the distance of the frame from the left or right side of the window.

The second group of radio buttons is similar to the first. It also contains two choices:

· Distance from Top of Window 

· Distance from Bottom of Window 

This group of radio buttons also has an edit field for the exact distance from top or bottom, and there is an edit field to specify the height of the frame. Navigate these fields in the same way as the ones discussed above.

Use the third group of radio buttons to specify whether you want the frame to be relative to the window or the screen. As you switch between these two choices, the choices above change to be relative to the screen or window. For example, if you choose relative to screen, the choices above change to state the frame’s distance from the left of the screen, instead of distance from the left of the window.

We recommend you set your frames relative to the Window for most situations. If you transfer frame files to another computer using a different screen resolution, your frame is more likely to work if it is set relative to the Window. Additionally, frames are usually designed specifically for one window; therefore they should be relative to that window.

The Lock to DPI check box allows you to specify that a frame will only be active at the DPI (Dots Per Inch) setting at which it was created.

For more information on positioning frames, refer to:

Moving Frames
Resizing Frames
Validation Rules

Validation Rules are the criteria used to determine when frames are active. These rules compare information within your application to information specified within the rule. To ensure a frame is active when it is supposed to be, ensure its Validation Rules are set for conditions that are met within the area of the application where you want to use the frame.

When you open Frame Viewer, only active frames are displayed. Validation Rules ensure your frames are only active where they are to be used. If your Validation Rules are too general, your frames will be active in too many places and may speak useless information. If your Validation Rules are too specific, your frames may not work when you need them.

There are three components of any Validation Rule:

Information Types: The types of information found in your applications that are used to determine if frames are active or inactive.

Comparison Types: The types of comparisons made between the information types found in your applications and the comparison values you specify.

Comparison Values: The values you specify that are compared with the information types found in your applications.

Information Types

Validation Rules are based on types of information found in your application.

Window Title: Window titles are the text contained within the title bars of application windows or dialog boxes. Window titles can change within applications where files can be opened. For example, the title of the open document is displayed in the title bar of Microsoft Word. If you want a frame to be active within Word no matter which file you have opened, you need to take this into account when you set up a Validation Rule based on window titles.

Window Class: Window classes are programming level labels assigned to every control and window. To verify the window class for a control or window, move focus to it and press CTRL+INSERT+F1. The "Class" line reports the window class.
Window classes usually do not change, so Validation Rules based on them usually work well. However, there are applications in which window classes are generated dynamically, and in these applications, the window class for a control or window can be different each time you reopen the application. Some applications also use different window classes from version to version.

Window Text: Window text is text that appears within a window. When you use this rule, JAWS searches the entire window for the text to determine if your frame is active. 
We recommend always using other Validation Rules with this one and giving them higher priority so frames are more quickly recognized as inactive within those areas of your application where they are not used.

Frame Text: Frame text is text that appears within the borders of the frame. When you use this rule, JAWS searches the text within the borders of the frame for the text to determine if your frame is active. We recommend taking the same precautions with this type of rule as with rules based on window text.

Comparison Types

Validation rules compare information from the current application or screen with information values you specify. You also specify the type of comparison the rule makes. The following comparison types are available.

Is: The value you specify must exactly match the information within the application for the rule to validate.

Is Not: The rule will validate unless there is an exact match between the value you specify and the information in the application.

Contains: The rule will validate if the information in the application contains the value you specify.

Does Not Contain: The rule will validate unless the information in the application contains the value you specify.

Comparison Values

Comparison values are specified in your Validation Rules and compared to the information types found in your applications. These comparisons are based on the comparison types you have specified.

When deciding on what values to specify for comparisons, it is important to consider the information type, the comparison type, and how your frame is to be used.

For example, in some dialogs in Microsoft Word 2000, all controls use the window class, "bosa_sdm_Microsoft Word 9.0." If the frame is only to be used in this version of Word, a window class based rule using the comparison value of Is would work fine with the full window class specified as the comparison value. However, if you wished to use the same frame in Word 97 as well, you need to be aware that the window class in that version of Word is slightly different. It is, "bosa_sdm_Microsoft Word 8.0." To make the frame work in both versions of Word, you need to do one of two things:

· Add a second comparison value of "bosa_sdm_Microsoft Word 8.0" to the rule. The advantage of this is that you do not need to modify any other part of your rule. Both values are compared to the actual window class and if either of them match, the rule is validated. 

· Change the comparison type in the rule to Contains, and change the comparison value to "bosa_sdm_Microsoft Word" in the rule. Since both versions of Word use a window class that contains this information, the rule will validate. 

Tip: To quickly change a comparison value, move to the Validation Rules page of a Frame's properties, select the rule in the list, and press F2. Type in the new value to be compared to the information in your application and press ENTER.

Frame Events

JAWS makes extensive use of events within Windows and your applications to determine when certain responses or actions are necessary. Events occur all the time: when you press a key on your keyboard (KeyPressedEvent), when you open a file containing text (NewTextEvent), when you TAB from one control to another (FocusChangeEvent). Recognizing events in such a way that actions can be taken allows JAWS to quickly and naturally respond appropriately as you work.

Within frames, only specific events are used. You specify which events each frame recognizes. When one of the events specified for a frame occurs, the action you have associated with that event is taken.

There are several parts to every event used with frames.

· Frame Event Types: There are four types of frame events: On Focus, On Frame Key, On Play Action, and On Text. The event type determines what causes actions within your frame to take place. For example, if you want some specific action to take place whenever you TAB to a control within the borders of a frame, assign an On Focus event and associate the action to take place. 

· Event Actions: Event actions are the actions that occur when the event takes place. Each event you add activates only one action. If you want to have several things occur when focus moves into the borders of a frame, add the On Focus frame event several times, assigning different actions to each instance of the event. 

· Action Attributes: Many, but not all, event actions require that you specify an attribute of some sort. For example, if you set a frame to speak the contents of a window when some event occurs, when you assign the Say Window action to the frame event, you are prompted to specify which window is to be spoken. 

Frame Event Types

The following events are available for use with frames.

On Focus

This event occurs whenever the system focus moves into the borders of a frame. If you want something to happen whenever you TAB to a specific control in a dialog, create a frame at the location of the control, assign the On Focus event, and add the actions you want to take place.

On Frame Key

This event occurs when the keyboard combination assigned to the frame is pressed. The keyboard assignment is made within the General page of the Frame Properties dialog.

On Play Action

This event occurs when the action, Play Frame Actions is used from another frame and uses this frame as the attribute. 

For example, assume you want several actions to take place in FrameA, but only when an event occurs in FrameB. In FrameA, set up an On Play Action event for each action you want to take place. Then in FrameB, set up the event you want to use to initiate the actions. Assign the action, Play Frame Actions to this event, and set FrameA as the attribute.

With the On Play Action event, you can specify the scope of the event to determine when the event is recognized. 

On Text

This event occurs when text is newly displayed within the borders of the frame. Newly displayed text can be text typed into an edit field, or static text in a dialog when the dialog first appears on the screen.

This text can be filtered so only specific text, or text with certain attributes or colors activates the event.

For example, if you set the On Text event for a frame containing a list box, and set the filter to recognize any highlighted text, every time you arrow to a new item in the list box, newly highlighted text is displayed and the event occurs, so the associated action takes place.

With the On Text event, you can specify the scope of the event to determine when the event is recognized. 

Text Filters

When using the On Text event, you can specify that the event is recognized only if the text newly written within the borders of the frame matches a "filter" you set. This filter allows you to specify:

· Foreground (Text) Color 

· Background Color 

· Text attributes (Bold, Highlight, Italic, Underline, etc.) 

· A String of Text 

Foreground and background colors can be specified based on the text colors at the location of the JAWS cursor (where it was before Frame Viewer was started), by selecting the color names from the edit combo boxes, or by typing in the RGB (Red, Green, Blue) numeric values.

When you specify a string of text for the filter, for the text in the frame to be considered a match, it must be displayed all on one line, and it cannot be interrupted by other text, symbols, or graphics.

Event Scope

The On Play Action event and the On Text event can be set so these events are only recognized under certain conditions. This allows you to limit when the actions associated with these events occur.

Set these Events to be recognized:

· All the time, regardless of the location of the system focus 

· Only when the system focus is within the frame 

· Only when the system focus is not within the frame 

Event Actions

Actions are what make frames so powerful. Set actions to read the frame or window, play a sound file, reposition cursors, or run a JAWS script. Each event you add to your frame is associated with one action, but you can have several instances of the same event type with different actions associated with each, so when the event occurs, all the actions take place. 

Note: Actions take place in the order the associated event types are listed in the Events page of the Frame Properties dialog.

When you add an event and choose an action to assign to it, as you move through the list of actions, a description of each action is provided. Below are summarized the types of actions that are available.

Speak or Braille Information

There are actions to speak or Braille the following types of information:

· Text within a frame or window: You specify which frame or window. 

· Text with specific attributes in a frame or window: Specify the frame or window, and specify the attributes or colors of the text. 

· A string of text: Just specify what you want spoken or displayed in Braille. 

· A structured message: Specify a combination of specific text and information gathered through use of script functions. 

Note: The actions related to Braille only work while you are in structured mode.

Move Cursors

There are actions to move cursors as follows:

· Move the JAWS cursor to the top left corner of a frame 

· Move the JAWS cursor to the top left corner of a window 

· Move the JAWS cursor to the PC cursor 

Play Sounds

There are actions to play sounds you specify, system sounds, or to produce a beep from the system speaker.

Other

There are also actions to:

· Load JAWS Configuration Files: Specify the configuration files you wish to use. 

· Play Actions Specified in other Frames: An event occurring in one frame can be set to cause actions in another frame to take place. 

· Run JAWS Scripts: Enhance your frames even further by using them together with JAWS scripts. 

· Suppress Script Events: Prevent script events from causing information to be spoken or Brailed so as to avoid duplicating the information your frame is providing. 

Frame Defaults

When you create a frame, several default settings are used for Validation Rules and Frame Events. It is helpful to be aware of these defaults if you need to change the rules under which a frame is active, or if you need to change the functionality of a frame. 

Default Frame Events

When a frame is created, one frame event is always assigned, On Frame Key, set to speak the contents of the frame. This frame event is added even if you do not assign a keystroke to the frame.

The other frame events that are assigned depend on the options selected during creation of the frame.

The fifth page of the frame creation dialogs prompts you to specify how your frame will echo text newly displayed within the frame. The choice you select determines the other frame event that is added.

· Silent: An On Text frame event is added with the action set to Suppress Script Event. This prevents the JAWS scripting New Text Event from causing text to be spoken. 

· Highlight: An On Text frame event is added set to filter for highlighted text only, with the action set to Speak Text Filter. This frame event speaks the text that caused the frame event to take place, in this case, the highlighted text. 

· All: An On Text frame event is added that does not filter for any specific sort of text, and with the action set to Speak Text Filter. In this case, all text within the frame is spoken any time new text is displayed within the frame. 

· JAWS Screen Echo: No frame event is added when this choice is selected, and the way JAWS echoes text newly displayed in the frame is determined by default JAWS screen echo settings. 

For more information, please refer to Frame Events.

Default Validation Rules

When a frame is created, two default Validation Rules are added:

· A rule is added based on the Window Title in the application. When you later use this frame, it is active if the window title in the application contains the same text as was present in the window title when the frame was created. If you create a frame in an application in which the name of the open document is reflected in the title bar, you will need to modify this rule or your frame will only be active when that document is open. 

· A rule is added based on the window class in the application window or control. When you later use this frame, it is active if the window class in the application window or control contains the same information as was present when the frame was created. 

For more information, please refer to Validation Rules.

Troubleshooting Frames

Creating and configuring frames to do what you want is a series of fairly simple steps, but there are quite a few steps, and frames can do a lot. Some of the time, frames will not work, or they might not work the way you expect. This topic addresses several situations you might encounter when working with frames, and provides some tips for correcting the situation.

Tips are provided for the following situations:

· When a frame is inactive where you want to use it 

· When a frame is active where you do not want to use it 

· When a frame does not perform the actions you set for it 

· When a frame performs actions more frequently than you expect 

·   When information sent to a Braille display is not properly updated 

·   When Braille Information is not Displayed 

When a Frame is Inactive Where you Want to Use it

If your frame is inactive when you expected it to be available, or when you open Frame Viewer, first make sure you opened Frame Viewer from the location at which the frame was created. All frames are application specific. You cannot create frames in one application and use them in another.

If you open Frame Viewer and your frames are inactive, you cannot move to them.

1. TAB to the Frames List button and press SPACEBAR. 

2. Move to the frame you wish to work with, and press ALT+P to open the frame's properties. 

When you first create a frame, two Validation Rules are set. A rule is set for the window title to contain the text it did at the time the frame was created. A rule is also set for the window class to contain the text it did at the time the frame was created. Verify this information has not changed in the application, or turn off one of the rules. In the Validation Rules page of frame properties, select a rule in the list and press SPACEBAR to toggle it off or back on again.

Add another comparison value. The rule will be valid if one or the other of the values match the information in the application.

Change the comparison type to something less specific, for example, from Is to Contains. Shorten the comparison value so it only contains text that does not change.

When a Frame is Active Where you do not Want to Use it

If your frame is active in places where you do not want it speaking information or performing other actions, your validation rules are too general. Look at the window title (INSERT+T), window class (CTRL+INSERT+F1), or text within the area (or areas) where you wish to use the frame. Look for something unique to that area or those areas. Set up a validation rule for that unique information.

When a frame does not perform the actions you set for it

All frame actions are based on events. Make sure the event is occurring as you expect. There are only three events that directly cause actions to take place: focus moving into the area of the frame (On Focus), new text (of some type) being newly displayed within the area of the frame (On Text), or pressing an assigned keystroke (On Frame Key). The fourth event type (On Play Action) lets you set an action in one frame to occur when one of the other events takes place in another frame. 

Create events to try and verify when events are occurring. Create an On Focus event with the action, Say String. Have it state, "Focus Event." Try a similar test with the On Text event. Try assigning the action to the On Frame Key event, assign a keystroke, and test it.

When a Frame Performs Actions More Frequently than you Expect

Not all actions take place because of the frame events you have set. Some actions are caused by system events and the JAWS script support. Most frequently, these actions are initiated by FocusChangeEvent, or NewTextEvent. To test to see if this is the cause of the situation, create an On Focus event in your frame with the action set to Suppress Script Event. If this does not resolve the situation, create an On Text event with the action set to Suppress Script Event.

The On Text event, when set to filter for any highlighted text, will perform the associated action each time the text that is highlighted changes - for example, when moving through a list box. Try changing the scope of the event to only when focus is in the frame, or to only when focus is not within the frame.

When Information Sent to a Braille Display is not Properly Updated

When you use any of the Braille related actions to send information to a Braille display, the display may not properly refresh when you move focus to another control or perform other actions in your application. To prevent this, ensure the Show Focus Control check box is checked. This check box is located in the Add/Modify Event dialogs, on the page that is displayed after one of the Braille actions is assigned.

When Braille Information is not Displayed

If you configure a frame to send information to a Braille display, but the information is not displayed, verify that you are using structured mode. The frame actions related to Braille do not work while you are using line mode as line mode is an actual representation of what is displayed on the screen. While using structured mode, you can set your frames to send the information you find useful to your Braille display.

An Example Frame

This topic demonstrates creating a frame within the Glossary page of the JAWS help system. When creating a frame, there are three things to consider: how JAWS behaves without the frame, why JAWS behaves as it does, and how we want JAWS to behave.

Open the JAWS help system, and press ALT+G to move to the Glossary page. Use the arrow keys to move through the list of terms, and press TAB to move to the definition for terms.

JAWS reads each term as we arrow through the list, but when we TAB to the definition, JAWS does not automatically read it. We can read by word, line, or with Say All. JAWS announces we are in an edit field when we first TAB into the definition. This must be why JAWS is not automatically reading the definition. In edit fields, it is normal for JAWS to automatically read only highlighted text.

It would be convenient if JAWS did automatically read the definition when we TAB to it, and with a frame, we can easily add this functionality.

While the focus is still in the definition, press and hold down CTRL+SHIFT, then press LEFT BRACKET twice quickly. Select to create a frame.

Name the frame, Definition. Fill out the synopsis and Description fields. Do not assign a keystroke to the frame. When asked to set the frame's echo, select JAWS screen echo.

Once the frame is created, we are within Frame Viewer with focus on our frame. Press ALT+ENTER to open the frame's properties.

Press CTRL+TAB twice to move to the Events page of the frame properties dialog. Press ALT+A to create a new event.

We want the frame to speak the contents of the Definition edit field when we TAB to the control, so we need to add an On Focus Event. Since we want the contents of the frame spoken, we need to assign the Say Frame action. We are then asked to specify which frame, and the voice to use to speak the information. The frame, Definition should be selected by default, since it is our only frame. Change the Speak Using Voice selection to PC Cursor.

Select Finish, then select Ok in the frame properties dialog. Press CTRL+S to save the frame. Press ESC to exit Frame Viewer.

We can now test our frame. TAB to the term field, move to a different term, then TAB back to the Definition field. The definition should be automatically spoken.

We need to make one change to our frame to ensure the frame does not speak information when we are not in the Glossary page of help. Press INSERT+F2, select Frame Viewer, and press ENTER.

Press ALT+ENTER to open our frame's properties, then press CTRL+TAB once to move to the Validation Rules page of properties.

Press ALT+A to add a new rule. We need to add a rule to look for information specific to this page of help. We want information that does not appear on other pages of help. Our best choice is Window Text, so select that.

Leave the comparison Type set to Contains. For the Comparison Value, type "definition" without the quotes. TAB to Add and press ENTER.

Select Finish, then Ok, and press CTRL+S to save changes. Press ESC to exit Frame Viewer. 

At this point, our frame should work fine where we need it, but should not be active where it would speak information we do not need.

Customizing List Views

A list view is an area in a window or dialog box that contains one or more items, such as files, folders, records, and so on. The list view usually contains multiple columns that display information about each item in the list. You can use the Customize List View feature to change how JAWS provides you with information about these columns and items. Using this feature, you can:

· Change the order in which JAWS reads columns in the list view. 

· Tell JAWS not to speak certain columns or show them on your Braille display. 

· Choose a voice alias that JAWS uses when reading column headers. 

· Choose whether JAWS should speak column headers and/or display them in Braille. 

· Assign custom text to each column header that JAWS can speak and/or display in Braille. 

Note: You cannot customize list views if the Rely On MSAA For Listviews check box is selected in the Advanced Options dialog of Configuration Manager.

To begin customizing a list view, do the following: 

1. Start the program where the list view you want to customize is located. 

2. Move to the list view and press INSERT+F2. 

3. Select "Customize List View" and press ENTER. The Customize Column Headers dialog box appears. 

For more information on using this dialog box, see Customize Column Headers Dialog. After you customize a list view, JAWS saves your settings and applies them each time you use that list view. You can define different custom settings for each list view. 

To hear your customized settings, use the UP and DOWN ARROW keys to select items in the list view. JAWS reads the contents of the selected row. To hear the contents of a specific column in the selected row, hold down CTRL+INSERT and press the number of the column you want to read. For example, to read the first column in the list view, press CTRL+INSERT+1.

Tip: If you have customized a list view so that certain columns are not spoken, you can press INSERT+PAGE UP to read the information in all columns for the selected item.

Customize Column Headers Dialog

The Customize Column Headers dialog box allows you to change how JAWS announces column headers using speech and Braille in a list view. These customizations are saved so you do not need to repeat your changes each time you use the list view. 

To customize a list view, move the focus to it and then press INSERT+F2. Select "Customize List View" and press ENTER. The Customize Column Headers dialog box appears. Refer to the topics below for more information on using this dialog box.

Changing the Order of Columns

JAWS reads the columns listed in the Customize Column Headers dialog box from top to bottom. To change the order in which JAWS announces the columns of a list view, do the following:

1. On the Speech tab, use the UP and DOWN ARROW keys to select a column. 

2. Use the Move Up and Move Down buttons to change the position of the column in the list. JAWS reads columns at the top of the list first. 

3. Press CTRL+TAB to switch to the Braille tab. The list on this tab shows the order in which JAWS displays columns in Braille. 

4. Use the UP and DOWN ARROW keys to select a column from the list. 

5. Use the Move Up and Move Down buttons to change the position of the column in the list. JAWS displays columns at the top of the list in Braille first. 

6. Choose the OK buttton. 

Toggling Speech and Braille for Columns

If you do not want JAWS to read a certain column and/or display it in Braille, do the following:

1. On the Speech tab, use the UP and DOWN ARROW keys to select the column. 

2. Choose the Toggle Speech button. This sets the behavior for the column to "Do Not Speak." You can choose this button again to change the behavior back to "Speak Column." 

3. Press CTRL+TAB to switch to the Braille tab and select the column from the list. 

4. Choose the Toggle Braille button. This sets the behavior for the column to "Do Not Braille." You can choose this button again to change the behavior back to "Braille Column." 

5. Choose the OK buttton. 

Selecting a Voice Alias for Column Headers

To assign a voice alias to the titles of columns in a list view, do the following:

1. Choose the Select Voice Alias button. 

2. Use the UP and DOWN ARROW keys to select the voice alias that you want JAWS to use when reading column headings and/or custom text. 

3. Choose the OK button. The voice alias you selected is shown in the Data column. 

4. Choose the OK button. 

Assigning Custom Text to Columns

You can have JAWS read or display in Braille custom text instead of, or in addition to, the column header text. To enter custom text and define how JAWS announces column headers, do the following:

1. On the Speech tab, use the UP and DOWN ARROW keys to select the column you want to assign custom text to. 

2. In the Custom Text edit box, type the text that you want JAWS to announce when reading the column. You can repeat steps 1 and 2 to assign different text to each column header. 

3. In the Column Headers area, select one of the following radio buttons: 

· Ignore - JAWS does not read column headers or custom text in list views. 

· Speak Custom Text OR Header - If you assigned custom text to a column, JAWS reads this text instead of the column header. If you have not assigned any custom text, JAWS reads the column header. 

· Speak Custom Text AND Header - JAWS reads the column header and any custom text that you have assigned. 

· Speak Custom Text Only - JAWS only reads custom text assigned to columns and does not read the column headers. 

4. If you want JAWS to display any custom text in Braille, press CTRL+TAB to switch to the Braille tab. 

5. Use the UP and DOWN ARROW keys to select the column you want to assign custom text to. 

6. In the Custom Text edit box, type the text that you want JAWS to display in Braille when reading the column. You can repeat steps 5 and 6 to assign different text to each column header. 

7. In the Column Headers area, select one of the following radio buttons: 

· Ignore - JAWS does not display column headers or custom text in Braille. 

· Braille Custom Text OR Header - If you assigned custom text to a column, JAWS displays this text in Braille instead of the column header. If you have not assigned any custom text, JAWS displays the column header. 

· Braille Custom Text AND Header - JAWS displays the column header and any custom text that you have assigned. 

· Braille Custom Text Only - JAWS only displays custom text assigned to columns and does not display the column headers. 

8. Choose the OK button. 

Navigation Quick Key Manager

Navigation Quick Keys are single or combination keystrokes that let you move quickly around Web pages, Acrobat PDF files, Microsoft Word documents, or Microsoft Outlook e-mail messages. For example, if you press the letter H while visiting a Web page, JAWS jumps to and reads the next heading on the page. Likewise, if you press SHIFT+H, JAWS jumps to and reads the previous heading.

Use the Navigation Quick Key Manager to view current key assignments, edit key assignments, or delete key assignments. 

Opening the Navigation Quick Key Manager

To open the Navigation Quick Key Manager, do one of the following:

· Press INSERT+F2, N, and then ENTER. 

· From the JAWS application window, press ALT+U to open the Utilities menu, press N to jump to the Navigation Quick Key manager, and then press H to open HTML/PDF Keys, O to open Microsoft Outlook Keys, or W to open Microsoft Word Keys. 

A list of all Navigation Quick Keys for Web pages and PDF documents, Outlook e-mail messages, or for Word documents appear in the open dialog box. Use the UP and DOWN ARROW keys to scroll through the list. 

Editing Key Assignments

You can assign an unused letter or number to an action listed in the Navigation Quick Key column of the dialog box.

To assign a key to an action, do the following:

1. Press the UP or DOWN ARROW key to move to an action in the list. 

2. Press TAB to move to the Edit Key Assignment button and press SPACEBAR. The Edit Quick Navigation Key Assignment dialog box opens. 

3. In the Key Assignment combo box, press UP ARROW or DOWN ARROW to scroll through the list of available letters and numbers that can be assigned to the action. Press ENTER after choosing an item from the list. The new key assignment now appears in the Assignment column of the Navigation Quick Key Manager dialog box. 

4. To save the change, move to the OK button in the Navigation Quick Key Manager dialog box, and press ENTER. The new assignment takes place immediately. 

Deleting Key Assignments 

To remove a Navigation Quick Key from an action, do the following:

1. Press the UP or DOWN ARROW key to move to an action in the list. 

2. Press TAB to move to the Delete Key Assignment button and press SPACEBAR. The word Unassigned appears next to the key action in the Navigation Quick Key Manager dialog box. 

3. To save the change, move to the OK button, and press ENTER. The change takes place immediately. 

Refer to Navigation Quick Keys for a list of quick keys that you can use with Web pages and PDF documents.

Refer to Navigation Quick Keys in Word for a list of quick keys to use with Word documents.

Network JAWS

Installing Network JAWS is a multi-step process that needs to be completed in the following order as each step builds upon the previous steps.

JAWS Server Setup 

Set Network Permissions 

Install Network Authorization
Create User and System Profiles in HJ Administrator 

Set Permissions for User Folders 

Run JAWS Client Installation
JAWS Server Setup

The system that will function as the JAWS server does not need to be a network server. Use any system that all Network JAWS clients can access. If you are working with a Windows server, you can install JAWS from the server, unless that server is not accessible from your location. 

To begin, insert the JAWS program CD into your CD drive and select JAWS Network Setup. The remainder of the setup process is very similar to a regular installation of JAWS. For information on the options and dialogs that are displayed, please see JAWS for Windows Setup. It is strongly recommended that you select either Guided or Advanced install. Select all speech synthesizers and/or Braille displays that will be used on any of the client systems. Only those items that are selected during the server setup will be available to the clients.

Note: If you are installing from a remote location, or to a non-Windows server, you will need to use the UNC (Universal Naming Convention) path to tell JAWS where the files should be installed. For example: \\ServerName\FolderName. 

Next Step:
Set Network Permissions
Set Network Permissions

After the files have been copied to the server, you need to share the folder where you installed JAWS. By default, most servers set up shared folders with full permissions. Please verify that the shared folder has full permissions, because this is required during the authorization process. 

Note: The term "permissions" is mostly a Windows term. Substitute the word "permissions" for the term your server software uses. For example, Novell Netware uses the term "supervisory."

Next Step:
Install Network Authorization
Installing Network Authorization

Internet License Manager (ILM) Network Authorization

If your license of JAWS uses Internet License Manager for authorization, you must set up a license server. You can install the license server on any Windows computer that is accessible to all clients. The license server distributes tokens to client computers that authorize the program. To begin setting up the license server, insert your multi-user Authorization CD into the CD drive of the computer that you want to use as the license server. Follow the instructions to install the network authorization tools and license server. 

Refer to ILM Multi-User Network Authorization for information on using Internet License Manager to authorize JAWS. This topic provides instructions for installing the network authorization tools and license server, activating Network JAWS, setting up client computers, and removing the authorization. 

Next Step:
Create User and System Profiles in HJ Administrator
Create User and System Profiles in HJ Administrator

Locate the Network JAWS Admin item under Start, Programs, , Tools. The first time you open this application, you are notified that the administrator account does not have a password set. At this time, press ENTER to continue without entering password. You can assign a password later if necessary. 

HJ Administrator creates the guest and administrator accounts. Now you must add a user account.

Press ALT+A to activate the Add User button and then enter a name for the user. At this time, you may want to create only a single test user account. When the network setup is complete, you can return to HJ Administrator and add other users. For detailed information on the options available, please see HJ Administrator. 

Tip: If you set each user’s user account name and password to the same user name and password they use to log in to their systems, they will automatically be logged in to JAWS under this user account when JAWS is started.

Next Step:
Run JAWS Client Installation
Run JAWS Client Installation

After you have set up at least one user account, you are ready to install the client portion of JAWS network support. To begin, go to the workstation that will act as the JAWS client and place the JAWS program CD into the CD drive. Allow the installation to start and then choose the Network Client Installation.

During this installation, you are asked to specify the location of the server files. Choose Browse and type the UNC (Universal Naming Convention) path of the folder where the JAWS files are located. For example, if the JAWS Server is installed on a server named "Business" and the folder is shared as "JAWSNet," the UNC path is \\Business\JAWSNet.

Once the client installation is complete, you should ensure JAWS functions properly and that you can switch between different user accounts. You should be able to log out and log back in as a different user. You should not receive any error messages about JAWS authorization. 

Next Step: 
Set Permissions for User Folders
Set Permissions for User Folders

Once you have the completed the server installation, you can add more users in HJ Administrator (see Create User and System Profiles in HJ Administrator for instructions on adding users). In the JAWS installation folder, there will be a C:\Documents and Settings\UserName\Application Data\Freedom Scientific\JAWS\X (where X is the JAWS version number)\Settings\ENU folder for each user you create. Grant each user read/write/execute access, at a minimum, to their folder. Access rights could also include delete privileges, or even full access. 

Optional Instructions for Secure Environments

If your organization requires that you lock down JAWS for a secure environment, you can perform the following optional steps to assign permissions to additional files and folders:

Note: These instructions assume that the system administrator has taken other standard lockdown steps, such as removing unwanted system hidden shares.

1. Navigate to the folder where you installed JAWS on the server. Select the folder and press ALT+ENTER. 

2. On the Security tab, choose the Advanced button. 

Tip: If the Security tab is not available, then turn off simple file sharing in Windows Explorer.

3. Clear the Inherit from the Parent Permissions that Apply to Child Objects check box. 

4. When the Security dialog box appears, choose Copy. 

5. Choose Apply, and then choose OK. 

6. Restart your computer so the new permissions take effect, and then log back on. 

7. Navigate to the folder where you installed JAWS. Select the folder and press ALT+ENTER. 

8. On the Security tab, ensure that the following users are in the Permission Entries list: 

· Creator/owner (full permission) 

· System (full permission) 

· Administrators (full permission) 

Note: This assumes that none of the general JAWS users have administrative rights on the JAWS server. This group should only contain system administrators.

9. Select the user "Everyone" and choose Remove. After you remove this user, choose OK. 

10. Log off and then log back on so that your changes take effect. 

11. Navigate to the folder where you installed JAWS. Select the folder and press ALT+ENTER. 

12. On the Security tab, add each of your JAWS user accounts. Give these users read-only permission. 

13. Log off and then log back on so that your changes take effect. 

14. You now need to set some specific permissions for several folders and files. Navigate to the Users folder, located in the folder where you installed JAWS. 

15. For each folder within the Users folder, give full permissions only to the user that folder belongs to. This allows that user to set up their own custom JAWS settings. For further security, remove any other JAWS user from the list (except for the system user, creator/owner user, and administrators). 

16. In the folder where you installed JAWS, set read/write/execute/append permissions for the following files. This prevents users from deleting files that are shared by other users while still allowing each JAWS client to modify them. 

· JFW.icf 

· JFW.rpt 

· User.ini 

· User.log 

Tip: Setting permissions for User.ini is optional. Keep this file read-only if you want to set, as the administrator, certain options like whether JAWS runs in the system tray. If you set this to read/write/execute/append, then users can change this setting. However, these changes affect all JAWS users because the file is global.

Contacting Freedom Scientific

Corporate Headquarters

Freedom Scientific Inc. 
11800 31st Court North
St. Petersburg, FL 33716-1805
USA     Telephone: (727) 803-8000
Fax: (727) 803-8001
World Wide Web: http://www.FreedomScientific.com 

Office hours: Monday through Friday 8:30 A.M. to 5:00 P.M. Eastern Time (USA)

Freedom Scientific Website

The Freedom Scientific Website, http://www.FreedomScientific.com, is a comprehensive source of information regarding JAWS screen reader software, MAGic screen magnification software, training opportunities, application-specific cassette tutorials and the company that develops these products. 

The Freedom Scientific Website is designed to be accessible by people with disabilities and includes a great deal of technical support information as well as online ordering capability, RealAudio descriptions of many products, and continuous product update and maintenance downloads.

Documentation Feedback

At Freedom Scientific, we strive to produce high quality documentation of our products, and welcome your feedback. If you have comments or suggestions about our online Help or printed guides, send your e-mail messages to Documentation@FreedomScientific.com.

Sales Contacting the Freedom Scientific Sales Department

Sales Telephone: (800) 444-4443
International Sales Telephone, including Canada: (727) 803-8000
Sales Fax: (727) 803-8001

World Wide Web: http://www.FreedomScientific.com 
Sales e-mail: Info@FreedomScientific.com
To ensure that your request is handled promptly, include your complete address and telephone number.

Office Hours: Monday through Friday, 8:30 am to 5:00 pm Eastern Time (USA)

Training Classes

Freedom Scientific Training Classes are designed to meet the needs of professional trainers. Training classes are offered to those who want to train others to use JAWS in various applications, i.e., Windows, word processors, Internet and e-mail. We also hold training in how to customize JAWS to work for your end-users. Our workshops range in complexity to cover the training needs of instructors just starting in the field as well as those who have been with us for quite some time. For more information, contact your Freedom Scientific sales representative, visit Freedom Scientific Training Courses for Professionals, or e-mail Freedom Scientific at training_info@FreedomScientific.com.

Excel 2000 Tutorial

This tutorial is an introduction to Microsoft Excel 2000 using JAWS as your screen reader. 

Excel is a powerful spreadsheet program used for creating and calculating tables of numeric information. Enjoy the ability to keep track of your personal or small business finances and even use Excel to manage contact information such as names, addresses, and telephone numbers. 

With Excel you can also link parts of a spreadsheet to a Microsoft Word document and have the information in this document updated when you change it in the Excel spreadsheet.

Key Topics Include:

· Launching Excel from the Start Menu and an orientation to the main application window 

· Opening a workbook 

· Using or closing the office assistant 

· Getting Help 

· JAWS Verbosity Options 

· Navigating a spreadsheet 

· Taking a look at banking 

· Entering text and values 

· Formatting numbers, dates, and currency 

· Relative and absolute locations 

· Creating a formula using relative and absolute values 

· Editing basics 

· Protecting your work 

· Find and Replace 

· Spell Check 

· Performing calculations 

· Totaling columns 

· Referencing formual cells 

· Naming cells and ranges 

· Creating arguments 

· Setting criteria 

· Creating hyperlinks 

· Get to it Fast! - Table of Contents for a Spreadsheet 

· Insert menu 

· Tools menu 

· Options for Excel 

· Employing database functions 

· Charting data 

· Sharing data 

· Putting an Excel spreadsheet into a Word document 

The tutorial includes four, two-sided audiocassettes, one CD-ROM with tutorial practice documetns and audio samples of other tutorials.

Excel XP with JAWS for Windows

Take control of your Excel spreadsheets with this tutorial that combines Windows and Office XP with JAWS 4.51 or above. Create workbooks for such uses as tracking personal finance, keeping databases and charting information. 

Designed for beginning and advanced JAWS users, this step-by-step tutorial covers all the key features of JAWS and Excel XP. Learn how to use time-saving features like the Windows Clipboard and explore the power of Excel calculations and formulas. Whether you're building or enhancing your JAWS knowledge, this tutorial is for you.

Topics covered in this tutorial include: 

· Navigating Spreadsheets 

· Entering Text, Data and formulas 

· Using Relative and Absolute Locations 

· Formatting Numbers and Dates 

· Performing Calculations 

· Naming Cells and Ranges 

· Using Database Functions 

· Charting Data 

· Sharing Data 

The tutorial includes four two-sided audio cassettes, and one Floppy with tutorial practice documents. 

Internet Explorer Suite 5.0 Tutorial

This tutorial gives you insight into the use of the various components of the Microsoft Internet Explorer 5.0 suite of products. The included learning modules are designed to introduce the participant to many aspects of Internet usage. This includes surfing the Web, using various search engines, downloading programs and files, subscribing to Web pages and news groups, checking and managing e-mail using Microsoft Outlook Express and creating a simple Web page. 

Internet Explorer 5.0 Topics

· Launching and exiting an Internet Explorer browser session. 

· Navigating, orienting to and identifying several different types of Web pages while browsing the Freedom Scientific practice tutorial and resource page. 

· Adding to, organizing and creating new folders within the Internet Explorer 5 Favorites menu. 

· Managing and updating Web page subscriptions. 

· Conducting Internet searches. 

· Downloading and installing compressed program files. 

· Selecting a default start page. 

Outlook Express E-Mail 

· Composing, receiving, replying to, forwarding and organizing e-mail. 

· Customizing menu options. 

· Adding, removing and modifying groups and contacts. 

· Sending e-mail from within the address book program. 

· Searching for and viewing content. 

· Subscribing and unsubscribing from news groups. 

Additional Instruction

· Understanding the various levels of Internet transmission security. 

· Setting up Microsoft Net Meeting and holding a Net Meeting conference. 

· Building a simple Web page using Microsoft Front Page Express. 

· Posting a Web page using an FTP client. 

JAWS 4.5 with IE in Windows XP

This tutorial combines advances in the JAWS screen reader with advances in Microsoft Internet Explorer. It is the first audio tutorial for the Windows XP environment. If your computer operates on the Windows XP system and you want to browse Web sites using JAWS 4.5 and IE 6, this tutorial will show you how. 

Packed on to four cassettes are “how to” lessons teaching everything you’ll need to know to maximize your experiences surfing the Internet and using Outlook Express to organize your emails. The functionality of JAWS 4.5 is explained in a systematic, easy-to-follow process that brings the Net alive. This tutorial gives users insight to Internet Explorer and instructs you how to use all of the great JAWS 4.5 features. As part of the instruction, you’ll explore Freedom Scientific’s HTML Challenge where you’ll learn first-hand how Web sites are designed and how JAWS organizes the information.

Once you are introduced to setting up Windows XP and IE, the tutorial moves quickly into browsing with JAWS in the IE environment. Here are some of the things you can expect to learn: 

· How to download files from the Internet 

· How to navigate Web sites 

· How to use the JAWS virtual cursor 

· How to move through links 

· How to recognize parts of Web sites such as graphics, lists, forms and tables 

· How to search the Net, set favorite links and return to recently-visited links 

You’ll also learn all facets of using Outlook Express as your email package. Once connected, you’ll learn tips on handling messages, checking spelling, manipulating attachments and using the address book.

Since computer manufacturers are loading XP on new equipment, Freedom Scientific wants to make certain that you get the latest in software instruction.

Outlook 2000 Tutorial

Fundamentals of Outlook 2000 with JAWS for Windows is a cassette tape tutorial that teaches the participant how to use the Outlook personal management program with JAWS.

Key Topics Include

· Launching and modifying Outlook. 

· An orientation to the Outlook main application window. 

· Accessing JAWS application specific, and Outlook Help files. 

· Composing, sending, navigating, replying to and forwarding e-mail in Outlook. 

· Sending, receiving and accessing file attachments. 

· Flagging messages for follow-up. 

· Creating and inserting signatures. 

· Using the spell checker in Outlook. 

· Creating, navigating and moving information between folders. 

· Creating and viewing contact information. 

· Setting-up and viewing calendar appointments. 

· Sending and tracking Meetings and Task requests. 

· Creating and contacting distribution groups. 

· Taking quick notes. 

· Using the Speed dialer. 

· Using the advanced find dialog. 

· Tracking activities using the Journal. 

· Filtering messages using the rules wizard dialog. 

PowerPoint 2000

The PowerPoint 2000 with JAWS tutorial has been designed to introduce the new JAWS user to fundamental concepts of using this powerful screen reader in combination with the PowerPoint 2000 presentation software. For more information contact info@Freedom Scientific.com.

Key Topics Include:

· An Orientation to the PowerPoint Application Window 

· Selecting Slide Layouts 

· Inserting Objects Created in Other Applications 

· Selecting Slide Templates 

· Adding Transitions, Animations, Graphics, and Sounds to Slides 

· Viewing Slideshows 

· Using Slide Sorter View 

· Using Hidden Slides 

· Importing and Exporting Word documents to PowerPoint 

· Working with Fonts 

· Meetings and Action Note Features 

· Headers and Footers 

· Print Options 

Word 2000 Tutorial

This tutorial covers the latest functionality of Microsoft Word 2000. Whether you are a novice or an advanced JAWS user, you can increase your speed, efficiency, and Word skills while listening and working along on your PC. Practice documents are provided with this comprehensive instructional session so you can discover the latest tips and the newest tricks in Microsoft Word.

Key Topics Include:

· Orientation, optimization, and organization 

· Creating, Stylizing, formatting and printing documents 

· Using the various grammar tools 

· Proofing documents for spelling grammatical errors 

· Utilizing the many automatic functions 

· Use templates, track changes, make headers/footers and using Mail Merge 

Word XP with JAWS

With the help of this tutorial, you will be able to manipulate existing documents that others have created and format them yourself. Combining Windows and Office XP with JAWS 4.51 or above, the Word XP tutorial is designed for beginning and advanced JAWS users. This step-by-step tutorial covers all the basic skills you'll need to operate in a Word XP environment. Plus, it demonstrates all the key features of JAWS and Word XP that help you stay productive and efficient. 

Learn how to create professional looking documents by using headers and footers and more! Use time-saving features like the Windows Clipboard and Mail Merge. If you have prior versions of either Windows or Word, you may want to consider Freedom Scientific's Word 2000 and JAWS tutorial. Topics included in this tutorial include: 

· Configuring Windows XP and Word XP for JAWS 

· Orientation to Word XP User Interface 

· Basic Word Processing 

· Editing Commands 

· Using Office XP Clipboard 

· Manually Formatting Text 

· Formatting a Document 

· Checking Spelling and Grammar 

· Using the Find Feature 

· Setting up Tables 

· Using Outline View 

· Working with Templates 

Word 8 Fundamentals

The Word 8 Fundamentals with JAWS tutorial has been designed to introduce the new JAWS user to fundamental concepts of using this powerful screen reader in combination with the Microsoft Word 8 word processing program. For more information contact Info@FreedomScientific.com.

Key Topics Include:

· Launching Word from within the Windows Start menus. 

· Orientation to the screen layout in Word, accessing the Title Bar, Menu Bar, various tool bars, Main Document Window and Status Bar. 

· Explanation of, detecting, and closing the Microsoft Office Assistant. 

· Opening a Word 8 document and an overview of controls found within the Open dialog box. 

· Saving and closing a document and an overview of various controls found within the Save dialog box. 

· Exiting Word 8. 

· Navigating a document and differentiating between JAWS navigational and standard Windows navigational commands. 

· Manually editing a document. 

· Using the clipboard. 

· Formatting a document. 

· Printing documents and envelopes. 

· Using the spell/grammar checker. 

· Using the Find and replace feature. 

· Using the Word Help feature. 

Corel WordPerfect 10 with JAWS

This new tutorial covers some of the latest functionality of Corel® WordPerfect® 10, a component of the WordPerfect® Office 2002 suite, with JAWS screen reading software. The novice or advanced JAWS user can increase their speed and accuracy and discover new tips and tricks, as they listen and work along on a PC. This comprehensive instructional session includes practice documents on diskette.

Key Topics Include:

· Getting Help 

· Orientation and navigating documents 

· Reveal Codes 

· Opening, editing, and formatting a document 

· Using Spell Check, the Thesaurus, and the Dictionary 

· Using the Find and Find and Replace features 

· Quick Correct and Quick Words 

· Printing documents, envelopes, and labels 

Advanced Features Include:

· Headers and Footers 

· Suppressing Codes 

· Columns 

· Tables 

· Inserting Watermarks 

· Tables of Contents 

Technical Support

Contacting Freedom Scientific Technical Support

You must be a registered user to access Freedom Scientific support services. Freedom Scientific support services are subject to Freedom Scientific terms and conditions in place at the time the service is used. 

Reach Technical Support using the following options:

Visit our Web site for automated online Help: Technical Support Department
Technical Support e-mail: Support@FreedomScientific.com
Technical Support Telephone: (727) 803-8600 

When you call, be at your computer, have your documentation in hand, and be prepared to provide the following information:

Product serial number used for registration.

Product name and version number.

Type of computer hardware you are using.

Software version number of Windows.

Exact wording of any messages that appear on your screen.

What you were doing when the problem occurred.

How you tried to solve the problem.

Office hours: Monday through Friday 8:30 A.M. to 7:00 P.M. Eastern Time (USA)

Video Intercept Manager

The JAWS Video Intercept Manager detects problems related to video that may prevent JAWS from functioning properly. The JAWS Video Intercept Manager provides information on your video hardware and software that can help Freedom Scientific Technical Support Engineers determine the cause of failure to properly install JAWS Video Intercept. 

Note: Troubleshooting and resolving situations that cause JAWS Video Intercept often involves uninstalling and reinstalling software applications and/or device drivers. We recommend only experienced computer users attempt to resolve Video Intercept problems without assistance From Freedom Scientific Technical Support.

Common causes of Video Intercept failures are listed below.

Incompatible Software

If incompatible software is installed on your system before you install JAWS, the Video Intercept will fail to install. JAWS attempts to identify the software causing this problem. If the software is identified, you can attempt to uninstall the software, and install JAWS Video Intercept. Once JAWS is functioning correctly, you should be able to reinstall the software without causing any conflicts.

Other Assistive Technology Software

In some cases, if other assistive technology software is installed on your system before you install JAWS, the Video Intercept will fail to install. JAWS attempts to identify the software causing this problem. If the software is identified, you can attempt to uninstall the software, and install JAWS Video Intercept. Once JAWS is functioning correctly, you should be able to reinstall the software without causing any conflicts.

Incorrect Display Drivers

If incorrect display drivers are installed on your system, JAWS Video Intercept will fail to install. You may need to contact the manufacturer of your display adapter hardware for assistance installing the correct display drivers. After the correct display drivers are installed, JAWS Video Intercept should install without problems.

Display Chaining Manager

Display Chaining Manager (DCM) allows multiple assistive technology aids (such as screen readers and screen magnifiers) to be installed on a single computer. You can use the Display Chaining Manager utility to view and/or modify your computer's display chain so that your assistive technology devices do not interfere with each other.

Warning: Modifying your computer's display chain can cause severe problems with system functionality. You should only use Display Chaining Manager if instructed by Freedom Scientific Technical Support.

To start Display Chaining Manager, go to the JAWS program group in the Start menu, open the Tool submenu, and choose Display Chaining Manager. 

Select the display chain you want to view in the Display Chain list. Enabled and disabled drivers for this display chain are shown in the two list views. To view information for the selected driver, choose the Properties button. This tells you the driver name, manufacturer, product name, version number, driver type, and other details. This information is read-only and cannot be modified. 

To remove a driver from the display chain, select it and choose Remove. The driver moves to the Installed But Disabled list. To add a driver to the display chain, select it in the Installed But Disabled list and choose Add. 

You can also change the order of the drivers in the display chain. To change the order of a driver, select it in the list and choose either the Move Up or Move Down button.
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